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Introduction (English)

This Concise User’s Guide introduces the main features
of your computer. The English version of this guide be-
gins on page 1. The expanded User’s Manual is on the
Device Drivers & Utilities + User’s Manual disc.

Einfihrung (Deutsch)

Dieses Ausflhrliche Benutzerhandbuch fiihrt Sie in die
Hauptfunktionen des Notebooks ein. Die deutsche Versi-
on des Handbuchs beginnt auf Seite 45. Das erweiterte
Benutzerhandbuch finden Sie auf der Disc fir die Geré-
tetreiber und Hilfsprogramme (Disc Device Drivers &
Utilities + User's Manual).

Présentation (Francais)

Ce Guide Utilisateur Concis présente les fonctionnalités
principales de votre ordinateur. La version francaise de
ce guide commence a la page 89. Le Manuel de I'Utilisa-
teur étendu se trouve sur le disque de Pilotes & Utilitai-
res + Manuel de I'Utilisateur (disque Device Drivers &
Utilities + User's Manual).

Introduccion (Espariol)

Esta Guia del Usuario Concisa le presenta las caracteris-
ticas principales de su ordenador. La version espafiola de
esta guia comienza en la pagina 133. EI Manual del usua-
rio completo se encuentra en el disco de Controladores
del dispositivo y Utilidades + Manual del usuario (disco
Device Drivers & Utilities + User's Manual).

Introduzione (Italiano)

La presente Guida Rapida per I'Utente introduce le carat-
teristiche principali del computer. La versione italiana di
questa guida inizia da pagina 177. Il Manuale utente
completo si trova nel disco contenente driver e utilita +
Manuale utente (disco Device Drivers & Utilities +
User's Manual).
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Notice

The company reserves the right to revise this publication or to change its contents without notice. Information con-
tained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any sub-
sequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this
publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this pub-
lication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted
or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this pub-
lication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks
of their respective companies. They are mentioned for identification purposes only and are not intended as an endorse-
ment of that product or its manufacturer.

© May 2008

Trademarks

This product incorporates copyright protection technology that is protected by method claims of certain U.S. patents
and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of this copy-
right protection technology must be authorized by Macrovision Corporation, and is intended for home or other limited
viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering or disassembly is
prohibited.

Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.

Notice - 1
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About this Concise User Guide

This quick guide is a brief introduction to getting your system started. This is a supplement, and not a substitute for
the expanded English language User’s Manual in Adobe Acrobat format on the Device Drivers & Utilities + User’s
Manual disc supplied with your computer. This disc also contains the drivers and utilities necessary for the proper
operation of the computer.

Some or all of the computer’s features may already have been setup. If they aren’t, or you are planning to re-configure
(or re-install) portions of the system, refer to the expanded User’s Manual. The Device Drivers & Utilities + User’s
Manual disc does not contain an operating system.

Regulatory Information

Regulatory notices and information are contained in the expanded User’s Manual on the Device Drivers & Utilities
+ User’s Manual disc.

N A
2

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the Wireless LAN, Blue-
tooth and 3.5G modules are OFF if you are using the computer aboard aircraft.

2 - About this Concise User Guide
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Instructions for Care and Operation

The computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating element.
This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other strong mag-
netic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget to
save your work. Remember to periodically save your data as data may be lost.

Take care when using peripheral devices.

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the com-
puter to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power sup-
ply. Then refer servicing to qualified service personnel under any of the following conditions:

When the power cord is damaged or frayed.

If the computer has been exposed to any liquids.

If the computer does not work normally when you follow the operating instructions.

If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
If there is an unusual odor, heat or smoke coming from your computer.

Instructions for Care and Operation - 3
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Power Safety
The computer has specific power requirements:

e Only use an AC/DC adapter approved for use with this computer.

* Your AC/DC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply.
If you are unsure of your local power specifications, consult your service representative or local power company.

» The AC/DC adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety fea-
ture; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.

* When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.

» Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.

» Before cleaning the computer, make sure it is disconnected from any external power supplies.

SN
2L &

Power Safety Warning

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals
and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the ma-
chine on.

Power Off Before Traveling

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a note-
book which is powered on in a travel bag may cause the vent(s) to be blocked. To prevent your computer from overheating make
sure nothing blocks the vent(s) while the computer is in use.

Cleaning
Do not apply cleaner directly to the computer, use a soft clean cloth. Do not use volatile (petroleum distillates) or
abrasive cleaners on any part of the computer.

4 - Instructions for Care and Operation



Concise User’'s Guide

Battery Precautions

Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way.
Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may pos-
sibly result in fire.

Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

Keep the battery away from metal appliances.

Affix tape to the battery contacts before disposing of the battery.

Do not touch the battery contacts with your hands or metal objects.

\ A/
L&
Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life, under
various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with your local solid
waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the man-
ufacturer. Discard used battery according to the manufacturer’s instructions.

Instructions for Care and Operation - 5
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Model Differences

This notebook series includes four different model types (each model includes different design styles). The exact out-
ward appearance and some of the Hot-Key buttons may appear slightly different from those illustrated in this manual,
however all the ports, components and functions etc. are the same for each design style. The models differ as indicated

in the table below.

Feature Model A Model B Model C Model D

Core Logic Intel(R) GM45 + ICH9M Chipset Intel(R) PM45 + ICH9M Chipset

Video Adapter Intel Integrated Video System (Internal On Chip) NVIDIA Discrete Video System (External On Board)

90W (DC Output 19V, 4.74A)

AC/DC Adapter 65W (DC Output 19V, 3.42A or 18.5V, 3.5A)
14.1" WXGA/ WXGA+ 15.4" WXGA/ WXGA+/ 14.1" WXGA/ WXGA+ 15.4" WXGA/ WXGA+/
LCD Type Glare Tvpe TET LCD WSXGA + Glare Type Glare Type TET LCD WSXGA + Glare Type
yp TET LCD yp TFT LCD

Table 1 - Model Differences

6 - Instructions for Care and Operation
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System Startup

Remove all packing materials.
Place the computer on a stable surface.
Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.

Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an outlet, and
connect the AC power cord to the AC/DC adapter.

5. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 130 degrees); use the other hand (as
illustrated in Figure 1) to support the base of the computer (Note: Never lift the computer by the lid/LCD).

6. Press the power button to turn the computer “on”.

> w DR

Shut Down

Note that you should always shut your computer down by choosing the Shut Down command from the Lock
Button Menu in Windows Vista. This will help prevent hard disk or system problems.

Figure 1 - Openning the Lid/LCD/Computer with AC/DC Adapter Plugged-In

System Startup - 7
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System Software Operating Systems Supported
Your computer may already come with system software GG
pre-installed. Where this is not the case, or where you are System Note
re-configuring your computer for a different system, you
will find this manual refers to the Microsoft Windows Windows XP For information on the Windows XP
Vista operating system. Further information on installing (Home Edition or | OS see the Device Drivers & Utilities +
the drivers and utilities is available in Chapters 4 & 7 of Professional) | User’s Manual disc.
the_ g>.<panded U’ser S Manugl on the Device Drivers & Make sure you install Windows Vista
Utilities + User’s Manual disc. Windows Vista Service Pack 1 (or a Windows Vista
with Service version which includes Service Pack 1)
4 Pack 1 (64-bit) before installing any drivers. Go to
. Home Basic/ ghe I\_/Illcrosoft website for doyvnload
Drivers Home Premium/ etails, or contact your service center.
If you are installing/re-installing new system software, you Business/ In order to run Windows Vista without
will need to install the appropriate drivers. Drivers are pro- _Enterpns_g/ limitations or decreased performance,
grams which act as an interface between the computer and Ultimate Editions your computer requires a minimum
a hardware component e.g. a wireless network module. It is 1GB of system memory (RAM).

very important that you install the drivers in the order listed
in Table 5 on page 23. You will be unable to use most ad-
vanced controls until the necessary drivers and utilities are Not IncI u ded
properly installed.

Operating Systems (e.g. Windows Vista/Windows XP)
and applications (e.g. word processing, spreadsheet and
database programs) have their own manuals, so please
consult the appropriate manuals.

.|
8 - System Software
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System Map: Front View with LCD Panel Figure 2

Front View with LCD

Open - Models A & C Panel Open

(Models A & C)

7Q§ 1. Built-In PC Camera
Wireless Device (Optional)
Operation Aboard Aircraft 2. LCD
. 3. Speakers
The use of any portable electronic
transmission devices aboard air- 4. Power Button
craft is usually prohibited. Make 5. Hot-Key Buttons
sure the wireless modules are 6. Keyboard
OFF if you are using the com- 7. Built-In Microphone
puter aboard aircraft. 8. Touchpad & Buttons
Use the key combinations to tog- 9. Fingerprint Module
gle power to the 3.5G/WLAN/ (Optional)
Bluetooth modules, and check 10. LED Indicators

the LED indicator icon to see if the
modules are powered on or not
(see

\ 7
TouchPad button

(valid operation area)

System Map: Front View with LCD Panel Open - Models A & C-9
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Figure 3
Front View with LCD
Panel Open
(Models B & D)

=

Built-In PC Camera
(Optional)

LCD

Speakers

Power Button
Hot-Key Buttons
Keyboard

Built-In Microphone
Touchpad & Buttons
Fingerprint Module
(Optional)

10. LED Indicators

© O N O

\ 7
TouchPad button
(valid operation area)

10 - System Map: Front View with LCD Panel Open - Models B & D

System Map: Front View with LCD Panel
Open - Models B & D

\ A/
2 &
Wireless Device
Operation Aboard Aircraft

The use of any portable elec-
tronic  transmission devices
aboard aircraft is usually prohib-
ited. Make sure the wireless
modules are OFF if you are
using the computer aboard
aircraft.

Use the key combinations to

toggle power to the 3.5G/
WLAN/Bluetooth modules,
and check the LED indicator
icon to see if the modules are
powered on or not (see
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LED Indicators

The LED indicators on the computer display helpful information about the current status of the computer.

Icon Color Description Icon Color Description
Orange DC Power is Plugged In Orange The Battery is Charging
Green The Computer is On Green The Battery is Fully Charged
D/ i
Blinking The Computer is in Sleep Blinking The Battery Has Reached Criti-
Green Mode Orange cally Low Power Status

Number Lock (Numeric Key- — . -
[E] Green oad) Activated - Green Hard Disk Activity

Green Caps Lock Activated Green U;%ﬁ?;it'soggxevr\g;egjs LAN
('l’)
El Green Scroll Lock Activated Orange The (optional) Bluetooth Module
is Powered On

Table 2 - LED Indicators

LED Indicators - 11
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Hot-Key Buttons & Keyboard

The Hot-Key buttons give instant access to the default In-
ternet browser and e-mail program, and allow you to tog-
gle the Silent Mode on/off with one quick button press.

Hot-Key Button Function
(@ Activate the Default E-Mail Browser
W Activate the Default Internet Program
(@ Toggle *Silent Mode (for power sav-
ing)

Table 3 - Hot-Key Buttons

*When enabled, Silent Mode will reduce fan noise and
save power consumption. Note this may reduce computer
performance.

The keyboard has a numeric keypad for easy numeric
data input, and features function keys to allow you to
change operational features instantly.

L& ‘08

Numeric Keypad :

Mo <

Figure 4 - Keyboard

4

Special Characters

Some software applications allow the number-keys to be
used with Alt to produce special characters. These special
characters can only be produced by using the numeric key-
pad. Regular number keys (in the upper row of the key-
board) will not work. Make sure that NumLKk is on.

12 - Hot-Key Buttons & Keyboard



Function Keys & Visual Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition to the
basic function key combinations; visual indicators (see the table below) are available when the hot key utility is in-
stalled (see “Hot-Key” on page 25). After installing the driver an icon & will appear in the taskbar.

Concise User’'s Guide

Function/Visual Indicators

Keys Function/Visual Indicators Keys
Fn + ~ Play/Pause (in Audio/Video Programs) Fn +F8/F9 Brightness
Decrease/Increase
3.5G Module | PC Camera Power ] i
Fn+ [ Power Toggle . na . Q Fn+F10 Toggle " ,‘7,7,7,:&7 b j&
— = WLAN Module ) w
Fn+FL | TouchPad Toggle \@ _\\Q_ Fn +F11 Power Toggle ikl (1) i
Turn LCD Backlight Off (Press a key to or use Bluetooth Module
Fn+F2 TouchPad to turn on) Fn+FL2 Power Toggle AT . .
Fn+F3 Mute Toggle | ® Fn + NumLk Number Lock (Numeric Keypad) Toggle
Volume *  On Volume ¥ Mute
Fn+F4 Sleep Toggle Fn + ScrLk Scroll Lock Toggle
Fn+Fs/Fe | Volume Decrease/ Silent Mode Toggle | Nomal Silent @
Increase ialpidinintaars mode mode
Fn + F7 Display Toggle Table 4 - Function Keys & Visual Indicators

Hot-Key Buttons & Keyboard - 13
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System Map: Front & Left Views

Figure 5
Front & Left Views

LED Indicators
DC-In Jack

External Monitor Port
RJ-45 LAN Jack
eSATA Port
HDMI-Out Port

Vent

2*USB 2.0 Ports

ExpressCard/54(34)
Slot

10. 7-in-1 Card Reader 7-in-1 Card Reader

© o N TN E

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) /
MS Pro (Memory Stick Pro) / MS Duo (requires PC adapter) /
Mini SD (requires PC adapter) / RS MMC (requires PC adapter)

eSATA Port

Note that the Intel Matrix Storage driver is required to enable the eSATA port (see “eSA-
TA Port Support” on page 34).

14 - System Map: Front & Left Views
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System Map: Right & Rear Views Figure 6

Right & Rear Views

S/PDIF-Out Jack
Microphone-In Jack
Headphone-Out Jack
USB 2.0 Port

Optical Device Drive
Bay

Emergency Eject Hole
RJ-11 Phone Jack
Security Lock Slot
Battery

SN
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CD Emergency Eject Changing DVD Regional Codes

© ® N

If you need to manually eject a CD/DVD Go to the Control Panel and double-click Device
(e.g. due to an unexpected power inter- Manager (Hardware and Sound), then click the +
ruption) you may push the end of a next to DVD/CD-ROM drives. Double-click on the
straightened paper clip into the emer- DVD-ROM device to bring up the Properties dialog
gency eject hole. Do not use a sharp- box, and select the DVD Region (tab) to bring up the
ened pencil or similar object that may control panel to allow you to adjust the regional
break and become lodged in the hole. code.

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
Don't try to remove a floppy disk/CD/ code 5 times. The fifth selection is permanent. This
DVD while the system is accessing it. cannot be altered even if you change your operating
This may cause the system to “crash”. system or you use the module in another computer.

Media Warning

System Map: Right & Rear Views - 15
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System Map: Bottom View

Figure 7
Bottom View "
1. Battery ZAS
2. Bluetooth Module Cover CPU
3. RAM & CPU Bay Cover The CPU is not a user serviceable 3
4. Vent part. Accessing the CPU in any way 4 Models A & C
5. Hard Disk Bay Cover may violate your warranty.
6. 3.5G USIM Card Overheati
Location verheating

To prevent your computer from
overheating make sure nothing
blocks any vent while the computer
is in use.

4

Battery Information 3

Always completely discharge, then
fully charge, a new battery before
using it. Completely discharge and
charge the battery at least once ev-
ery 30 days or after about 20 partial
discharges.

4
Models B & D

16 - System Map: Bottom View
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Windows Vista Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are ac-
cessed from the Start menu. When you install programs and utilities they will be installed on your hard disk drive,
and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu icon 4, and
then select Properties if you want to customize the appearance of the Start menu.

i Open .@: Default Programs \‘ - [ip - E
I Explore 25y Windows Update —— + G e . - [
. Search... = : d 8
Properties Programs v - ‘
. | Open All Users 5, Documents ’ oes Ry cro
E Explore All Users B setings B Control Panel & =
\ & Network Connections - ~
T = = ;,t Search v :.. = = ] :
— > @ Help and Support ||l Taskbar and Start Menu =
H /5 . @

(0] shutDown...

| Windo

I
Click here to toggle Classic View

Figure 8 - Start Menu & Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel
is accessed from the Start menu, and it allows you to configure the settings for most of the key features in Windows
(e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the features, however
many new controls are added (or existing ones are enhanced) when you install the drivers listed in Table 5 on page 23.
To see all controls it may be necessary to toggle to Classic View on.

. |
Windows Vista Start Menu & Control Panel - 17
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Video Features

This computer features two different (either Intel for Models A & B or NVIDIA for Models C & D) video
options. You can switch display devices, and configure display options, from the Display Settings control panel (in
Personalization) in Windows Vista and/or the Intel GMA Driver for Mobile control panel/NVIDIA Control Pan-
el.

To access Windows Vista Display Settings:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).

2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click Personalization >
Display Settings).

3. Move the slider to the preferred setting in Resolution: 0 (Figure 9 on page 19).
4. Click the arrow, and scroll to the preferred setting In Colors: Q(Figure 9 on page 19).
5. Click Advanced Settings (button) e (Figure 9 on page 19) to bring up the Advanced Settings tabs.

To access the Intel GMA Driver for Mobile Control Panel (Models A & B):
1. The Intel GMA control panel can be accessed by clicking the icon in the taskbar and selecting Graphics Properties
from the menu (or from the Intel GMA Driver for Mobile in the Windows Control Panel).

To access the NVIDIA Control Panel (Models C & D):
1. The NVIDIA Control Panel can be accessed by right-clicking the desktop, and then clicking NVIDIA Control Panel (or from
the NVIDIA Control Panel in the Windows Control Panel).
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Figure 9 - Display Settings & Intel GMA Driver for Mobile control panel/NVIDIA Control Panel

Attaching Other Displays

Besides the built-in LCD you can also use an external monitor/flat panel display/TV (TV through HDMI-Out port
only), connected to the external monitor port or to the HDMI-Out port (High-Definition Multimedia Interface) as your
display device.
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Audio Features

You can configure the audio options on your computer
from the Sound 7 control panel in Windows, or from the
Realtek HD Audio Manager g/ @: icon in the taskbar/
control panel (right-click the taskbar icon gfj to bring up
an audio menu). The volume may also be adjusted by
means of the Fn + F5/F6 key combination.

ﬂ]] Sound Manager /
Audio Devices Sound Volume
Adjustment

System Sound Events

The sound volume level is

OF =)

Windows Media Player set using the volume con-
e trol within Windows (and
Higy Yol Contiol the volume function keys
P — on the cqmpu_ter). Click the
N Volume icon in the taskbar

ESSSCACITES| | to check the setiing.

Right-click the icon g
to access the menu
above.

HDMI Audio Configuration

As HDMI (High-Definition Multimedia Interface)
carries both audio and video signals you will need to
configure the audio output as per the instructions be-
low.

Windows Audio Setup for HDMI

1.

Connect a device with HDMI support to the HDMI-Out
port.

Click Start, and click Control Panel (or point to Settings
and click Control Panel).

Click Sound » (Hardware and Sound).

Click Playback (tab), and click to select HDMI Device
(Models A & B)/NVIDIA HDMI Output (Models C & D).

Click Set Default (button).
Click OK to close the Sound # control panel.

You will now be able to hear audio sources when played in
Windows Media Player.
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_ HDMI Notes
Click the taskbar . connect a device with HDMI support to the HDMI-
volume indicator [f Out port BEFORE attempting to play audio/video
when HDMI - De- sources through the device.
viceIs _selected, and If you disconnect the HDMI cable the default audio
you will note that layback device will not revert to speakers until th
the icon at the top of playbac .e ce .O cve ospez.a ersu €
the volume level in- computer is restarted (if you do not wish to restart the
dicator has changed. computer then go to the Sound control panel and select

Speakers as the default audio playback device).

Click the taskbar
volume indicator [Jj
~\When NVIDIA

HDMI Output is
selected, and you
will note that the
icon at the top of the
volume level indi-
cator has changed.

Figure 10 - HDMI Device/NVIDIA HDMI Output
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Power Options

The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 17) allows you to
configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change Plan Settings and click Change advanced power settings to access further
configuration options.

——

@ a Pawer Options
u

~ | 43 [ searen

Select a power plan

Choose what closing the lid
does

Create a power plan

[® Choose
display

when to turn off the

& Change when the computer

@ Balanced
Change plan setting

() Power saver

s

Change plan settings

(©) High performance

Change plan settings

Battery life: 900
Performance: @09

Battery life: 900000
o

Battery life: 90
Performance: 2099@9
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Note: Sleep is the default power saving state in Windows Vista

Figure 11 - Power Options
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Dr|Ver In Stal I at|0 n Driver (Windows Vista with SP1) Page#
The Device Drivers & Utilities + User’s Manual disc Chipset page 24
contams the drivers and utilities necessary for the.proper Video page 24
operation of the computer. Insert the disc and click In- _
stall Drivers (button), or Option Drivers (button) to ac- | Aud page 24
cess the Optional driver menu. Modem page 24
Install the drivers in the order indicated in Table 5. Af- | LAN page 24
ter installing each driver it will become grayed out (if you TouchPad page 24
need to reinstall any driver, click Unlock). CardReader page 25
Manual Driver Installation Hot-Key page 25
Click the Browse CD button in the Drivers Installer ap- | 8SATA Support page 34
plication and browse to the executable file in the appro- PC Camera (Optional) page 25
priate driver folder. 3.5G Module (Optional) page 30
Windows Update Wireless LAN (Optional) page 33
After installing all the drivers make sure you enable | 'Mté! Turbo Memory (Optional) page 34
Window Update in order to get all the latest security up- Fingerprint Reader (Optional) page 35
dates etc. (all updates will include the latest hotfixes [ g eto0th (Optional)
from Microsoft). Note: No driver installation required (see page 37)

Table 5 - Driver Installation Enable Windows Update (see left)
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New Hardware Found

If the Found New Hardware wizard appears during the in-
stallation procedure, click Cancel to close the window,
and follow the installation procedure as directed.

Chipset

1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

Video
1. Click 2.Install Video Driver > Yes.

Models A & B (Intel):
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Models C & D (NVIDIA):

4. Click Next.
5. Click Finish to restart the computer.

Audio
1. Click 3.Install Audio Driver > Yes.

2. Click Next.
3. Click Finish to restart the computer.

Modem

1. Click 4.Install Modem Driver > Yes.

2. Click OK.

3. The modem is ready for dial-up configuration.

LAN

1. Click 5.Install LAN Driver > Yes.

2. Click Next > Install.

3. Click Finish.

4. The network settings can now be configured.

TouchPad

1. Click 6.Install Touchpad Driver > Yes.

2. Click Next.

3. Click Finish > Restart Now to restart the computer.
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CardReader

1. Click 7.Install Cardreader Driver > Yes.
2. Click Next > Install.

3. Click Finish.

Hot-Key

1. Click 8.Install Hotkey Utility > Yes.

2. Click Next > Install.

3. Click Finish > Finish to restart the computer.

eSATA Support

See “Intel Turbo Memory & Matrix Storage Setup
and Driver Installation” on page 34 for instructions
on installing this driver to enable the eSATA port.

Concise User’'s Guide
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PC Camera

The PC Camera module uses the BisonCap application
to capture video files.

2N
I

Latest PC Camera Driver Information

Check the Device Drivers & Utilities + User's Manual disc,
and any accompanying insert pages, for the latest updated
information on the PC Camera driver, which may override
the information provided here.

PC Camera Driver Installation

1.

o0k wn

Turn on the module using Fn + F10 (the on-screen
visual indicator @ will briefly be displayed when

the module is powered on).

Click Option Drivers (button).

Click 1.Install WebCam Driver > Yes.

Choose the language you prefer and click Next > Next.
Click Finish to restart the computer.

Run the BisonCap application program from the
BisonCam shortcut on the desktop, or from the
BisonCam item in the Start > Programs/All
Programs menu (if the hardware is turned off use the
Fn + F10 key combination to turn it on again).

PC Camera Audio Setup

If you wish to capture video & audio with your camera,
it is necessary to setup the audio recording options in
Windows.

10.

Click Start, and click Control Panel (or point to Settings
and click Control Panel).

Click Sound *? (Hardware and Sound).
Click Recording (tab).

Right-click Microphone (Realtek High Definition Audio)
and make sure the item is not disabled.

Double-click Microphone (or select Properties from the
right-click menu).

Click Levels (tab), and adjust the Microphone and
Microphone Boost sliders to the level required.

Click OK and close the control panels.

Run the BisonCap program from the Start > Programs/
All Programs > BisonCam menu.

Go to the Devices menu heading and select Microphone
(Realtek....) (it should have a tick alongside it).

Go to the Capture menu heading and select Capture
Audio (it should have a tick alongside it).
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BisonCap

The BisonCap application is a video viewer useful for
general purpose video viewing and testing, and can cap-
ture video files to .avi format.

1. Run the BisonCap program from the Start > Programs/
All Programs > BisonCam menu (it is recommended that
you Set Capture File before the capture process - see
“Set Capture File” below).

2. Go to the Capture menu heading (if you wish to capture
audio check “PC Camera Audio Setup” on page 26) and
select Start Capture.

3. Click OK (the file location will be displayed in the pop-up
box) to start capturing the video, and press Esc to stop the
capture (you can view the file using the Windows Media
Player).

Set Capture File

Prior to capturing video files you may select the Set Cap-
ture File... option in the File menu, and set the file name
and location before capture (this will help avoid acciden-
tally overwriting files). Set the name and location then
click Open, then set the “Capture file size:” and click
OK. You can then start the capture process as above.

Concise User’'s Guide

Zoom
The BisonCap program allows you to zoom the camera
in and out.

1. Runthe BisonCap program.
2. Goto Zoom and select ZoomOut/Zoom In.

Taking Still Pictures
The BisonCap program allows you to take still pictures.

1. Runthe BisonCap program.
2. Goto Options and select Take Picture.
3. The picture (in JPEG format) will be placed in the

Snapshot folder % on the desktop (do not move or
rename the folder).
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Eliminating Screen Flicker

If you find that the video screen in the BisonCap pro-
gram is flickering, you can try to adjust the setting in the
Video Capture Filter options.

1. Runthe BisonCap program.

2. Goto Options and scroll down to select Video Capture
Filter....

3. Click either 50Hz or 60Hz under Frequency in Property
Page (tab).

Reducing Video File Size

Note that capturing high resolution video files requires a
substantial amount of disk space for each file. After re-
cording video, check the video file size (right-click the
file and select Properties) and the remaining free space
on your hard disk (go to Computer, right-click the hard
disk, and select Properties). If necessary you can re-
move the recorded video file to a removable medium e.g.
CD, DVD or USB Flash drive.

Note that the Windows Vista system requires a minimum
of 15GB of free space on the C: drive system partition.
In order to prevent system problems it is recommended
that you save the captured video file to a location other
than the C: drive (see “Set Capture File” on page 27),
limit the file size of the captured video or reduce video
resolution.

To Reduce Video Resolution Output Size:

1. Runthe BisonCap program.

2. Goto Options and scroll down to select Video Capture
Pin....

3. Click the Output Size drop box and select a lower
resolution size in order to reduce the captured file size.
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3.5G Module

If you have included an optional 3.5G module in your
purchase option, follow the instructions below to install
the USIM card (which will be provided by your service
provider), and then install the application.

2NZ
2 &

Power Safety Warning

Figure 12 - SIM Card Cover Removal

6. Insert the USIM card as illustrated in (Figure 13) and
close the SIMLOCK.

Before you undertake any installation procedures, make

sure that you have turned off the power, and disconnected
all peripherals and cables (including telephone lines). It is
advisable to also remove your battery in order to prevent 7. Lock the SIMLOCK by pushing it in the direction of the
accidentally turning the machine on. arrow in Figure 13 until it clicks into the lock position.

8. Replace the cover, screw and battery.

1. Turn off the computer, and turn it over and remove the
battery.

2. Locate the SIM card cover and loosen screw @ in Figure
12.

3. Remove the SIM card cover e in Figure 12.

Insert the USIM card as you would into your mobile phone.

5. Slide the SIMLOCK towards the hinge (in the opposite

direction to the arrow illustrated in Figure 13) in order to Figure 13 - Insert the USIM Card & Lock the SIM-
release the lock and lift it up. LOCK

»
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3G Watcher Application

With the 3.5G module and USIM card (provided by
your service provider) installed you may then install the
3G Watcher application. The 3G Watcher application
allows you to directly access your 3.5G internet service
from the computer.

3G Watcher Application Installation

1. Make sure you enable power to the module by pressing
the Fn + [Z_] key combination (the on-screen visual indi-
cator . < will indicate the module’s power status).

2. If a Found New Hardware wizard appears, click
Cancel.

Click Option Drivers (button).

Click 2.Install 3G Driver > Yes.

Click Next.

Click the button to accept the license agreement, and

then click Install.

7. When the next screen appears wait about 2 minutes
before clicking Finish (to allow the hardware to detect
the 3.5G module).

8. The 3G Watcher icon ﬁ will appear on the desktop.

9. You can access the 3G Watcher application from the

Start menu (Start > Programs/All Programs > Sierra

o 0k~ w

Wireless > 3G Watcher), or by clicking the desktop
icon F.
Setting Up a Carrier Profile
Although the connection information is stored on the
USIM card supplied by the service provider, you will
need to set up the appropriate carrier profile from the 3G
Watcher software.

1. Power on the 3.5G module using the Fn + [] key combi-
nation.

2. Access the 3G Watcher application from the Start menu
(Start > Programs/All Programs > Sierra Wireless > 3G
Watcher), or by clicking the desktop icon ﬁ

3. Click Tools and select Options.

4. Click Profiles and then click the Add new profile button
&, and select WWAN profile.

Figure 14 - Add WWAN Profile
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You can then enter a new profile name or choose a profile
from the drop-down list provided by the software.

Click Apply > OK to save the information.
You can choose the profile from the pull-down menu.

36 Watcher

View  Tosls  Help
L@
Chunghwa Telecom

SiERAA WiRELESE

S/ WhN - Chung'wa Telecom 34
=

Profile Details

If you have chosen the profile from the drop-down list then
most of the information in the General and Advanced
tabs should be automatically filled in for you (however
check with your service provider for the latest information
as you may at least need to add in your Username and
Password).

Figure 15 - User Options and Choose Profile
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Connecting to the Service Provider

1.

Power on the 3.5G module using the Fn + key combi-
nation.

You can access the 3G Watcher application from the Start
menu (Start > Programs/All Programs > Sierra
Wireless > 3G Watcher), or by clicking the icon E

The software will run and display the service provider name
(connection information is obtained from the USIM card).

Figure 16
3G Watcher

Click Connect to begin the connection process.
The 3G Watcher application will then display the
connection information in the window.

When the connection is successful a taskbar notification
wiII appear (as below).

b 3G Watcher
|

Connected to
leng Wa Telecom

You can then access the internet, download e-mail etc. as
per any internet connection.

Figure 17
Connected Task-
bar Notification
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10.
11.

12.

13.

14.

While you are connected the taskbar icon will be green
m (it will be red ‘ when the program is running but not
connected).

The program will disconnect from the service provider.
The module will still be on, and you will need to press the
Fn + E] key combination.

If you click the 3G Watcher close icon [£§ a message will
be displayed asking you to click OK to confirm the
program exit.

B

a Figure 18
Bluetooth
Devices
Options

Exiting the program DOES NOT turn off the 3.5G module,
and you will need to press the Fn + E] key combination to
turn off the module (pay careful attention to this aboard
aircraft - see “Wireless Device Operation Aboard
Aircraft” on page 9).

If the module is on and the computer enters a power-
saving state, then the power status of the module on
resuming from the power-saving state will be as below:

* If the 3.5G module is on and the computer is Shut
Down or Restarted; the module will be off when the
computer starts up.

« |If the 3.5G module is on and the computer enters
Sleep or Hibernate; the module will be off when the
computer resumes from sleep.

Short Messaging Service

In addition to standard internet services you may also
send and receive SMS text messages using the 3G
Watcher program.

1.

The SMS message indicator [[i# in the main window will
notify you of any new messages received.

Double-click the icon [ or select Tools > SMS Express.
Select the inbox folder and select any message to read it,
or select File > New Message or click the New button to
prepare a new message.

For more details on SMS see 3GWatcher Online Help
from the Help > Help Topics menu.
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Wireless LAN
A

Power Toggle for the Wireless LAN Module

Enable power to the Wireless LAN module by using the
Fn + F11 key combination. When the Wireless LAN mod-
ule is powered on, the () LED will be green and the on-
screen visual indicator , __“ will briefly be displayed.

© rasoen

Wireless LAN Driver Installation
Make sure the module is powered on.

Click Option Drivers (button).

Click 3.Install Wireless Lan Driver > Yes.
Click Next > Next.

© 0ok wbN Pk

Click Next > Next > Finish.

Note: The operating system is the default setting for

Wireless LAN control in Windows Vista.

Click the button to accept the license and click Next.

Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1.

Concise User’'s Guide

Click the taskbar wireless icon [&, and then click Connect
to a network (or right-click the icon [&§, and then click
Connect to a network).

In the Show list, click to choose Wireless from the drop-
down menu.

A list of currently available networks will appear.

Click a network, and then click Connect.

If you do not see a network you want to connect to, click
Set up a connection or network (a list of options will
appear allowing manual searching, and creating a new
network).

Move the cursor over the taskbar icon @ to see the
connection status.

To disconnect from the wireless network you can click the
taskbar wireless icon @ and then select Connect or
disconnect to access the network menu, and click
Disconnect (or right-click the icon @ and then click
Disconnect from).
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Intel Turbo Memory Module
A

eSATA Port Support

Note that the Intel Matrix Storage driver is required to
enable the eSATA port even if you have not included an
Intel Turbo Memory module in your purchase configura-
tion.

Follow the instructions provided here in order to install the
driver.

If you have included an Intel Turbo Memory (Robson)
NAND flash memory card module in your purchase op-
tion, then you will need to install the driver as per the
instructions below (do not install this driver in Win-
dows XP).

Intel Turbo Memory Technology (also known as Rob-
son flash memory) is an Intel technology that reduces
the time it takes for a computer to boot up, to load appli-
cations, and to write data to the hard drive. Intel Turbo
Memory Technology is supported in Windows Vista only
(it also supports Windows Vista features such as Ready-
Boost, ReadyDrive, and Superfetch).

Concise User’'s Guide

Intel Turbo Memory & Matrix Storage

Setup and Driver Installation
1. Start-up your computer and press F2 to enter the BIOS.

2. Go to the Advanced menu, select "Installed O/S" and
make sure "Vista" is the selected option.

3. Go to the "SATA Mode Selection" item and make sure
"AHCI" is selected.

4. Select "Exit Saving Changes" from the Exit menu (or
press F10 and Enter) and press Enter to exit the BIOS
and reboot the computer.

5. Insert the Device Drivers & Utilities + User’s Manual
disc into the CD/DVD drive.

Click Option Drivers (button).

Click 4.Install TM&IMSM Driver > Yes.
Click Next > Yes > Next > Next.

Click Finish to restart the computer.

© 0N

S — T ===+ Windows ReadyBoost -

@ = = uses flash memory as a

= hard-drive caching solution.

* Windows ReadyDrive -
uses hybrid drives as a
hard-drive caching solution.

Figure 19 - Intel Turbo Memory Console
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Fingerprint Reader

If you have included the fingerprint reader in your pur-
chase option you will need to install the driver as per the
instructions below.

Make sure you have administrator’s rights to your com-
puter, and have a Windows password enabled for full se-
curity protection.

Before beginning the enrollment process it is recom-
mended that you go through the fingerprint tutorial. To
run the tutorial click Start > Programs/All Programs >
Protector Suite QL > Fingerprint Tutorial after in-
stalling the driver.

Fingerprint Reader Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual
disc into the CD/DVD drive.

Click Option Drivers (button).

Click 5.Install FingerPrint Driver > Yes.
Click Software Installation.

Click Next > Next > Next.

Click Finish > Yes to restart the computer.

© ok owd
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4

Help & Manual

Right-click the taskbar icon [ to bring up the menu to se-
lect Help.

Insert the Device Drivers & Utilities + User’'s Manual disc
and click Option Drivers (button). Click Unlock (button)
and then click 5.Install FingerPrint Driver > Yes.

Click Documentation to open the folder containing the
manual in .pdf format.

To install the Adobe Acrobat Reader software to read the file,
insert the Device Drivers & Utilities + User’'s Manual disc
and click User’s Manual (button), and click Install Acro-
bat Reader (button).

User Enrollment

1.

Click Start > Programs/All Programs > Protector Suite
QL > User Enrollment, or double click the taskbar icon
On the first run of the program you will be asked to click
the button to accept the license, and then click OK.

Click Next (“Enrollment to the hard disk” will
automatically be selected), and click Finish.
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4. If you have not set a Windows password you will be 16. See “Help & Manual” on page 35 for further details.
prompted to do so (note: If you have not set a password 17. If you swipe your finger over the reader at any time you
Protector Suite QL cannot secure access to your can access the Biomenu to lock the computer, register
computer). websites, open the Control Center and access the Help

5. Click Next and you will then be prompted to enter your menu.

Windows password. 18. The Control Center allows you to change the Settings,

6. Click Next > Next (if you have the “Run interactive enroll Fingerprints and get Help.
tutorial” tickbox selected you will run through the
Fingerprint Tutorial).

7. Click Next for each window of the tutorial (you can click 5
. R . ingerprint Control Center
the button to “skip tutorial” at any time). © Fingerprints ® ok
Erenl 0 odf Cumant user's TNgeIpant lemplates
8. Click the button above any of the fingers to begin the T,
enroliment process for that finger. © Holp

Gl hadp information

9. Swipe the finger three times to enroll that finger.

10. Repeat the process for all the fingers you wish to enroll,
and then click Next.

11. Click Finish.

12. Click any of the headings under “Learn more about:” to
get more information on any topic.

13. Click Close.

14. Restart the computer. Fingerprint Enroliment

15. Right-click the taskbar icon [f£] to bring up the menu that Note that it is strongly recommended that you enroll
allows you to Edit Fingerprints, Start Control Center, more than one finger in case of injury etc.

access the Help menu etc. You can also run the Control
Center etc. from the Protector Suite QL item in the
Programs/All Programs menu.

Figure 20 - Control Center & Biomenu
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Bluetooth Configuration

Setup your Bluetooth Device so the
Computer Can Find it

1.
2.

Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.

Make the device discoverable (to do this check your
device documentation).

To Turn the Bluetooth Module on

1.

Press the Fn + F12 key combination to power on the Blue-
tooth module.

A Bluetooth icon [J will appear in the taskbar (you may
need to enable the option from the Bluetooth Devices
control panel).

You can then do any of the following to access the
Bluetooth Devices control panel.

» Double-click the icon g to access the Bluetooth Devices
control panel.

* Click Start, and click Control Panel (or point to Settings
and click Control Panel), and then click Bluetooth
Devices (Hardware and Sound).

* Click/Right-click the icon g§ and choose an option from
the menu.

Concise User’'s Guide

Bluetooth Data
Transfer

Note that transferring
data between the com-
- puter and a Bluetooth

— enabled device is sup-

ported in one direction

Add a Bluetooth Device

Show Bluetooth Devices only (simultaneous
Sind o e data transfer is not
Receive a File Supported).

Join a Personal Area Metwork

Open Bluetooth Settings

Remaowe Bluetooth Icon

Figure 21 - Bluetooth Devices & Click Icon Menu

To Add a Bluetooth Device

1.
2.

Access the Bluetooth Devices control panel.

Click Options (tab), and make sure that Allow Bluetooth
devices to connect to this computer check box
(Connections) has a tick inside it.

Click Devices (tab), and then click Add.

The Add Bluetooth Device Wizard will appear.
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5. Click to select “My device is set up and ready to be
found”, and then click Next.

[ = =

§

E

é
o

Figure 22 - Add Bluetooth Device Wizard

6. The Wizard will then search for any available Bluetooth
devices within range.

7. Select the device you want to communicate with, and click
Next.

8. Select an appropriate passkey option and click Next >
Finish.

O L9 Brtoots Cover Wiewd

Figure 23 - Passkey Option

To Change Settings for the Bluetooth

Device
1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click
Properties to:
¢ Change the name of the device (click General, type a new
name and click OK).
¢ Enable/Disable a service (click Services, tick/clear the
check box next to the service and click OK).

To Make your Computer Discoverable
to Bluetooth Devices

1. Access the Bluetooth Devices control panel.
2. Click Options, and make sure that Allow Bluetooth

devices to find this computer check box (Discovery)
has a tick inside it.

3. Make sure that Alert me when a new Bluetooth device

wants to connect check box (Connections) has a tick
inside it, if you want to be notified when a Bluetooth device
wants to connect.

0 Bluctooth Devees

=]

Devices | Optons. | COM Poss | Hardes

Figure 24
Bluetooth
Devices
Options
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Troubleshooting

Problem

Possible Cause - Solution

The Wireless LAN/
Bluetooth modules
cannot be detected.

The modules are off. Check the LED indicator () to see if the WLAN/Bluetooth is on or off. If
the LED indicator is off, then press the Fn + F11 (WLAN) or Fn + F12 (Bluetooth) key
combination in order to enable the modules (see Table 4 on page 13).

The Bluetooth module is
off after resuming from
Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving
state. Use the key combination (Fn + F12) to power on the Bluetooth module after the computer
resumes from Sleep.

A file cannot be copied to/
from a connected
Bluetooth device.

Transferring data between the computer and a Bluetooth enabled device is supported in one
direction only (simultaneous data transfer is not supported). If you are copying a file from
your computer to a Bluetooth enabled device, you will not be able to copy a file from the
Bluetooth enabled device to your computer until the file transfer process from the computer has
been completed.

The captured video files

from the PC Camera are
taking up too much disk

space.

Note that capturing high resolution video files requires a substantial amount of disk space for
each file. See “Reducing Video File Size” on page 28.

No sound can be heard
through an HDMI
connected display device.

You have not configured the HDMI audio output. See “HDMI Audio Configuration” on
page 20.
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Specifications

4

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/speeds
and CD/DVD device types) may be changed, delayed or updated due to the manufacturer's release schedule. Check with your ser-

vice center for details.

Feature Specification

Processor Intel® Core™2 Duo Processor 45nm (45 Nanometer) Process Technology
(478-pin) Micro-FC-PGA Package, 35W 6MB On-die L2 Cache & 1066MHz FSB
T9400/ T9600 2.53/2.8 GHz
Intel® Core™2 Duo Processor 45nm (45 Nanometer) Process Technology
(478-pin) Micro-FC-PGA Package, 25W 6MB On-die L2 Cache & 1066MHz FSB
P9500 2.53 GHz
Intel® Core™2 Duo Processor 45nm (45 Nanometer) Process Technology
(478-pin) Micro-FC-PGA Package, 25W 3MB On-die L2 Cache & 1066MHz FSB
P8400/ P8600 2.26/ 2.40 GHz

Core Logic Models A & B: Models C & D:
Intel(R) GM45 + ICH9M Chipset Intel(R) PM45 + ICH9M Chipset
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Feature Specification
LCD Options Models A & C: Models B & D:
14.1" WXGA/ WXGA+ Glare Type TFT LCD 15.4" WXGA/ WXGA+/ WSXGA+ Glare Type TFT
LCD
Video Adapter Models A & B: Models C & D:
Intel GM45 Integrated Video (Internal On Chip) NVIDIA GeForce 9300M GS Discrete Video (External
High Performance 2D/3D Graphics Accelerator On Board)
Shared Memory Architecture (up to 256MB 256MB of GDDR2 Video Memory On-Board
shared video memory dynamically allocated from TurboCache™ Supporting Total Graphics
system memory where needed) Memory up to 512MB (depending on system
Supports Microsoft DirectX 10.0 memory)
Supports DirectX 10.0
Memory Two 200 Pin SO-DIMM Sockets Supporting DDRII (DDR2) 667/800 MHz
Memory Expandable up to 4GB
Security Security (Kensington® Type) Lock Slot BIOS Password
Fingerprint Reader Module (Factory Option)
BIOS One 32Mb SPI Flash ROM Phoenix™ BIOS
Storage One Changeable 12.7mm(h) SATA Optical Device (CD/DVD) Type Drive (see “Optional” on page 44 for

drive options)
Easy Changeable 2.5" 9.5 mm (h) SATA (Serial) HDD

Audio Intel High Definition Audio Compliant Interface S/PDIF Digital Output
3D Stereo Enhanced Sound System 2 * Built-In Speakers
Sound-Blaster PRO™ Compatible Built-In Microphone
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Feature Specification
Keyboard & Winkey Keyboard Built-In TouchPad with Scrolling Function
Pointing Device
Interface Three USB 2.0 Ports One eSATA Port
One HDMI (High-Definition Multimedia Interface) Port ~ eSATA supported in Windows Vista only:
(supports 5.1 channel) with audio output AHCI mode supports hot swapping
One Headphone-Out Jack IDE mode does not support hot swapping
One Microphone-In Jack
One S/PDIF Out Jack One RJ-11 Modem Jack

One RJ-45 LAN Jack
One DC-in Jack
One External Monitor Port

Card Reader Embedded 7-in-1 Card Reader (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)
Note: MS Duo/ Mini SD/ RS MMC Cards require a PC adapter

ExpressCard Slot | One ExpressCard/34(54) Slot

Mini-Card Slots One Mini-Card Slot for Wireless LAN Module
One Mini-Card Slot for Intel Turbo Memory Module OR 3.5G Module
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Feature Specification

Communication Built-In Gigabit Ethernet LAN
56K MDC Modem, V.90 & V.92 Compliant ﬁ
Wireless Module Options: UMTS Modes
Intel® WiFi Link 5300 (802.11 a/g/n) Wireless LAN Mini-Card Module
Intel® WiFi Link 5100 (802.11 a/g/n) Wireless LAN Mini-Card Module Note that UMTS

) : modes CAN NOT

1.3M or 2.0M Pixel USB PC Camera Module (Factory Option) e ueesl i Mein
Bluetooth 2.0 + EDR (Enhanced Data Rate) Module (Factory Option) America.

UMTS/HSPDA-based 3.5G Module with Mini Card Interface (Factory Option)
Quad-band GSM/GPRS (850 MHz, 900 MHz, 1800 MHz, 1900 MHz)
UMTS WCDMA FDD (2100 MHz)

Power Supports ACPI1 3.0

Management

Power Models A & B: Models C & D:
Full Range AC/DC Adapter Full Range AC/DC Adapter
AC Input: 100 - 240V, 50 - 60Hz AC Input: 100 - 240V, 50 - 60Hz
DC Output: 19V, 3.42A or 18.5, 3.5A (65 Watts) DC Output: 19V, 4.74A (90 Watts)

6 Cell Smart Lithium-lon Battery Pack, 4.0AH OR 4.4AH
9 Cell Smart Lithium-lon Battery Pack, 7.2AH (Option)

Environmental Temperature Relative Humidity
Spec Operating: 5°C - 35°C Operating: 20% - 80%
Non-Operating: -20°C - 60°C Non-Operating: 10% - 90%
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DVD/CD-RW Combo SATA Drive Module
DVD Dual (Super Multi) SATA Drive Module

Wireless Module Options:
Intel® WiFi Link 5300 (802.11 a/g/n) Wireless LAN
Mini-Card Module

Intel® WiFi Link 5100 (802.11 a/g/n) Wireless LAN
Mini-Card Module

9 Cell Smart Lithium-lon Battery Pack

1.3M or 2.0M Pixel USB PC Camera Module
(Factory Option)

Fingerprint Reader Module (Factory Option)

Bluetooth 2.0 + EDR (Enhanced Data Rate) Module

(Factory Option)

Feature Specification

Dimensions Models A & C: Models B & D:

& Weight 336mm (w) * 250mm (d) * 24.8 - 35.7mm (h) 359mm (w) * 268mm (d) * 24.8 - 37mm (h)
2.3 kg With 6 Cell Battery 2.6 kg With 6 Cell Battery

Optional Optical Drive Module Options: 2GB Intel Turbo Memory Module

or
UMTS/HSPDA-based 3.5G Module with Mini Card
Interface (Factory Option)

Quad-band GSM/GPRS (850 MHz, 900 MHz, 1800
MHz, 1900 MHz)

UMTS WCDMA FDD (2100 MHz)

2%

UMTS Modes

Note that UMTS modes CAN NOT be
used in North America.
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Hinwels

Das Unternehmen behélt sich das Recht vor, diese Publikation ohne Vorankiindigung zu Uberarbeiten und den Inhalt zu
verandern. Alle enthaltenen Informationen sind nur Anhaltspunkte und stellen keine Verpflichtung seitens des Herstellers
oder Wiederverkéufers dar. Sie Ubernehmen weder Verantwortung oder Haftung fiir mdgliche Fehler oder Ungenauigkei-
ten dieser Publikation noch sind sie in irgendeiner Weise verantwortlich fiir Verluste oder Schaden aus der Nutzung (oder
fehlerhaften Nutzung) dieser Publikation.

Die Publikation und alle beiliegende Software darf nicht, ganz oder in Teilen, ohne vorheriges Einverstandnis des Verkau-
fers, Herstellers oder Autors dier Publikation reproduziert, tibersetzt, iibertragen oder in maschinenlesbare Form umgewan-
delt werden, abgesehen von Kopien, die fiir Archivzwecke erstellt werden.

In dier Publikation erwahnte Marken- und Produktnamen kénnen Copyrights und/oder eingetragene Warenzeichen ihrer
jeweiligen Firmen in. Sie werden nur zu Identifikationszwecken erwahnt und sind nicht als Werbung fiir die Produkte oder
ihre Hersteller gedacht.

© Mai 2008

Warenzeichen

Dies Produkt beinhaltet durch Urheberrechte geschiitzte Technologie, die durch Anspriiche bestimmter US-Patente und an-
dere geistige Eigentumsrechte geschiitzt ist, welche der Macrovision Corporation und anderen Rechtsbesitzern gehort. Die
Verwendung dier durch Urheberrechte geschiitzten Technologie mul3 von der Macrovision Corporation genehmigt werden
und dient nur fir den Heimgebrauch bzw. andere beschrénkte Ansichtszwecke, wenn nicht anderweitig von der Macrovi-
sion Corporation genehmigt. Reverse Engineering oder Auseinandernehmen ist untersagt.

Intel und Intel Core sind warenzeichen/eingetragenes warenzeichen der Intel Corporation.

. |
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Uber das Ausfiihrliche Benutzerhandbuch

Diese Kurzanleitung soll einen Uberblick tiber die Schritte geben, die dazu notwendig sind, das System zu starten. Dieses
ist nur eine Ergédnzung und kein Ersatz fur das erweiterte englischsprachige Benutzerhandbuch, das auf der mitgelieferten
Disc Device Drivers & Utilities + User's Manual im Adobe-Acrobat-Format vorliegt. Diese Disc enthdlt auch die Treiber
und Utility-Programme, die fir einen einwandfreien Betrieb des Notebooks notwendig sind.

Einige oder alle Funktionen des Notebooks sind bereits eingerichtet worden. Falls das nicht der Fall ist oder wenn Sie ein-
zelne Teile des Systems neu konfigurieren (oder neu installieren) méchten, finden Sie eine Anleitung im erweiterten Be-
nutzerhandbuch. Die Disc Device Drivers & Utilities + User's Manual enthalt nicht das Betriebssystem.
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Informationen zu gesetzlichen Vorschriften
Die Informationen zu gesetzlichen Vorschriften finden Sie im erweiterten Benutzerhandbuch auf der Disc Device Drivers
& Utilities + User's Manual.

SN
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Betrieb von Wireless-Geraten in Flugzeugen

In der Regel ist die Benutzung jeglicher tragbarer elektronischer Funkgerate in Flugzeugen verboten. Achten
Sie darauf, da die Module (Bluetooth, WLAN und 3.5G) AUSGESCHALTET sind, wenn Sie das Notebook
im Flugzeug benutzen.
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Hinweise zu Pflege und Betrieb
Das Notebook ist zwar sehr stabil, kann aber dennoch beschadigt werden. Damit es nicht dazu kommt, sollten Sie die fol-
genden Hinweise beachten:

» Das Gerat darf nicht herunterfallen und in anderer Form Sté3en ausgesetzt werden. Wenn der Computer fallt, kénnen das
Gehduse und andere Komponenten beschadigt werden.

» Halten Sie den Computer trocken, Das Gerét darf nichtiiberhitzt werden. Computer und Netzteil diirfen nicht in der Néhe von
Waérmequellen stehen oder gelagert werden. Dies ist ein elektrisches Gerét. Wenn Wasser oder andere Flissigkeiten eindringen,
kann der Computer stark beschadigt werden.

» Vermeiden Sie Interferenzen mit anderen Geréaten. Halten Sie den Computer fern von magnetischen Feldern, die von Stromquel-
len, Monitoren, Magneten etc. erzeugt werden. Die kdnnen die Leistung beeintrachtigen und Ihre Daten beschadigen.

» Achten Sie auf die richtige Bedienung des Computers. Schalten Sie ihn erst aus, wenn alle Programme geschlossen wurden
(speichern Sie lhre Daten!). Speichern Sie regelméaRig lhre Daten, da diese verloren gehen kénnen, wenn der Akku verbraucht ist.

 Seien Sie vorsichtig bei der Verwendung von Peripheriegeraten.

yoasinag

Reparatur

Reparieren Sie das Gerat nicht selbst. Damit verstoRen Sie gegen die Garantiebedingungen und Sie kénnen Schaden am
Gerdt und an der eigenen Gesundheit verursachen. Uberlassen Sie alle Reparaturen autorisiertem Fachpersonal. Trennen
Sie das Notebook vom Stromnetz. Unter den folgenden Umstanden sollten Sie das Geréat zur Reparatur geben:

« Wenn das Netzkabel oder der AC/DC-Adapter beschédigt oder zerschlissen sind.

« Wenn der Computer Regen ausgesetzt war oder mit Fliissigkeiten in Beriihrung gekommen ist.

e Wenn der Computer unter Beachtung der Bedienungsanweisungen nicht korrekt arbeitet.

» Wenn der Computer heruntergefallen ist oder beschadigt wurde (beriihren Sie nicht die giftige Flussigkeit des LCD-Bildschirms).
* Wenn ein ungewohnlicher Geruch, Hitze oder Rauch aus dem Computer entweicht.

.|
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Stromsicherheit
Fur dieses Computer werden bestimmte Stromanforderungen gestellt:

» Verwenden Sie nur einen AC/DC-Adapter, der fir die Verwendung mit diesem Computer zugelassen ist.

» Der AC/DC-Adapter kann zwar fir internationale Benutzung vorgesehen sein, bendtigt aber trotzdem eine gleichmégige, ununter-
brochene Stromversorgung. Wenn Sie sich Gber lhre lokalen Stromspezifikationen nicht im klaren sind, wenden Sie sich an lhren
Servicevertreter oder lhre lokale Stromgellschaft.

» Der AC/DC-Adapter kann einen zwei- oder dreipoligen geerdeten Netzstecker haben. Der dritte Pol hat eine wichtige Sicherheits-
funktion. Setzen Sie die nicht auBer Kraft. Wenn Sie keinen Zugang zu einer passenden Steckdose haben, lassen Sie von einem qua-
lifizierten Elektriker eine solche einbauen.

» Fassen Sie das Netzkabel am Stecker und nicht am Kabel an, wenn Sie es vom Stromnetz trennen méchten.

 Achten Sie darauf, daf? die Steckdose und alle verwendeten Verldngerungskabel die Gesamtstromlast aller angeschlossenen Geréte trégt.

» Trennen Sie den Computer vor dem Reinigen von allen externen Stromquellen.

2N
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Warnung zur Stromsicherheit
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Bevor Sie Schritte zum Aufristen des Computers unternehmen, missen Sie zunachst das Gerat ausschalten und alle Peripheriegerate
und Kabel (einschlieR3lich Telefonkabel) abtrennen. Sie sollten auch den Akku herausnehmen, damit das Gerat nicht versehentlich ein-

geschaltet werden kann.
Vor dem Transport in einer Tasche ausschalten

Achten Sie darauf, dass Ihr Notebook ausgeschaltet ist, wenn Sie es fur den Transport z.B. wahrend einer Reise in eine Tasche einpak-
ken. In einer Tasche kann/konnen die Luftungsoffnung(en) verdeckt werden. Wenn das Gerat dann noch eingeschaltet ist, kann es uber-
hitzt werden. Damit das eingeschaltete Notebook nicht uberhitzt wird, stellen Sie sicher, dass die Luftungsoffnung(en) immer frei sind.

Reinigung
* Tragen Sie Reinigungsmittel nicht direkt auf das Computer auf. Reinigen Sie es mit einem weichen, sauberen Tuch.
» Verwenden Sie keine flichtigen Reinigungsmittel (Petroleumdestillate) oder Scheuermittel zum Reinigen des Computers.

.|
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Sicherheitshinweise zum Akku

Verwenden Sie nur Akkus, die fiir diesen Computer entwickelt wurden. Ein falscher Akku-Typ kann explodieren, auslaufen oder
den Computer beschadigen.

Verwenden Sie den Akku nicht mehr, wenn er heruntergefallen ist oder in anderer Weise beschédigt (z.B. verzogen) ist. Auch wenn
das Notebook mit dem beschédigten Akku zu funktionieren schein, kdnnen dadurch Stromkreise beschédigt werden, die schlieflich
einen Brand verursachen kdnnen.

Laden Sie die Akkus tber das Notebook auf. Durch falsches Laden kann der Akku explodieren.

Versuchen Sie nicht, Akkus zu reparieren. Lassen Sie die Akkupacks durch den Servicevertreter oder qualifiziertes Fachpersonal
reparieren oder austauschen.

Halten Sie Kinder vom Akku fern und entsorgen Sie beschadigte Akkus sofort. Seien Sie vorsichtig bei der Entsorgung der Akkus.
Akkus kdnnen explodieren oder auslaufen, wenn sie Feuer ausgesetzt sind oder unsachgemaf behandelt oder entsorgt werden.
Halten Sie den Akku von Metallgeraten fern.

Bringen Sie Klebeband auf den Akkukontakten an, bevor Sie den Akku entsorgen.

Beriihren Sie die Akkukontakte nicht mit Ihren Handen oder mit metallenen Gegenstanden.

SN
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Entsorgen der Akkus/Batterien & Achtung

Das von Ihnen gekaufte Produkt enthalt einen aufladbaren Akku. Dier Akku ist wiederverwertbar. Nach verschiedenen nationalen
und regionalen Getzgebungen kann es verboten in, einen nicht mehr gebrauchsféahigen Akku in den normalen Hausmdill zu wer-

fen. Informieren Sie sich bei Ihrem regionalen Entsorgungsunternehmen tiber Recycling-Moglichkeiten oder korrekte Entsorgung.

Wenn ein falscher Akku eingesetzt wird, besteht Explosionsgefahr. Tauschen Sie den Akku nur durch den gleichen oder einen
baugleichen Typ aus, der vom Hersteller empfohlen wird. Entsorgen Sie den verbrauchten Akku entsprechend der Anweisungen
des Herstellers.
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Modellunterschiede
Diese Notebook-Serie umfasst vier verschiedene Modelltypen (fiir jedes Modell gibt es unterschiedliche Designs). Es ist
mdoglich, dass das Design und einige der Hot-Key-Tasten anders aussehen als in diesem Benutzerhandbuch abgebildet. Die

Anschlisse, Komponenten, Funktionen usw. sind jedoch bei allen Ausfiihrungen gleich. Die Modelle unterscheiden sich
wie in der Tabelle beschrieben.

Funktion Modell A Modell B Modell C Modell D
Core Logic Intel(R) GM45 + ICH9M Chipset Intel(R) PM45 + ICH9M Chipset
Videoadapter Intel Integrated Video (auf dem Chip) NVIDIA Discrete Video (extern onboard)

AC/DC-Adapter

65W (DC-Ausgang 19V, 3,42A oder 18,5V, 3,5A)

90W (DC-Ausgang 19V, 4,74A)

LCD-Typ

14,1" WXGA/ WXGA+

15,4" WXGA/ WXGA+/
WSXGA+

14,1" WXGA/ WXGA+

15,4" WXGA/ WXGA+/
WSXGA+

Tabelle 1 - Modellunterschiede
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Schnellstart

1.

2.
3.

Entfernen Sie das gesamte Verpackungsmaterial.

Legen Sie das Notebook auf eine stabile Unterlage.

SchlieRen Sie alle Peripheriegeréte, die Sie mit dem Notebook verwenden wollen (z. B. Tastatur und Maus), an die entsprechenden
Schnittstellen an.

SchlieRen Sie den AC/DC-Adapter an die DC-Eingangsbuchse an der linken Seite des Notebooks an. Verbinden Sie dann das
Netzkabel mit einer Netzsteckdose und dem AC/DC-Adapter.

Klappen Sie den Deckel/LCD vorsichtig mit einer Hand auf, und 6ffnen Sie ihn auf einen angenehmen Sichtwinkel (jedoch nicht
weiter als 130°). Mit der anderen Hand halten Sie das Unterteil des Notebooks fest (siehe Abb. 1 unten) (Hinweis: Heben Sie den

Computer niemals am Deckel/LCD hoch).
Driicken Sie auf den Netzschalter, um das Notebook einzuschalten.

Herunterfahren

Bitte beachten Sie, dal? der Computer immer mit dem Befehl Herunterfahren in das Meni der Schaltflache Sperren
in Windows Vista heruntergefahren werden muf3. Dadurch werden Festplatten- bzw. Systemprobleme vermieden.

Abb. 1 - Offnen des Deckels/LCD/Notebooks mit angeschlossenem AC/DC-Adapter
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Systemsoftware

Mdglicherweise wurde das Notebook bereits mit vorinstal-
lierter Software ausgeliefert. Ist das nicht der Fall, oder
wenn Sie das Notebook flir ein anderes System neu konfi-
gurieren mdchten, finden Sie dazu eine Anleitung in diesem
Handbuch zum Betriebssystem Microsoft Windows Vista.
Weitere Informationen zur Installation der Treiber und
Hilfsprogramme finden Sie in den Kapiteln 4 und 7 des er-
weiterten Benutzerhandbuchs auf der Disc Device Drivers
& Utilities + User's Manual.

4

Treiber

Wenn Sie eine neue Systemsoftware installieren oder erneut in-
stallieren, mussen Sie die geeigneten Treiber installieren. Trei-
ber sind Programme, die als Schnittstelle zwischen dem
Computer und einer Hardware-Komponente, z.B. einem Wire-
less-Netzwerkmodul, dienen. Es ist sehr wichtig, dass Sie die
Treiber in der in Tabelle 5 auf Seite 67 angegebenen Reihen-
folge installieren. Sie kdnnen die meisten erweiterten Einstel-
lungen nicht benutzen, bevor nicht die notwendigen Treiber und
Hilfsprogramme sachgemaR installiert sind.

Unterstltzte Betriebssysteme

Betriebssystem Anmerkung

Informationen zum Betriebssystem

W|r_1§10ws XP (Home Windows XP finden Sie auf der Disc
Edition oder Profes- . . o ,
sional) Device Drivers & Utilities + User’s

Manual.

Bevor Sie die Treiber installieren,
missen Sie das Windows Vista Ser-
vice-Pack 1 (oder eine Version von
Windows Vista, die das Service-Pack
1 enthélt) installieren. Details zum
Download erhalten Sie auf der Web-
site von Microsoft oder von lhrem Ser-
vice-Zentrum.

Windows Vista mit
Service Pack 1 (64-
bit) Home Basic
Edition/ Home Pre-
mium Edition/Busi-
ness Edition/
Enterprise Edition/
Ultimate Edition

Windows Vista kann nur dann mit
voller Leistung laufen, wenn der Com-
puter tber einen Systemspeicher
(RAM) von mindestens 1GB verfigt.

Nicht enthalten

Zu den Betriebssystemen (z.B. Windows Vista/Windows
XP) und zu den Programmen (z.B. Textverarbeitung, Kal-
kulationsprogramme und Datenbanken) gibt es eigene
Handblicher, in denen Sie entsprechende Informationen fin-
den.
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Systemubersicht: Ansicht von vorne mit gedff- Ao 2
netem LCD-Bildschirm (MOdeue A & C) Ansicht von vorne mit

geotffnetem LCD-Bild-
_Il’_ schirm (Modelle A & C)

Y/ \N

Wireless-Module AUSGE-
SCHALTET sind, wenn Sie das
Notebook im Flugzeug benutzen.

TouchPad mit Tasten
Fingerabdruckleser

Driicken Sie die entsprechenden (optional)

Tastenkombinationen, um jeweils 10. LED-Anzeigen
das 3.5G-, das WLAN- oder das
Bluetooth-Modul zu aktivieren. Pri-
fen Sie die Statusanzeige, um fest-
zustellen, ob die Module ein- oder
ausgeschaltet  sind (siehe

Die Benutzung drahtlos 1. PC-Kamera (optional)
angeschlossener Gerate in 2. LCD-Bildschirm g
Flugzeugen 3. Lautsprecher =
In der Regel ist die Benutzung jeg- 4. Netzschalter 2]
licher tragbarer elektronischer 5. Hot-Key-Tasten g
Funkgerate in Flugzeugen verbo- 6. Tastatur
ten. Achten Sie darauf, daR die ’ )
7. Mikrofon
8.
9.

TouchPad-Tasten
(wirksamer Tastenbereich)
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Ao 3 Systemubersicht: Ansicht von vorne mit geotff-
Ansicht von vorne mit Netem LCD-Bildschirm (MOde”e B & D)

geotffnetem LCD-Bild-

; \ A/
schirm (Modelle B & D) ﬂ<
= 1. PC-Kamera (optional) Die Benutzung drahtlos
O 2. LCD-Bildschirm angescf:zllossener Gerate in
ﬂ 3. Lautsprecher ugzeugen
> 4. Netzschalter In der Regel ist die Benutzung jeg-
8 5. Hot-Key-Tasten licher Eragparer elektronischer
6. Tastatur Funkgerate in Flugzeugen verbo-
’ ) ten. Achten Sie darauf, daR die
7. Mikrofon Wireless-Module AUSGE-
8. TouchPad mit Tasten SCHALTET sind, wenn Sie das
9. Fingerabdruckleser Notebook im Flugzeug benutzen.
(optional) Driicken Sie die entsprechenden
10. LED-Anzeigen Tastenkombinationen, um jeweils

das 3.5G-, das WLAN- oder das
Bluetooth-Modul zu aktivieren. Pri-
fen Sie die Statusanzeige, um fest-
zustellen, ob die Module ein- oder
ausgeschaltet  sind (GELE

TouchPad-Tasten
(wirksamer Tastenbereich)
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LED-Anzeigen

Die LED-Anzeigen auf dem Computer zeigen wichtige Informationen (ber den aktuellen Status des Computers.

Ausfihrliches Benutzerhandbuch

Tabelle 2 - LED-Statusanzeigen

Symbol | Farbe Beschreibung Symbol Farbe Beschreibung
Orange | Der AC/DC-Adapter ist angeschlossen Orange Der Akku wird geladen
Griin Der Computer ist angeschaltet Grin Der Akku ist voll geladen
L /LI) Lampe s N m . . " N
blinkt Das System ist im konfigurierten Ener- Lampe blinkt | Der Akku hat einen kritisch niedrigen
griin giesparmodus orange Stromstatus erreicht
. Die Funktion NumLk (Nummerntasta- - . . . .
IE] Grin tur) ist aktiviert - Grin Es wird auf die Festplatte zugegriffen
Griin | Caps-Lock ist aktiviert Griin E:hsa\li\gtreless LAN-Modul ist einge-
()
&l Griin Scroll-Lock ist aktiviert Orange Das Bluetooth-Modul ist eingeschaltet
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Hot-Key-Tasten & Tastatur

Mit den Hot-Key-Tasten haben Sie einen direkten Zugriff
auf den Standard-Internetbrowser und Ihr E-Mail-Standard-
programm, und Sie kénnen mit nur einem schnellen Tasten-
druck den Leise-Modus ein- oder ausschalten.

Tabelle 3 - Hot-Key-Tasten

Hot-Key-Taste Funktion
Das Standard-E-Mail-Programm aktivie-
(@ ren
Einen Standard-Internet browser aktivie-
(W ren
Leise-Modus ein-/ausschalten* (um
(@ Strom zu sparen)

*Wenn der Leise-Modus aktiviert ist, werden die Lifterge-
rdusche und der Stromverbrauch reduziert. Beachten Sie,
dass sich dabei auch die Leistung des Notebooks verringern
kann.

Die Tastatur hat eine eingebettete Nummerntastatur fiir ein-
fache Zahleneingabe. Zusatzlich gibt es Funktionstasten,
Uber die Sie direkt zwischen den Funktionen umschalten
kdnnen (siehe Abb. 4).

Abb. 4 - Tastatur

[ “r' Funkt|o tasten . o IIJII Paa | | Oruck | | Eidg | Entf
! & 3 2 . 8 a

Ein-/Ausschalten des kS

R N 3.5G-Moduls

# -
o 1> 1Y 11X 17c [v Jie Nummemtastatur i
Lo — k|
iy Bl Fn Taste A B o

Post| | Bagh | | Ende

4

Sonderzeichen

Bei einigen Programmen kénnen die Nummern-Tasten zur
Erzeugung von Sonderzeichen zusammen mit der Taste Alt
gedriickt werden. Diese Sonderzeichen kdnnen nur mit der
Nummerntastatur erzeugt werden. Die normalen Zahlenta-
sten (in der oberen Tastenreihe der Tastatur) kénnen dazu
nicht verwendet werden. Die Funktion NumLk muf aktiviert
sein.
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Funktionstasten und visuelle Anzeigen

Wenn die Funktionstasten (F1 - F12) gleichzeitig mit der Fn-Taste gedriickt werden, funktionieren sie wie Hotkeys. Ne-
ben den Tastenkombinationen fiir die Grundfunktionen gibt es visuelle Anzeigen, wenn der Hotkey Treiber (HotKey
Driver) installiert ist (siehe “Hot-Key” auf Seite 69). Wenn der Treiber installiert ist, erscheint in der Taskleiste das Sym-

bol .

Y : Y : v
Tasten Funktion/Visuelle Anzeigen Tasten Funktion/Visuelle Anzeigen D
lligkei %
Fn+~ | Wiedergabe/Pause (in Audio /Videoprogrammen) Fn+Fg/Fg | LCD-Helligkeit ver- o
ringern/erhéhen e
. Ein-/Ausschalten des ] PC-Kamera aktivie- A i
Fn+ & | 3.5G-Moduls ‘, ,0 . ..G Fn+F10 1 rendeaktivieren i - b "4&
TouchPad aktivieren/ = e Wireless-LAN akti- ) P
FneF deaktivieren \‘@ —\\Q— Fn+Fil vieren/deaktivieren ° .E.mi‘l) ® m.wnl
LCD-Hintergrundlicht ausschalten Bluetooth aktivieren/
Fn+F2 | (zum Einschalten beliebige Taste driicken oder Touch- Fn + F12 L 8 .
- deaktivieren . e
Pad berihren) . rerew e
Stummschaltung/Stumm- Fn + Ein-/Ausschalten des NumLk (Nummerntasta-
Fn+F3 | ®
schaltung aufheben S5, Do dirigien fibite: NumLk tur)
Fn + F4 | Wechsel Schlaf/Wiederaufnahme Fn + ScrLk | Ein-/Ausschalten des Scroll-Modus
Fn + F5/ | Audio-Lautstéarke verrin- Ein-/Ausschalten Nl Silent @
F6 gern/erhéhen S5 (@ des Leise-Modus mode oo
Fn+ F7 | Wechseln der Anzeigegerate Tabelle 4 - Funktionstasten & visuelle Anzeigen
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Abb. 5 Systemubersicht: Ansicht von vorne und links
Ansicht von vorne und

links
1. LED-Anzeigen 1
2. DC-Eingangsbuchse

3. Schnittstelle fir exter-
nen Monitor

4. RJ-45 LAN-Buchse

5. eSATA Anschluss

6. HDMI-Ausgangsan-
schluss

7. Luftungsoffnung

2 USB 2.0 Anschliisse

9. ExpressCard/54(34)-

Steckplatz 7-in-1 Kartenleser
10. 7-in-1 Kartenleser
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Mit dem Kartenleser kénnen einige der neuesten digitalen Speicherkarten gelesen werden.

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) /
MS Pro (Memory Stick Pro) / MS Duo (PC adapter erforderlich) /
Mini SD (PC adapter erforderlich) / RS MMC (PC adapter erforderlich)

eSATA Anschluss

Beachten Sie, dass der Intel Matrix Storage-Treiber erforderlich ist, um den eSATA Anschluss
zu aktivieren (siehe “Unterstiitzung des eSATA Anschlusses” auf Seite 78).

.|
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Systemubersicht: Ansicht von hinten und rechts

\ A/

/ N

CD-Notauswurf

Wenn eine CD/DVD manuell entnommen
werden muf3 (z.B. wegen eines Stromaus-
falls) kénnen Sie mit dem Ende einer gera-
degebogenen  Buroklammer in  das
Notauswurfloch drikken. Verwenden Sie
hierzu aber keinen spitzen Bleistift oder
ahnliche Objekte, die im Loch abbrechen
und darin stekkenbleiben kénnten.

Warnung zu Datentragern

Entnehmen Sie keine Diskette/CD, wenn
das System gerade darauf zugreift. Da-
durch koénnte es zu einem “Systemzusam-
men-bruch” kommen.

Rechte Seite
9

Hintenseite

Die DVD-Regionalcodes éndern

Gehen Sie auf Systemsteuerung und doppelKlicken
Sie auf Gerate-Manager (Hardware und Sound)
und dann auf das + neben den DVD/CD-ROM-Lauf-
werken. Klicken Sie doppelt auf das DVD-ROM-Lauf-
werk, 6ffnen das Menu Eigenschaften und wéahlen
DVD-Region (Registerkarte). In dem angezeigten
Fenster konnen Sie nun den Regionalcode einstellen.
Die DVD-Regionserkennung hangt vom Gerat, nicht
vom Betriebssystem ab. Sie kdnnen den Regionalco-
de fur Ihr Modul 5mal wahlen. Die funfte Wahl ist
nicht mehr dnderbar. Sie kann auch bei Wechsel des
Betriebssystems oder bei Verwendung des Moduls in
einem anderen Computer verandert werden.

Systemibersicht: Ansicht vo

Abb. 6
Ansicht von hinten und
rechts

1. S/PDIF-Ausgangs-
buchse

2. Mikrofon-Eingangs-
buchse

3. Kopfhorer-Ausgangs-
buchse

4. USB 2.0 Anschluss

5. Schacht fir optisches
Laufwerk (fur CD/DVD-
Gerate)

6. Notauswurfloch

7. RJ-11-Telefonbuchse

8. Sicherheitsschlof3-
Buchse

9. Akkufach

n hinten und rechts - 59
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Abb. 7 Systemubersicht: Ansicht von unten

Ansicht von unten

Akku ﬁ

2. Abdeckung des Blue- CPU

=

- tooth-Modulfachs Die CPU darf nicht vom Anwender repa- 3
(&) 3. Abdeckung des CPU/ riert werden. Jeglicher Zugriff auf die 4
2] RAM-Schachts CPU fiihrt zum Verlust der Garantiean- Modelle A & C
- | 4. Luftungsoffnung spriiche.
8 5. Abdeckung des Fest- . .

plattenschachts Uberhitzung

6. Position der 3.5G Zum Schutz vor Uberhitzung Ihres
USIM-Karte Computers dirfen die Luftungsoff-

nung(en) nicht wahrend das Notebook
in Betrieb ist verdeckt werden.

4

Hinweis zum Akku

3

Ein neuer Akku sollte bei seiner ersten

Verwendung zuerst einmal vollstandig 4 Modelle B & D
entladen und dann komplett wieder ge-

laden werden. Entladen und laden Sie

den Akku mindestens einmal im Monat

oder nach etwa 20 Teilentladungen ein-

mal vollstandig.
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Windows Vista Startmenl und Systemsteuerung

Die meisten Einstellfenster, Utilitys und Programme erreichen Sie in Windows Vista (und bei den meisten anderen Ver-
sionen von Windows) tiber das Start-Menii. Wenn Sie Programme und Utilitys installieren, werden diese auf der Festplatte
installiert. Eine Verknipfung davon wird in das Start-Men( und/oder auf dem Desktop erstellt. Klicken Sie mit der rechten
Maustaste auf das Startmenti-Symbol [, und wahlen Sie die Option Eigenschaften, um das Erscheinungsbild des Start-

mends zu andern.

Wi L@ Standsrdprogramme

P Windows Update
-l

&

1@% ¥

Explorer

Suchen...

Eigenschaften

Gffnen - Alle Benutzer

w Explorer - Alle Benutzer
o o — -

f @

& Netzwerkverbindungen
| Drucker
[l Taskleiste und Startmenii

d

Klicken Sie hier, um in die Klassi-
sche Ansicht zu wechseln

Abb. 8 - Startmeni und Systemsteuerung

In diesem Benutzerhandbuch finden Sie wiederholt die Aufforderung, die Systemsteuerung zu 6ffnen. Zur Systemsteue-
rung gelangen Sie (ber das Start-Mend. In der Systemsteuerung kénnen Sie die Einstellungen fiir die meisten wichtigen
Windows-Funktionen (z.B. Strom, Video, Netzwerk, Audio) vornehmen. Windows Vista bietet fiir viele dieser Funktionen
Einstellfenster, wobei viele neue Fenster bereits hinzugefligt werden (oder die bestehenden verbessert werden), wenn Sie
die in Tabelle 5 auf Seite 67 aufgefiihrten Treiber installieren. Es kann sinnvoll sein, die klassische Ansicht des Startmends

einzustellen.

Windows Vista Startmeni und Systemsteuerung - 61
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Grafikfunktionen

Dieses Notebook verfiigt je nach Modell Giber zwei verschiedene Videooptionen (Intel bei Modellen A & B und NVIDIA
bei Modellen C & D). Wenn der Grafiktreiber installiert ist, konnen Sie bei Windows Vista im Einstellfenster Anzeige-
einstellungen oder im Fenster Intel GMA Driver for Mobile/NVIDIA Systemsteuerung die Anzeigegerate wechseln
und Anzeigeoptionen konfigurieren.

So 6ffnen Sie in Windows Vista das Dialogfeld Anzeigeeinstellungen:

1. Klicken Sie Start (Menii) und klicken Sie Systemsteuerung (oder zeigen auf Einstellungen und klicken Systemsteuerung).

2. Klicken Sie im Menii Darstellung und Anpassung auf Bildschirmauflésung anpassen (oder doppelklicken Sie auf Anpassung >
Anzeige).

3. Verschieben Sie den Regler auf die gewiinschte Einstellung fur die Auflésung 0 (siehe Abb. 9 auf Seite 63).

4. Klicken Sie auf den Pfeil, und wéahlen Sie die gewiinschte Einstellung fur die Farbtiefe 9 (siehe Abb. 9 auf Seite 63).

5. Klicken Sie auf Erweiterte Einstellungen (Schaltflache) 9 (siehe Abb. 9 auf Seite 63) um das Einstellfenster Erweiterte
Eigenschaften aufzurufen

So rufen Sie das Fenster Intel GMA Driver for Mobile auf (Modelle A & B):

1. Das Intel GMA-Einstellfenster kann aufgerufen werden, indem Sie in der Taskleiste auf das Symbol klicken und dann aus dem
Menu die Option Grafikeigenschaften wéahlen (sie kénnen dorthin auch lber Intel GMA Driver for Mobile (Symbol) in der Win-
dows-Systemsteuerung gelangen).

So 6ffnen Sie die NVIDIA Systemsteuerung (Modelle C & D):

1. Die NVIDIA Systemsteuerung kann aufgerufen werden, indem Sie mit der rechten Maustaste auf den Desktop klicken und dort
NVIDIA Systemsteuerung wahlen (sie konnen dorthin auch Gber die NVIDIA Systemsteuerung (NVIDIA Control Panel) in der
Windows-Systemsteuerung gelangen).

. |
62 - Grafikfunktionen
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[——

e —
Grafikeigenschaften...

%) SRR
Taskleiste beenden

semcnichin Ancrrun
Intel* Graphics Media
" -

Accelerator Driver
for mobile

Ansicht i

Sortieren nach i

B' Aktualisieren
Einfiigen
Verknagfung sinfiger
"

Abb. 9 - Anzeigeeinstellungen & Fenster Intel GMA Driver for Mobile/NVIDIA Systemsteuerung

Anschlie3en anderer Anzeigegeréate

Neben dem LCD-Bildschirm des Notebooks kénnen Sie als Anzeigegerat auch einen externen Monitor/Flachbildschirm/
TV-Bildschirm (TV nur tiber den HDMI-Ausgangsanschluss) verwenden, der an die Schnittstelle fiir externen Monitor
oder an den HDMI-Ausgangsanschluss (High-Definition Multimedia Interface) angeschlossen ist.

Grafikfunktionen - 63
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Audiofunktionen

Die Audioeinstellungen koénnen Sie bei Windows durch
Anklicken des Soundsymbols ©» oder des Realtek HD
Audio Manager -Symbols g/ @ in der Taskleiste/Sy-
stemsteuerung aufrufen (wenn Sie mit der rechten Mausta-
ste auf das Taskleistensymbol ﬁ klikken, wird das
Audioment aufgerufen). Die Lautstarke kénnen Sie durch
Driicken der Tastenkombination Fn + F5/F6 andern.

él] Sound-Manager
4

sz Audiogerate

Lautstarkeeinstellung

Systemklangereignisse

Die Lautstarke wird mit den
Windows Media Player #i Windows-Lautstarkereglern
| (oder den Lautstarkereglern

O

H 1eeninicing am Notebook) eingestellt.
L Uberpriifen Sie die Einstel-
- lung, indem Sie in der Tasklei-
ste auf das Lautstarke-
Klicken Sie mit der Symbol Klicken.

rechten Maustaste auf
das Symbol Ell, um
das obige Menl auf-
zurufen.

HDMI -Audiokonfiguration

Da HDMI (High-Definition Multimedia Interface) sowohl
Audio- als auch Videosignale Ubermittelt, missen Sie die
Audioausgabe entsprechend der folgenden Anweisung kon-
figurieren.

Audio-Setup fur HDMI bei Windows

1. SchlieBen Sie ein Gerat mit HDMI-Unterstutzung an den
HDMI-Ausgangsanschluss an.

2. Klicken Sie Start (Men) und klicken Sie Systemsteuerung
(oder zeigen auf Einstellungen und klikken
Systemsteuerung).

Klicken Sie auf Sound “** (Hardware und Sound).

4. Klicken Sie auf Wiedergabe (Registerkarte), und klicken Sie
auf HDMI-Gerat (Modellen A & B)/NVIDIA HDMI Output
(Modellen C & D).

5. Klicken Sie Als Standard (Schaltflache).
6. Klicken Sie auf OK, um das Fenster Sound “** zu Schliel3en.

7. Jetzt kdnnen Sie die Audioquelle héren, wenn die Dateien mit
Windows Media Player abgespielt werden.

w
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Hinweise zu HDMI

= Klicken Sie auf das  « SchlieBen Sie ein Gerdt mit HDMI-Unterstutzung an den
- Lautstarkesymbol £f HDMI-Ausgangsanschluss an, BEVOR Sie die Audio-/
n wengeLDﬁsll-(gésrtgt' Videoquelle mit dem Gerat abspielen.
markiert ist. Das ° Vvenn Sie das HDMI-Kabel abtrennen, kehrt die Wieder-
Symbol Uber dem gabe erst dann zum Audio-Standardwiedergabegerat
- Lautstérkesymbol zuriick, wenn der Computer neu gestartet wurde (wenn der O
0 hat sich geandert. Computer nicht neu gestartet werden soll, wahlen Sie in der g
O | e Systemsteuerung das Sounds und dann Lautsprecher als W
e Standardwiedergabegerat fiir Audiodateien). o
>

Klicken Sie auf das
Lautstarkesymbol [l
in der Taskleiste,
wenn NVIDIA
HDMI Output mar-
kiert ist. Das Symbol
Uber dem Lautstar-
kesymbol hat sich
geéndert.

Abb. 10 - HDMI-Gerét/ NVIDIA HDMI Output
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Energieverwaltungsfunktionen

Die Energieoptionen von Windows (siehe Seite 61) ermdglichen Ihnen die Konfiguration der Optionen fiir das Energiema-
nagement des Computers. Sie kdnnen Strom sparen, indem Sie Energiesparplane erstellen, die Netzschalter-, Energie-
spartasten- und Zuklappeinstellung (beim Schlieen des Dekkels) konfigurieren und im linken Menii den Anzeige- und
Energiesparmodus festlegen. Beachten Sie, dass sich die Energiesparpléne (Energiesparmodus) auf die Computerlei-
stung auswirken.

Wahlen Sie einen bestehenden Plan aus, oder klicken Sie im linken Menii auf Energiesparplan erstellen, und wéhlen Sie

die Optionen, um einen neuen Plan zu erstellen. Klicken Sie auf Energieplaneinstellungen andern, und klicken Sie auf
Erweiterte Energieeinstellungen andern, um weitere Optionen fir die Konfiguration aufzurufen.

@+ Sytemsteuerung b Energueopticnen [y | muchar » K3\ ) 7@ = toegesptionen + Sysiemencieiungen ~ 47 | sucten 2

nschalten

#dhlen Sie einen HIUngDMp an aus Verhalten des Netzschalters definieren und Kennworischutz ¢
Mt insbeungen fr den Computer s Die Anderengen dor DniteBungen, de See aul
Adtesieren Sie emen Plan, -\!!l'\s-( m m.nle phieis

rgiesinateliongen bndem.

o, i breen eige angessis Energiesparpline
Scheden des Liptopdeckeh,
geachehen 2ci

Alsuaustant: 999
Lentung: oe:

Enegieypatplan ertrien
8 Testpunict ton das fumashalten Ak .m.-m foataad
" Nagichima suvedhlen

L L

Kennwertengebe bel Reaktvierang

Der Computes ot geipera, Wenn der Computer sus dem Energoesparmedus nesbirvier mnd, ki
ki R g i o i e e Renncr Bngegeben wise

Dar Compuber st ich gepat, Wann dar Computer sus dem Energiespsmodis rabtiviert mind
Rann jocker sl e Diten sugraden.

Hinweis: Bei Windows Vista ist die Standardeinstellung Energie sparen

Abb. 11 - Energieoptionen

.|
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Installation der Treiber

Die Disc "Device Drivers & Utilities + User's Manual” ent-
hélt die Treiber und Hilfsprogramme, die fiir das einwand-
freie Funktionieren des Notebooks notwendig sind. Legen
Sie die mitgelieferte Disc und Klicken Sie auf Install
Drivers (Schaltfliche), oder klicken Sie auf Option
Drivers (Schaltflache), um das optionale Treibermeni auf-
zurufen.

Installieren Sie die Treiber in der in Tabelle 5 angegebenen
Reihenfolge. Nachdem ein Treiber installiert wurde, wird er
grau dargestellt (wenn einer dieser Treiber ein weiteres Mal
installiert werden soll, klicken Sie auf die Schaltflache Un-
lock).

Manuelle Treiber-Installation

Klicken Sie in der Anwendung Drivers Installer auf die
Schaltflache Browse CD (CD durchsuchen) und navigieren
Sie zu der ausfiihrbaren Datei in dem Ordner fiir Ihren Trei-
ber.

Windows Update

Nachdem Sie alle Treiber installiert haben, sollten Sie die
Funktion Windows Update aktualisieren, um immer die
neuesten Sicherheits-Updates usw. zu erhalten (die Updates
enthalten die neuesten Fehlerbehebungen von Microsoft).

Ausfihrliches Benutzerhandbuch

Treiber (Windows Vista mit SP1) Seite#

Chipset Seite 68

Video Seite 68

Audio Seite 68

Modem Seite 68 )
D

Network (LAN) Seite 68 S_
wn

TouchPad Seite 69 e
o

Kartenleser Seite 68

Hot-Key Seite 69

eSATA-Unterstltzung Seite 78

PC-Kamera (Option) Seite 69

3.5G-Modul (Option) Seite 74

Wireless-LAN-Modul (Option) Seite 77

Intel Turbo Memory-Modul (Option) Seite 78

Fingerabdruckleser (Option) Seite 79

Bluetooth-Modul (Option)

Hinweis: Ein Treiber muss nicht installiert werden (siehe Seite 81)

Windows Update aktivieren (siehe links)

Tabelle 5 - Installationsvorgang

Installation der Treiber - 67
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Neue Hardware Gefunden

Wenn wahrend des Installationsvorgangs der Assistent
Neue Hardware gefunden erscheint, klicken Sie auf Ab-
brechen, um den Assistenten zu schlielen. Befolgen Sie
dann die Installationsanweisungen.

Chipset

1. Klicken Sie auf 1.Install Chipset Driver > Ja.

2. Klicken Sie auf Weiter > Ja > Weiter > Weiter.

3. Klicken Sie auf Fertig stellen, um das Notebook neu zu
starten.

Video

1. Klicken Sie auf 2.Install Video Driver > Ja.

Modelle A & B (Intel):

2. Klicken Sie auf Weiter > Ja > Weiter > Weiter.

3. Klicken Sie auf Fertig stellen, um das Notebook neu zu
starten.

Modelle C & D (NVIDIA):
4. Klicken Sie auf Weiter.

5. Klicken Sie auf Fertig stellen, um das Notebook neu zu
starten.

Audio

1. Klicken Sie auf 3.Install Audio Driver > Ja.

2. Klicken Sie auf Weiter.

3. Kilicken Sie auf Fertig stellen, um das Notebook neu zu
starten.

Modem

1. Klicken Sie auf 4.Install Modem Driver > Ja.
2. Klicken Sie auf OK.

3. Thr Modem ist nun bereit zur Konfiguration.

LAN

Klicken Sie auf 5.Install LAN Driver > Ja.
Klicken Sie auf Weiter > Installieren.

Klicken Sie auf Fertig stellen.

Nun kénnen die Netzwerkeinstellungen konfiguriert
werden.

TouchPad
1. Klicken Sie auf 6.Install Touchpad Driver > Ja.
2. Klicken Sie auf Weiter.

3. Klicken Sie auf Fertig stellen > Jetzt neu starten, um das
Notebook neu zu starten.

N
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Kartenleser

1. Klicken Sie auf 7.Install Cardreader Driver > Ja.
2. Klicken Sie auf Weiter > Installieren.

3. Kilicken Sie auf Fertig stellen.

Hot-Key

1. Klicken Sie auf 8.Install Hotkey Utility > Ja.

2. Kilicken Sie auf Next > Install.

3. Klicken Sie auf Finish > Finish, um das Notebook neu zu
starten.

o
[0
c
=
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9
>

eSATA-Unterstltzung

Eine Anleitung zum Installieren dieses Treibers, um den
eSATA Anschluss zu aktivieren, finden Sie auf “Einrich-
ten des Intel Turbo Memory- und Matrix Storage-Speich-
ers und Installieren des Treibers” auf Seite 78.

Installation der Treiber - 69
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PC-Kamera

Das PC-Kamera-Modul verwendet fiir die Aufnahme von
Videodateien die Anwendung BisonCap.

AN
&
Neueste Informationen zum PC-Kameratreiber

Auf der Disc Device Drivers & Utilities + User's Manual und auf

allen beigefuigten Zusatzseiten finden Sie die neuesten aktua-
lisierten Informationen zum PC-Kameratreiber. Diese Informa-
tionen werden sind vom Inhalt aktueller als die hier
angegebenen Informationen.

Installieren des PC-Kamera-Treibers

1. Schalten Sie das Modul mit der Tastenkombination Fn +
F10 ein (wenn das Modul eingeschaltet wird, erscheint
kurz die Anzeige . @),

Klicken Sie auf Option Drivers (Schaltflache).

Klicken Sie auf 1.Install WebCam Driver > Ja.

Wéhlen Sie eine Sprache und klicken auf Weiter.

Klicken Sie auf Weiter > Fertig stellen, um das

Computer neu zu starten.

6. Die BisonCap-Software wird Uiber die Verkniipfung auf
dem Desktop oder tber den Eintrag BisonCam im Menii
Start > Programme/Alle Programme gestartet (wenn
die Hardware ausgeschaltet wurde, kénnen Sie sie mit der
Tastenkombination Fn + F10 wieder einschalten).

a bk wn

Audio-Setup fir die PC-Kamera

Wenn Sie mit der Kamera Video- und Audio-Daten aufneh-
men mdéchten, missen Sie bei Windows die Optionen fir die
Audio-Aufnahme einstellen.

10.

Klicken Sie Start (Meni) und klicken Sie Systemsteuerung
(oder zeigen auf Einstellungen und klicken Systemsteue-
rung).

Klicken Sie auf Sound “** (Hardware und Sound).

Klicken Sie auf Aufnahme (Registerkarte).

Klicken Sie mit der rechten Maustaste auf Mikrofon (Realtek
High Definition Audio) und stellen Sie sicher, dass die
Funktion nicht deaktiviert ist.

Klicken sie doppelt auf Mikrofon (oder wahlen Sie aus dem
Rechtsklick-Menu die Option Eigenschaften).

Klicken Sie auf Pegel (Registerkarte), und regeln Sie die
Einstellungen von Mikrofon and Mikrofonverstarkung.
Klicken Sie auf OK und schlieBen Sie alle Fenster.

Starten Sie das Programm BisonCap aus dem Men( Start >
Programme/Alle Programme > BisonCam.

Rufen Sie das Meni Gerate auf, und wahlen Sie Mikrofon
(Realtek....) (es sollte mit einem Hakchen gekennzeichnet
sein).

Rufen Sie das Menl Aufnahme auf, und wahlen Sie Audio
aufnehmen (es sollte mit einem Hékchen gekennzeichnet
sein).
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BisonCap

Die Anwendung BisonCap ist ein Videowiedergabegerat
fur die allgemeine Videowiedergabe und -priifung. Die Vi-
deodateien werden im Format .avi aufgenommen.

1. Starten Sie das Programm BisonCap aus dem Men( Start >
Programme/Alle Programme > BisonCam (es wird empfoh-
len, vor der Aufnahme die Aufnahmedatei einzustellen -
siehe "Einstellen der Aufnahmedatei" weiter unten).

2. Gehen Sie zum Meni Aufnahme (wenn Sie Ton aufnehmen
mdchten, siehe “Audio-Setup fiur die PC-Kamera” auf
Seite 70) und wéhlen Sie dann Aufnahme starten.

3. Klicken Sie auf OK (der Speicherort der Datei wird im Pop-up-
Fenster angezeigt), um die Aufzeichnung zu starten, und auf
Esc, um sie zu stoppen (Die Datei kdnnen Sie sich dann mit
Windows Media Player ansehen).

Einstellen der Aufnahmedatei

Vor dem Aufnehmen von Videodateien kénnen Sie im Meni
Datei die Option Aufnahmedatei einst. wahlen und den Da-
teinamen und den Speicherort fur die aufgenommene Datei
festlegen (dadurch kénnen Sie vermeiden, dass andere Dateien
versehentlich tberschrieben werden). Wahlen Sie den Namen
und den Speicherort, und klicken Sie auf Offnen. Legen Sie
dann bei "Capture file size:" die GroRe der Aufnahmedatei
fest, und klicken Sie auf OK. Nun kénnen Sie den Aufnahme-
vorgang wie oben beschrieben starten.

Ausfihrliches Benutzerhandbuch

Zoom
Mit dem Programm BisonCap konnen Sie das Kamerabild
verkleinern und vergréRern.

1. Starten Sie das Programm BisonCap.

2. Gehen Sie zum Meni Zoom und wahlen Sie dann
VergroRern/Verkleinern.

Fotografieren
Mit dem Programm BisonCap koénnen Sie auch fotografie-
ren.

1. Starten Sie das Programm BisonCap.
2. Gehen Sie zum Menu Optionen und wéhlen Sie dann
Fotografieren.

3. Das Bild (im Format JPEG) wird im Desktopordner Snapshot
& gespeichert (der Ordner darf nicht verschoben oder
umbenannt werden).

PC-Kamera - 71
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Bildschirmflimmern beseitigen

Wenn das Videobild bei der Wiedergabe mit dem Pro-
gramm BisonCap flimmern sollte, kénnen Sie bei den Op-
tionen des Video Aufnahme Filters die Einstellung
vornehmen.

1. Starten Sie das Programm BisonCap.

2. Gehen Sie zu Optionen und wahlen Sie "Video Aufnahme
Filter....

3. Wabhlen Sie aus dem Feld Frequenz in der Registerkarte
Eigenschaftenseite entweder 50Hz oder 60Hz.

Reduzieren der Videodateigroi3e

Beachten Sie, dass die Dateien beim Aufnehmen von Vide-
odateien mit groRer Auflésung sehr viel Speicherplatz in
Anspruch nehmen. Prifen Sie nach dem Aufnehmen des
Videos die DateigroRe (klicken Sie mit der rechten Mausta-
ste auf die Datei, und wahlen Sie Eigenschaften) und den
freien Speicherplatz auf der Festplatte (klicken Sie auf
Computer, danach mit der rechten Maustaste auf die Fest-
platte, und wahlen Sie dann Eigenschaften). Wenn nétig,
kénnen Sie die aufgenommene Videodatei auf einem aus-
tauschbaren Datentrager speichern, z. B. CD, DVD oder
USB-Speicher.

Beachten Sie, dass das Betriebssystem Windows Vista min-

destens 15GB freien Speicher auf der Systempartition
Laufwerk C: bendtigt. Um Probleme mit dem Betriebssy-
stem zu vermeiden, sollten Sie die Videodateien nicht auf
Laufwerk C: speichern (siehe “Einstellen der Aufnahme-
datei”” auf Seite 71), die DateigroRe beschranken oder die
Auflésung der Videoaufnahmen verringern.

So verringern Sie die GroRRe der Videoauflésung:

1. Starten Sie das Programm BisonCap.

2. Gehen Sie zu Optionen, und wéhlen Sie dort Video
Aufnahme konfigurieren....

3. Klicken Sie das Feld AusgabegroRe an, und wéhlen Sie
eine niedrigere Auflésung, um die GroRe der
Aufnahmedateien zu verringern.
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3.5G-Modul

Wenn Ihr Modell das optionale 3.5G-Modul enthalt, fol-
gen Sie den nachfolgenden Anweisungen, um die USIM-
Karte zu installieren (Sie erhalten sie von Ihrem Dienstan-
bieter). Installieren Sie dann die Anwendung.

2NZ
2 &

Warnung zur Stromsicherheit

Bevor Sie Schritte zum Aufriisten des Computers unterneh-
men, missen Sie zunachst das Gerat ausschalten und alle Pe-
ripheriegerate und Kabel (einschlieBlich Telefonkabel)
abtrennen. Sie sollten auch den Akku herausnehmen, damit
das Gerat nicht versehentlich eingeschaltet werden kann.

1. Schalten Sie das Notebook aus, drehen Sie es herum, und
nehmen Sie den Akku heraus.

2. Losen Sie die Schrauben der Abdeckung des SIM-
Kartenfachs @ in Abb. 12.

3. Nehmen Sie die Abdeckung des SIM-Kartenfachs ab 9 in
Abb. 12.

4. Setzen Sie die USIM-Karte wie bei lhrem Mobiltelefon ein.

5. Schieben Sie den SIMLOCK-Riegel in Richtung Scharnier (in
die entgegengesetzte Richtung des in Abb. 13 dargestellten
Pfeils), um den Riegel zu 6ffnen, und klappen Sie ihn hoch.

Ausfuhrliches Benutzerhandbuch

Abb. 12 - Abnehmen der SIM-Kartenfachabdeckung

6. Setzen Sie die USIM-Karte wie abgebildet ein (Abb. 13), und

schlie3en Sie den SIMLOCK.

7. Verriegeln Sie den SIMLOCK, indem Sie ihn bis zum

Einrasten in Pfeilrichtung schieben (Abb. 13).

8. Setzen Sie die Abdeckung wieder auf, die Schraube und den
Akku ein.

Abb. 13 - Einsetzen der USIM-Karte und SchlieRen
des SIMLOCK-Riegels

3.5G-Modul - 73
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Programm 3G Watcher Einrichten eines Profils

Wenn das 3.5G-Modul und die USIM-Karte (lhres Auch wenn die Verbindungsinformationen auf der vom
Dienstanbieters) installiert sind, konnen Sie das Programm ~ Dienstanbieter zur Verfligung gestellten USIM-Karte ge-
3G Watcher verwenden. Mit 3G Watcher kénnen Sie mit ~ speichert sind, missen Sie im Programm 3G Watcher das
dem Notebook direkt auf den -Internetdienst zugreifen. richtige Profil einrichten.

Installieren von 3G Watcher 1. Benutzen Sie die Tastenkombination Fn + i., um das 3.5G-
1. Schalten Sie das Modul an, indem Sie auf die Tasten Fn + Modul zu aktivieren.

;. driicken (die Anzeige ‘9 zeigt den Stromstatus des 2. Sie kénnen das Programm 3G Watcher iber das Sta_rt-Menu
. aufrufen (Start > Programme/ AlleProgramme > Sierra

Moduls an). . ] Wireless > 3G Watcher) oder durch Anklicken des Symbols
2. Wenn der Assistent "Neue Hardware gefunden™ erscheint, B in der Taskleiste.

k“_Cken Sl_e Abbrechen' . B 3. Klicken Sie auf Extras und wahlen Sie Optionen.

KI!Cken S!e auf Option Drivers _(Schaltflache). 4. Klicken Sie auf Profile und dann auf die Schaltflache Neues

Klicken Sie auf 2.Install 3G Driver > Ja. Profil hinzufiigen &g. Wahlen Sie WWAN-Profil.

Klicken Sie auf Weiter.

Klicken Sie auf die Schaltflache Ich akzeptiere die

Bedingungen der Lizenzvereinbarung, und dann auf

Installieren.

7. Wenn das nachste Fenster angezeigt wird, missen Sie
ca. 2 Minuten warten, bevor Sie auf Fertigstellen
klicken (damit die Hardware das 3.5G-Modul erkennen
kann).

8. Auf dem Desktop erscheint das 3G Watcher -Symbol ﬁ O

o 0k w

9. Sie kdnnen das Programm 3G Watcher (ber das Start-
Menu aufrufen (Start > Programme/ AlleProgramme >
Sierra Wireless > 3G Watcher) oder durch Anklicken Abb. 14 - WWAN-Profil hinzufigen
des Symbols ﬁ in der Taskleiste.
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5. Sie kénnen dann einen neuen Profilnamen eingeben oder ein

Profil aus der Drop-down-Liste auswahlen, die von der
Software angeboten wird.

6. Klicken Sie auf Ubern. > OK, um die Informationen zu
speichern.

7. Sie kénnen das Profil aus dem Pull-down-Menu auswahlen.

T 3G Watcher
Ansicht  Extras Hilfe:

SIERAA WRELESE

Informationen zum Profil

Wenn sie ein Profil aus der Drop-down-Liste ausgewahlt ha-
ben, werden die meisten Daten in den Registerkarten Allge-
mein und Erweitert automatisch in die Felder eingetragen
(lassen Sie sich von lhrem Dienstanbieter jedoch die neue-
sten Daten geben, da Sie auf jeden Fall lhren Benutzerna-
men und das Kennwort eingeben missen).

Abb. 15 - Benutzeroptionen und Profile

Ausfuhrliches Benutzerhandbuch

Herstellen einer Verbindung zum Dienstan-

bieter

1. Benutzen Sie die Tastenkombination Fn + ., um das 3.5G-
Modul zu aktivieren.

2. Sie kénnen das Programm 3G Watcher lber das Start-Menii
aufrufen (Start > Programme/ AlleProgramme > Sierra
WLreIess > 3G Watcher) oder durch Anklicken des Symbols

in der Taskleiste.

3. Die Software wird gestartet und zeigt dann den namen des
Dienstanbieters an (die Verbindungsdaten sind auf der USIM-
Karte gespeichert).

Abb. 16
3G Watcher

4. Klicken Sie auf Verbinden um die Verbindung herzustellen.

5. Das Programm 3G Watcher zeigt im Fenster dann die
Verbindungsinformationen an.

6. Wenn die Verbindung erfolgreich hergestellt wurde, erscheint

eine entsprechende Benachrichtigung (siehe unten).

“Lp 3G watcher |

Abb. 17
Verbindungshbe-
nachrichtigung in
der Taskleiste

= |
©, Verbunden mit Far
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10.
11.

12.

13.

14,

Sie kénnen dann wie bei jeder Internetverbindung auf das
Internet zugreifen, E-Mails herunterladen usw.

Solange die Verbindung besteht, ist das Taskleistensymbol
grun & (wenn das Programm l|auft, aber nicht verbunden ist,
leuchtet es rot ‘).

Um die Verbindung zu trennen, klicken Sie auf das Trennen-
Symbol.

Das Programm trennt die Verbindung zum Dienstanbieter.
Das Modul ist dann immer noch aktiviert. Um es zu

deaktivieren, driicken Sie auf die Tastenkombination Fn+ &+ .

Wenn Sie auf das SchlieRen-Symbol [ von 3G Watcher
klicken, erscheint ein Fenster, in dem Sie auf OK klicken
mussen, um das Programm zu beenden.

Warnung =]

Abb. 18
Hinweis zum Beenden

Durch das Beenden des Programms wird das Modul NICHT
ausgeschaltet. Um es auszuschalten, miissen Sie auf die
Tastenkombination Fn + . driicken (denken Sie daran,
wenn Sie im Flugzeug unterwegs sind - siehe “Betrieb von
Wireless-Geraten in Flugzeugen” auf Seite 46).

Wenn das Modul aktiviert ist, und der Computer in einen
Stromsparmodus wechselt, wird der Stromstatus des Moduls

beim erneuten Einschalten des Computers wie umseitig

angezeigt:

« Wenn das 3.5G-Modul aktiviert ist und der Computer aus-
geschaltet oder neu gestartet wird, ist das Modul beim
Wiedereinschalten des Computers aus.

« Wenn das 3.5G-Modul aktiviert ist und der Computer in
den Energiesparmodus oder Ruhezustand wechselt, ist
das Modul beim Wiedereinschalten des Computers aus.

SMS-Dienst
Neben der Nutzung der Standard-Internetdienste kénnen
Sie mit 3G Watcher auch SMS-Nachrichten senden und

empfangen.

1. Wenn eine neue SMS-Nachricht eingegangen ist, erscheint
im Hauptfenster das SMS-Symbol [

2. Klicken Sie doppelt auf das Symbol H oder wéahlen Sie
Extras > SMS Express....

3. Rufen Sie den Posteingangsordner auf, und wahlen Sie die

Nachricht aus, die Sie lesen moéchten, oder klicken Sie auf
Datei > Neue E-Mail, oder klicken Sie auf die Schaltflache
Neu, um eine neue SMS-Nachricht zu schreiben.

Ausfiihrliche Informationen zu SMS-Nachrichten finden
Sie in der 3GWatcher Online-Hilfe, die Sie bei Hilfe >
Hilfethemen finden.
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Wireless LAN
4

Ein- und Ausschalten des Wireless-LAN-Moduls

Das Wireless-LAN-Modul wird durch Dricken der Tastenkom-
bination (Fn + F11) eingeschaltet. Wenn das Wireless-LAN-
Modul eingeschaltet ist, leuchtet die LED (ig) griin und er-
scheint kurz die Anzeige | @ .

Installieren des Wireless-LAN-Treibers

Schalten Sie das Modul ein.

Klicken Sie auf Option Drivers (Schaltflache).

Klicken Sie auf 3. Install Wireless Lan Driver > Ja.
Wabhlen Sie eine Sprache und klicken auf Weiter.

Klicken Sie auf Weiter > Weiter.

Klicken Sie auf die Schaltflache Ich akzeptiere die Bedin-
gungen der Lizenzvereinbarung, und dann auf Weiter.
7. Klicken Sie auf Weiter > Weiter > Fertig stellen.

ok wpnE

Hinweis: Das Betriebssystem ist die Standardeinstellung fiir
die Steuerung des Wireless LAN bei Windows Vista.

Ausfihrliches Benutzerhandbuch

AnschlielRen an ein Drahtlosnetzwerk
Stellen Sie sicher, dass das Wireless-LAN-Modul aktiviert ist.

1. Klicken Sie auf das Wireless-Symbol [= in der Taskleiste,
und Kklicken Sie dann auf Verbindung mit einem Netz-
werk herstellen (oder klicken Sie mit der rechten Mausta-
ste auf das Symbol &, und klicken Sie dann auf
Verbindung mit einem Netzwerk herstellen).

2. Klicken Sie in der Liste Anzeigen aus dem Dropdown-
Men( die Option Drahtlosnetzwerke.

3. Eine Liste der verfiigbaren Netzwerke wird angezeigt.

4. Klicken Sie auf ein Netzwerk und dann auf Verbinden.

5. Wenn das gewinschte Netzwerk nicht angezeigt wird,
klicken Sie auf Eine Verbindung oder ein Netzwerk
einrichten.

6. Schieben Sie den Cursor iiber das Taskleistensymbol =,
um den Verbindungsstatus aufzurufen.

7. Wenn Sie die Verbindung zum Wireless-Netzwerk trennen
mochten, klicken Sie in der Taskleiste auf das Wireless-
Symbol &, und wahlen Sie dann die Option Verbindung
herstellen oder Trennen, um das Netzwerkmeni
aufzurufen. Klicken Sie dann auf Trennen (oder klicken
Sie mit der rechten Maustaste auf das Symbol E, und
klicken Sie dann auf Verbindung trennen von).

Wireless LAN - 77
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Intel Turbo Memory-Modul
e

Unterstltzung des eSATA Anschlusses

Beachten Sie, dass der Intel Matrix Storage-Treiber erforder-
lich ist, um den eSATA Anschluss zu aktivieren, auch wenn
das von lhnen erworbene Modell kein Intel Turbo Memory-Mo-
dul enthalt.

Folgen Sie fiir die Installation des Treibers den folgenden An-
weisungen.

Wenn in Ihrem Modell ein Intel Turbo Memory-Modul
(Robson) enthalten ist, missen Sie den Treiber entspre-
chend der folgenden Anleitung installieren (bei Windows
XP darf dieser Treiber nicht installiert werden).

Die Intel Turbo Memory-Technologie (auch bekannt als
Robson-Flash-Speicher) ist eine Intel-Technologie, mit
der die Zeit zum Hochfahren des Computers, Laden von
Programmen und Schreiben von Daten auf die Festplatte
verkirzt wird. Die Intel Turbo Memory-Technologie wird
nur von Windows Vista unterstutzt (es unterstutzt auch
Windows Vista-Funktionen wie ReadyBoost, ReadyDrive
und Superfetch).

Einrichten des Intel Turbo Memory-
und Matrix Storage-Speichers und In-

stallieren des Treibers

1. Starten Sie das Notebook und driicken Sie auf die Taste
F2, um in das BIOS zu gelangen.

2. Gehen Sie zum Meni Advanced, wéhlen Sie "Installed O/
S" und stellen Sie sicher, dass die Option "Vista" markiert ist.

3. Stellen Sie bei "SATA Mode Selection" sicher, dass die
Option "AHCI" markiert ist.

4. Waéhlen Sie Exit Saving Changes aus dem Menii Exit
(oder driicken Sie auf F10 und wéhlen Sie "Yes" und dann
dricken Sie auf Enter) und driicken Sie auf Enter um das
BIOS zu verlassen und den Computer neu zu starten.

5. Legen Sie die Disc Device Drivers & Utilities + User's

Manual in das CD/DVD-Laufwerk ein.

Klicken Sie auf Option Drivers (Schaltflache).

Klicken Sie auf 4.Install TM&iMSM Driver > Ja.
Klicken Sie auf Next > Yes > Next > Next.

Klicken Sie auf Finish, um das Notebook neu zu starten.

e m==== o \Nindows ReadyBoost - ver-

=] - = wendet Flashspeicher zum

= Cachen der Festplatte.
» Windows ReadyDrive - ver-
wendet Hybridlaufwerke zum
Cachen der Festplatte.

©oNOo

Abb. 19 - Intel Turbo Memory Console
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Fingerabdruckleser

Wenn das von lhnen erworbene Gerét Uber einen Fingerab-
druckleser verfligt missen Sie den Treiber entsprechend der

4

Hilfe & Handbuch

folgenden Anweisung installieren. Klicken Sie mit der rechten Maustaste auf das Taskleistensym-

bol ¥ und wahlen Sie aus dem Meni die Option Help (Hilfe).

Fir einen vollen Schutz mussen Sie fir den Computer Ad- Legen Sie die mitgelieferte Disc Device Drivers & Utilities +
ministratorrechte und ein Windows-Kennwort aktiviert ha- User's Manual ein und klicken Sie auf Option Drivers (Schalt- O
ben flache). Klicken Sie auf Unlock (Schaltflache) und dann Klik- g
' ken Sie auf 5.Install FingerPrint Driver > Ja. (7;-
Bevor Sie mit der Registrierung beginnen, sollten Sie das Klicken Sie auf Documentation um den Ordner zu 6ffnen, in o
Lernprogramm zum Fingerabdruckleser durchgehen. Um dem Sich das Benutzerhandbuch im .pdf-Format befindet. >

das Lernprogramm zu starten, klicken Sie auf Start > Pro- Um die Adobe Acrobat Reader-Software zu installieren, die Sie

gramme/ Alle Programme > Protector Suite QL > Fin- benétigen, um die Datei lesen zu kénnen, legen Sie die Disc

Device Drivers & Utilities + User’'s Manual in das CD-Laufwerk
ein, und Klicken sie auf User’s Manual (Schaltflache) und
dann auf Install Acrobat Reader (Schaltflache).

gerprint Tutorial (Fingerabdruck-Lernprogramm).

Installieren des Fingerabdruckleser-

Treibers Benutzerre istrierun
1. Legen Sie die Disc Device Drivers & Utilities + User’s g g
Manual in das CD/DVD-Laufwerk. " feotor Suite QL > Benutzeegistrierung oder doppelic
g' i:!c:zen g!e au; ?Ft'onlﬁzr_'vers F()S_Cha:;ﬂ‘?mhe); 3 ken Sie in der Taskleiste auf das Symbol | £
) !C en !e auf 5.Insta . Inger '_‘mt rver a. 2. Wenn das Programm das erste Mal gestartet wird, werden Sie
4. KI!Cken S!e auf Soﬁware'mt_a”at'on- _ gefragt, ob Sie die Lizenzvereinbarung annehmen mochten.
5. Klicken Sie auf Weiter > Weiter > Weiter. Klicken Sie dann auf OK.
6. Klicken Sie auf Fertig stellen > Ja, um das Notebook neu 3. Kiicken Sie auf Weiter ("Registrierung auf der Festpllate"
zu starten. wird automatisch ausgewahlt) und klicken Sie auf Fertig
stellen.

.|
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4. Wenn Sie kein Windows-Kennwort eingerichtet haben,
werden Sie dazu aufgefordert (Hinweis: Wenn kein Kennwort
festgelegt wurde, kann Protector Suite QL nicht den Zugriff
auf den Computer sichern).

5. Wenn Sie auf Weiter klicken, werden Sie aufgefordert, Ihr
Windows-Kennwort einzugeben.

6. Klicken Sie auf Weiter > Weiter (Markieren Sie das
Kontrollfeld bei "Interaktives Lernprogramm ausfuhren”,
um das Fingerabdruck-Lernprogramm durchzugehen).

7. Klicken Sie bei jedem Fenster des Lernprogramms auf Weiter
(sie kdnnen jederzeit auch auf die Schaltflache
"Lernprogramm Uberspringen" klicken).

8. Klicken Sie auf eine der Tasten liber einem beliebigen Finger,
um mit der Registrierung dieses Fingers zu beginnen.

9. Tippen Sie dreimal mit dem Finger auf, um diesen Finger zu
registrieren.

10. Wiederholen Sie diesen Vorgang fiir alle Finger, die registriert
werden sollen, und dann klicken Sie auf Weiter.

11. Klicken Sie auf Fertig stellen.

12. Klicken Sie auf einen der Eintrage unter "Weitere
Informationen zu:", um weitere Informationen tber dieses
Thema zu erhalten.

13. Klicken Sie auf Schlie3en.

14. Starten Sie das Notebook neu.

15. Klicken Sie mit der rechten Maustaste auf das
Taskleistensymbol ﬁ| um das Menl mit den Optionen zu
starten, mit denen Sie Fingerabdricke bearbeiten, auf das
Control Center zugreifen, die Hilfe aufrufen kdnnen. Sie

kénnen das Control Center usw. auch tber den Eintrag
Protector Suite QL im Meni Start > Programme/Alle
Programme starten.

16. Eine ausfiihrliche Beschreibung finden Sie unter “Hilfe &
Handbuch” auf Seite 79.

17. Wenn Sie mit dem Finger auf den Fingerabdruckleser tippen,
kénnen Sie auf das Biomen zugreifen, um den Computer
zu sperren, Websites zu registrieren, das Control Center
zu 6ffnen und das Hilfe-MenU aufzurufen.

18. Im Control Center kénnen Sie die Einstellungen und

Fingerabdriicke bearbeiten, und hier erhalten Sie auch Hilfe
dazu.

T 3]
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Fingerabdruckregistrierung

Beachten Sie, dass es fir den Fall einer Verletzung o. &.
sinnvoll ist, mehr als einen Finger zu registrieren.

Abb. 20 - Control Center & Biomentl
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. . ) : 4
Richten Sie Ihr Bluetooth-Geréat so ein,
Bluetooth-
dass der Computer es erkennen kann Dateniibertragung

1. Schalten Sie Ihr Bluetooth-Gerat (z. B. PDA, Mobiltelefon) ein.

2. Schalten Sie das Gerat in den Erkennbar-Modus (eine
Beschreibung dazu finden Sie in der dazugehdrigen
Dokumentation).

Einschalten des Bluetooth-Moduls

1. Schalten Sie das Bluetooth-Modul mit der Tastenkombination
Fn + F12 ein.

2. In der Taskleiste erscheint das Bluetooth-Symbol £

Bluetooth-Gerdt hinzufigen

Bluetooth-Netzwerkgerdte anzeigen

Datei senden

Datei empfangen
Einem PAN beitreten

Bluetooth-Einstellungen offnen

Beachten Sie, dass die
Datenlibertragung ZWi-
schen dem Notebook und
einem Bluetooth-Gerat
nur in einer Richtung
maoglich ist (eine gleich-
zeitige Datenubertra-
gung in beide
Richtungen wird nicht
unterstitzt).

yoasinag

Bluetooth-Symbol entfernen

(moglicherweise miissen Sie die Option iber das Fenster
Bluetooth-Gerate aktivieren).

3. Fuhren Sie dann einen der folgenden Schritte aus, um das
Fenster Bluetooth-Geréte aufzurufen.

Abb. 21 - Fenster "Bluetooth-Geréate" und beim Ank-
licken des Symbols angezeigtes Meni

« Klicken Sie doppelt auf das Symbol g3, um das Fenster Hinzufligen eines Bluetooth-Gerats
BlyetOOth'Gerate anZl_J_rUfen- _ ) 1. Rufen Sie das Fenster Bluetooth-Geréte auf.

* Klicken Sie Start (Meni) und klicken Sie Systemsteue- 2. Klicken Sie auf Optionen (Registerkarte), und machen Sie ein
rung (oder zeigen ?Uf Eln_stellungen und klicken Sy§tem- Hakchen bei Bluetooth-Gerate kbnnen eine Verbindung
steuerung), und klicken Sie dan auf Bluetooth-Geréate mit diesem Computer herstellen (Verbindungen).

(Hardware und Sound). 3. Klicken Sie auf Gerate (Registerkarte) und klicken Sie dann
» Klicken/klicken Sie mit der rechten Maustaste auf das auf Hinzuftgen.
Symbol {3 und wahlen Sie eine Option aus dem Mendi. 4. Der Assistent zum Hinzufiigen von Bluetooth-Geréten
erscheint.

.|
Bluetooth-Konfiguration - 81



Ausfihrliches Benutzerhandbuch

5. Klicken Sie auf “Gerat ist eingerichtet und kann erkannt Andern der Einstellungen flir das Blue-
werden”, und klicken Sie dann auf Weiter. L
tooth-Gerat

[ | D s sm tersogen -on Bumsim-Gamen =

3

WSy B 3 | 1. Rufen Sie das Fenster Bluetooth-Gerate auf.
2. Kilicken Sie auf das Gerat, das Sie &ndern mochten, und dann
auf Eigenschaften, um:
¢ den Namen des Geréts zu &ndern (klicken Sie auf Allgemein,
geben Sie einen neuen Namen ein, und klicken Sie auf OK).

« einen Dienst zu aktivieren/deaktivieren (klicken Sie auf Dien-
""" e — ste, markieren Sie das Kontrollkéstchen neben im Feld Dienst
(oder entfernen die Markierung), und klicken Sie auf OK).

1= % & @

" EE X

Abb. 22 - Assistent zum Hinzufiigen von Bluetooth-

Gerdten Schalten des Computers in den Er-

6. Der Assistent sucht dann innerhalb der Reichweite nach kennbar—Modus fur BIuetooth-Geréte

verfugbaren Bluetooth-Geraten. ; )
7. Wahlen Sie das Gerat aus, mit dem Sie kommunizieren 1. Rufen Sie das Fenster Bluetooth-Geréte auf.

mochten, und klicken Sie auf Weiter. 2. Klicken Sie auf Optionen (Registerkarte), und machen Sie ein
8. Wahlen Sie einen geeigneten Hauptschlissel, und klicken Sie Hakt_:heln bei BI;:etooth-Gerate konnen diesen Computer

auf Weiter > Fertig stellen. ermitteln (Suche).

: 3. Machen Sie ein Hakchen bei Benachrichtigung anzeigen,
s é‘" wenn ein Bluetooth-Gerét eine Verbindung herstellen méchte
(Verbindungen), wenn Sie benachrichtigt werden méchten, wenn

ein Bluetooth-Gerét eine Verbindung herstellen méchte.
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Abb. 24
- Bluetooth-Gerate -
Optionen

Abb. 23 - Hauptschllissel-Option
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Problem

Mdgliche Ursache - Losung

Die Module Wireless-LAN/Bluetooth
kénnen nicht erkannt werden.

Das/Die Modul(e) ist/sind ausgeschaltet. Stellen Sie anhand der Anzeige-LED (i) fest, ob
das Modul an- oder ausgeschaltet ist. Wenn die Anzeige-LED nicht leuchtet, driicken Sie
die Tastenkombination Fn + F11 (WLAN) oder Fn + F12 (Bluetooth), um das/die Modul(e)
zu aktivieren (siehe Tabelle 4 auf Seite 57).

Das Bluetooth-Modul ist aus, wenn
das Gerat aus dem Energiesparmodus
zurtickkehrt.

Das Bluetooth-Modul ist standardmafig ausgeschaltet, wenn es aus dem
Energiesparmodus zurlickkehrt. Driicken Sie die Tastenkombination (Fn + F12), um das
Bluetooth-Modul nach der Rickkehr aus dem Energiesparmodus wieder einzuschalten.

Eine Datei kann nicht auf ein/von
einem angeschlossenen Bluetooth-
Geréat Ubertragen werden.

Die Datenubertragung zwischen dem Notebook und einem Bluetooth-Gerét nur in einer
Richtung moglich ist (eine gleichzeitige Datenlibertragung in beide Richtungen wird
nicht unterstitzt). Sie kénnen eine Datei vom Notebook auf ein aktiviertes Bluetooth-
Gerat nur dann kopieren, wenn nicht gleichzeitig Dateien vom Gerat zum Computer
Ubertragen werden. Dieser Vorgang muss zuerst abgeschlossen werden.

Die mit der PC-Kamera
aufgenommenen Dateien benétigen
zu viel Speicherplatz.

Videodateien, die mit hoher Auflésung aufgenommen werden, erfordern sehr viel
Speicherplatz. Siehe “Reduzieren der VideodateigroRe” auf Seite 72.

Es ist kein Ton zu héren, wenn ein
Anzeigegerat an den HDMI-
Andschluss angeschlossen ist.

Der HDMI-Audioausgang wurde nicht konfiguriert. Siehe “HDMI -Audiokonfiguration”
auf Seite 64.
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Technische Daten
4

Aktualitat der technischen Daten

Die in diesem Anhang aufgefuhrten technischen Daten sind zum Zeitpunkt der Druckstellung richtig. Bestimmte Elemente (ins-

e besondere Prozessortypen/-geschwindigkeiten) kénnen im Rahmen des Entwicklungsplans des Herstellers zwischenzeitlich ge-
8 andert oder aktualisiert werden. Detailinformationen erhalten Sie bei lhrem Servicezentrum.
o
=)
(]
(a) : :
Funktion Technische Daten
Prozessor Typen | Intel Core 2 Duo Prozessor (45nm) 45 Nanometer-Prozesstechnologie
Micro-FCPGA-Paket (478-pin), 35W 6 MB L2 Cache & 1066-MHz-Systembus (FSB)
T9400/ T9600 2,53/ 2,8 GHz
Intel Core 2 Duo Prozessor (45nm) 45 Nanometer-Prozesstechnologie
Micro-FCPGA-Paket (478-pin), 25W 6 MB L2 Cache & 1066-MHz-Systembus (FSB)
P9500 2,53 GHz
Intel Core 2 Duo Prozessor (45nm) 45 Nanometer-Prozesstechnologie
Micro-FCPGA-Paket (478-pin), 25W 3 MB L2 Cache & 1066-MHz-Systembus (FSB)
P8400/ P8600 2,26/ 2,4 GHz
Core Logic Modelle A & B Modelle C & D
Intel GM45 + ICH9M Chipsatz Intel PM45 + ICH9M Chipsatz

. |
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Funktion

Technische Daten

LCD-Bildschirm

Modelle A & C
Glare-Type TFT-Flachbildschirm, 14,1" - WXGA /
WXGA+

Modelle B & D
Glare-Type TFT-Flachbildschirm, 15,4" - WXGA /
WXGA+ | WSXGA+

Videoadapter Modelle A & B Modelle C & D
Intel GM45 Integrated Video (auf dem Chip) NVIDIA GeForce 9300M GS Discrete Video (extern
Hochleistungs-2D/3D-Grafikbeschleuniger onboard)
Shared-Memory-Architektur (bis zu 256MB 256MB GDDR?2 Video-RAM On Board
gemeinsam verwendeter Videospeicher, der vom TurboCache™ unterstitzt einen gesamten Grafik-
Systemspeicher nach Bedarf dynamisch zugewie- speicher von bis zu 512MB (je nach Systemspei-
sen wird) cher)
Unterstitzt DirectX 10.0 Unterstiitzt DirectX 10.0
Speicher Zwei 200-Pin SODIMM-Sockel, Unterstiitzung von DDRII (DDR2) 667/800 Speicher
Speicher auf bis zu 4GB erweiterbar
Sicherheit Offnung fur SicherheitsschloR (Typ Kensington) BIOS-PalRwort
Fingerabdruckleser (Werkseitige Option)
BIOS Phoenix BIOS (32Mb SPI Flash-ROM)
Speicher Ein Austauschbares SATA optisches Laufwerk (12,7 mm Ho6he) fir CDs/DVDs (Laufwerksoptionen finden Sie
unter “Optional” auf Seite 88)
Eine einfach auszuwechselnde SATA-2,5"-Festplatte (9,5 mm Hohe)
Audio Intel High-Definition-Audio-kompatible Schnittstelle S/PDIF Digtalausgang

3D Stereo-Soundsystem
Kompatibel mit Sound-Blaster PRO™

2 eingebaute Lautsprecher
Eingebautes Mikrofon
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Funktion Technische Daten
Tastatur “Win Key”-Tastatur
Zeigegerat Eingebautes TouchPad (integrierte Rolltastenfunktion)
- Schnittstellen Drei USB 2.0-Anschlisse Ein eSATA-Anschluss
(&) Ein HDMI (High-Definition Multimedia Interface)-Aus- eSATA nur in Windows Vista unterstutzt:
ﬂ gangsanschluss (unterstiitzt 5.1-Kanal) mit Audioaus- AHCI-Modus unterstiitzt Hot-Swapping
> gabe IDE-Modus unterstiitzt kein Hot-Swapping
8 Eine Lautsprecher/Kopfhorer-Ausgangsbuchse _
Eine Mikrofon-Eingangsbuchse Eine RJ-11 Buchse fiir Modem
Eine S/PDIF-Ausgangsbuchse Eine RJ-45-Buchse fur LAN

Eine DC-Eingangsbuchse
Eine Schnittstelle fiir externen Monitor

Kartenleser Festes 7-in-1 Kartenleser-Modul (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)
Hinweis: MS Duo/ Mini SD/ RS MMC Karte erfordert PC-Adapter

ExpressCard-

Steckplatz ExpressCard/54(34)-Steckplatz

Mini-Card-Steck- | Ein Mini-Card-Steckplatz nur fur Wireless-LAN Modul
platze Ein Mini-Card-Steckplatz nur fur Intel Turbo Memory-Modul oder 3.5G-Modul

. |
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Funktion Technische Daten

Kommunikation | 56K MDC-Modem (V.90- und V.92-kompatibel)

1 Gbit PCI-Express Fast-Ethernet-LAN Ay
Optionen fur Wireless-LAN-Module: /ﬂ\

Intel® WiFi Link 5300 (802.11 a/g/n) Wireless LAN Mini-Card-Modul UMTS-Modi

Intel® WiFi Link 5100 (802.11 a/g/n) Wireless LAN Mini-Card-Modul Beachten Sie, dass die UMTS-
1,3M oder 2,0M Pixel USB PC-Kamera-Modul (Werkseitige Option) Modi NICHT in Nordamerika ver-

USB Bluetooth 2.0 + EDR-Modul (Werkseitige Option) wendet werden knnen.

UMTS/HSPDA-gestitzes 3.5G-Modul mit MiniCard-Schnittstelle
(Werkseitige Option)

Quad-band GSM/GPRS (850 MHz, 900 MHz, 1800 MHz, 1900 MHz)
UMTS WCDMA FDD (2100 MHz)

o
@D
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Energieverwal- |\ ctiitzt ACPI V3.0

tung

Stromversor- Modelle A & B Modelle C & D

gung AC/DC-Adapter fir den gesamten Spannungsbereich | AC/DC-Adapter fiir den gesamten Spannungsbereich
AC-Eingang: 100-240 V, 50-60Hz AC-Eingang: 100-240 V, 50-60Hz
DC-Ausgang: 19V, 3,42A oder 18,5V, 3,5A (65W) DC-Ausgang: 19V, 4,74A (90W)

Akkupack mit Smart Lithium-lonen-Hauptakku mit 6 Zellen, 4000mAH oder 4400mAH

oder
Akkupack mit Smart Lithium-lonen-Hauptakku mit 9 Zellen, 7200mAH - Option

. |
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und Gewicht

336 (B) x 250 (T) x 24,8 - 35,7 (H) mm
2,3 kg mit 6-Zellen-Akku

Funktion Technische Daten
Umgebungsbe- | Temperatur Relative Luftfeuchtigkeit
dingungen In Betrieb: 5°C — 35°C In Betrieb: 20 — 80 %

Bei Aufbewahrung: -20°C — 60°C Bei Aufbewahrung: 10 — 90 %
Abmessungen Modelle A & C Modelle B & D

359 (B) x 268 (T) x 24,8 - 37 (H) mm
2,6 kg mit 6-Zellen-Akku

Optional

Optionen fur optische Laufwerks-Module:
Kombiniertes SATA -Laufwerk

DVD Dual (Super Multi) SATA-Laufwekrsmodul

Optionen fur Wireless-LAN-Module:

Intel® WiFi Link 5300 (802.11 a/g/n) Wireless LAN
Mini-Card-Modul

Intel® WiFi Link 5100 (802.11 a/g/n) Wireless LAN
Mini-Card-Modul

Akkupack mit Smart Lithium-lonen-Hauptakku mit 9

Zellen

1,3M oder 2,0M Pixel USB PC-Kamera-Modul (Werk-

seitige Option)
Fingerabdruckleser (Werkseitige Option)

USB Bluetooth 2.0 + EDR-Modul (Werkseitige
Option)

Intel Turbo Memory-Modul (Robson) - 2GB
Oder
UMTS/HSPDA-gestitzes 3.5G-Modul mit MiniCard-
Schnittstelle (Werkseitige Option)
Quad-band GSM/GPRS (850 MHz, 900MHz,
1800 MHz, 1900 MHz)
UMTS WCDMA FDD (2100 MHz)

N A
2

UMTS-Modi

Beachten Sie, dass die UMTS-Modi NICHT in
Nordamerika verwendet werden kénnen.
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Avertissement

La compagnie se réserve le droit de revoir cette publication ou de modifier son contenu sans préavis. Les informations
qu’elle contient sont pour référence seulement et n’engagent pas la responsabilité du fabricant ou d’aucun distributeur. Ils
n’assument aucune responsabilité en cas d’erreurs ou d’imprécisions qui pourraient se trouver dans cette publication et ne
sont en aucun cas responsable d’aucunes pertes ou dommages résultant de I’utilisation (correcte ou incorrecte) de cette pu-
blication.

Cette publication et les logiciels qui I’accompagnent ne peuvent pas, dans leur intégrité ou en partie, étre reproduits, tra-
duits, transmits ou convertis en format électronique sans I’autorisation préalable du vendeur, du fabricant ou des créateurs
de cette publication, a I’exception de copies conservées par |’utilisateur pour archive.

Les noms de marques ou de produits mentionnés dans cette publication peuvent ou pas étre protégés et/ou étre des marques
déposeées par leur compagnies respectives. Ils sont mentionnés dans un but d’identification seulement et ne signifient pas
I’approbation de ce produit ou de son fabricant.

© Mai 2008

Marques déposées

Ce produit incorpore une technologie de protection des droits d'auteur protégée par certains brevets américains et autres
droits sur la propriété intellectuelle appartenant a Macrovision Corporation et d’autres propriétaires légitimes. L utilisation
de cette technologie de protection des droits d'auteur doit étre autorisé par Macrovision Corporation, et n’est prévu que dans
un cadre privé ou limité, a moins d’obtenir I’autorisation de Macrovision Corporation. L'ingénierie inverse et le désassem-
blage sont interdits.

Intel et Intel Core sont des marques déposées ou enregistrées d’Intel Corporation déposées.

Avertissement - 89

I
)
S
O
Q.
o




Guide Utilisateur Concis

A propos de ce Guide Utilisateur Concis

Ce guide rapide est une bréve introduction a la mise en route de votre systéme. | s’agit d’un supplément, et non pas d’une
alternative au Manuel de I’Utilisateur en Anglais complet au format Adobe Acrobat sur le disque Device Drivers & Utili-
ties + User's Manual fourni avec votre ordinateur. Ce disque contient aussi les pilotes et utilitaires nécessaires au fonction-
nement correct de votre ordinateur portable.

Certains ou tous les éléments de I’ordinateur peuvent avoir été déja installés. Si ce n’est pas le cas, ou si vous avez I’inten-
tion de reconfigurer (ou réinstaller) des portions du systéme, reportez-vous au Manuel de I’Utilisateur complet. Le disque
Device Drivers & Utilities + User’s Manual ne contient pas de systéme d’exploitation.

Informations de contrdle

Des mises en garde et informations de contréle sont incluses dans le Manuel de I'Utilisateur complet qui se trouve sur le
disque Device Drivers & Utilities +User’s Manual.
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Utilisation des appareils sans fil a bord d'un avion

L'utilisation de tout appareil électronique de transmission est généralement interdite a bord d'un avi-
on. Assurez-vous que les modules 3.5G/WLAN/Bluetooth sont éteints si vous utilisez I'ordina-
teur a bord d'un avion.
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Instructions d’entretien et d’utilisation
L’ordinateur portable est robuste, mais il peut toutefois étre endommagé. Afin d’éviter ceci, veuillez suivre ces recommandations :

* Ne le laissez pastomber. Ne I’exposez a aucun choc ou vibration. Si I’ordinateur tombe, le boitier et d’autres éléments pour-
raient étre endommages.

« Gardez-le sec. Ne le laisser pas surchauffer. Tenez I’ordinateur et son alimentation externe a distance de toute source de chaleur.
Il sagit d’un appareil électrique. Si de I’eau ou tout autre liquide venait & pénétrer a I’intérieur de votre ordinateur, il pourrait étre
sérieusement endommagg.

« Euvitez les interférences. Tenez I’ordinateur a distance de transformateurs a haute capacité, moteurs électriques, et autres appareils
générateurs de champs magnétiques importants. Ceux-ci peuvent géner ses performances normales et endommager vos données.

« Suivez les procédures appropriées d’utilisation de votre ordinateur. Arrétez I’ordinateur correctement, et fermez tous vos pro-
grammes (n’oubliez pas d’enregistrer votre travail). N’oubliez pas d’enregistrer vos données régulierement puisqu’elles peuvent
étre perdues si la batterie est vide.

» Soyez prudent lorsque vous utilisez des périphériques.

I
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Révision

N’essayez pas de réaliser les opérations de révision de votre ordinateur par vous-méme. Le faire pourrait annulez votre
garantie et vous exposez a des chocs électriques. Pour toute opération de révision, adressez-vous a des personnes agrées.
Débranchez votre ordinateur de toute source d’alimentation. Puis adressez-vous a des professionnels agréés si vous ren-
contrez I’une des situations suivantes :

 Sile cordon d’alimentation ou I’adaptateur CA/CC est endommagé, abimé ou effiloché.

 Sivotre ordinateur a été exposé a la pluie ou tout autre liquide.

 Si votre ordinateur ne fonctionne pas normalement bien que vous ayez suivi les instructions de mise en marche a la lettre.

 Si votre ordinateur est tombé par terre ou a été endommagé de quelque maniére que ce soit (ne touchez pas le liquide qui sortirait
de I’écran LCD au cas ou celui-ci serait cassé : il est trés dangereux et contient des produits qui pourraient vous empoisonner).

 Siune odeur inhabituel, de la chaleur ou de la fumée apparaissait sortant de votre ordinateur.

. |
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Sécurité electrique

\otre ordinateur posséde des besoins en énergie propre :

« Utilisez uniquement un adaptateur CA/CC agréé avec votre ordinateur.

» \otre adaptateur CA/CC peut avoir été congu pour les voyages internationaux mais il lui faut tout de méme une source de courant
réguliére et ininterrompue. Si vous n’étes pas sir des caracteristiques du réseau électrique local, consultez notre représentant de
service ou la compagnie électrique locale.

» L’adaptateur CA/CC que vous utilisez, peut étre a 2 broches ou a 3 broches, comprenant une prise de terre. Cette prise de terre est
un des éléments de sécurité importants, ne vous en passez pas ! Si une prise murale compatible n’est pas disponible, demandez a un
électricien qualifié de vous en installez une.

» Quand vous voulez débrancher le cordon d’alimentation, ne tirez pas sur le fil, mais attrapez la téte de la prise.

» Assurez-vous que la prise murale et la (les) rallonge(s) que vous utilisez peuvent supporter la consommation électrique de tous les
appareils qui y sont reliées.

» Avant de nettoyez votre ordinateur, assurez-vous qu’il n’est relié & aucune source de courant.

SN
A&

Mise en garde pour le sécurité electrique
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Avant d’entreprendre des procédures de mise a niveau, assurez-vous d’'avoir éteint I'ordina-teur, et déconnecté tous les périphériques et
ca-bles (y compris les cor-dons téléphoniques). Il est également conseillé d’enlever la batterie afin d’éviter d’allumer I'ap-pareil par mégarde.

Eteignez avant de partir en voyage

Assurez-vous que votre notebook est complétement éteint avant de le mettre dans un sac de voyage (ou tout autre bagage similaire). Si
vous placez le notebook allumé dans un sac de voyage, cela peut obstruer la (les) ventilation(s). Pour éviter que votre ordinateur ne sur-
chauffe, assurez-vous que rien n‘obstrue la (les) ventilation(s) quand l'ordinateur est en cours d'utilisation.

Nettoyage
» N’appliquez pas de produit de nettoyage directement sur I’ordinateur, utilisez un bout de tissu propre et souple.
» Nutilisez pas de produit de nettoyage volatil (des distillés pétrdle) ou abrasifs sur aucun des éléments de I’ordinateur.

. |
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Précautions a prendre pour la batterie

» Utilisez uniquement des batteries congues pour votre ordinateur. Un mauvais type de batterie peut provoquer des explosions, des
fuites et/ou endommager votre ordinateur.

» Ne continuez pas d'utiliser une batterie qui est tombée, ou qui parait endommagée (ex: tordue ou vrillée) d'une maniere quelconque.
Méme si l'ordinateur continue de fonctionner avec la batterie en place, cela peut détériorer le circuit, pouvant déclencher un incendie.

» Rechargez les batteries en utilisant le systéme de I’ordinateur portable. Un rechargement incorrect peut provoquer I’explosion de la
batterie.

» N’essayez jamais de réparer la batterie. Au cas ou votre batterie aurait besoin d’étre réparée ou changée, veuillez vous adresser a
votre représentant de service ou a des professionnels qualifiés.

» Gardez les batteries endommagées hors de portée des enfants et débarrassez-vous en le plus vite possible. Veuillez toujours jeter les
batteries avec précautions. Les batteries peuvent exploser ou se mettre a fuire si elles sont exposées au feu ou si elles sont manipu-
lées ou jetées d’une fagon non appropriée.

» Gardez la batterie loin des appareils métalliques.

» Placez un morceau de scotch sur les contacts de la batterie avant de la jeter.

* Ne touchez pas les contacts de la batterie avec les mains ou avec des objects en métal.

2NZ
2 &

Elimination de la batterie & avertissement
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Le produit que vous venez d’acheter contient une batterie rechargeable. Cette batterie est recyclable. Quand elle n’est plus utili-
sable, en fonction des lois locales des différents états et pays, il peut étre illégal de s’en débarrasser en la jetant avec les ordures
ménageres normales. Vérifiez aupres du responsible local de I'élimination des déchets solides de votre quartier pour vous infor-

mer des possibilités de recyclage ou de la maniere appropriée de la mettre au rebut.

Il existe un danger d’explosion si la batterie est replacée de facon incorrecte. Remplacez-la uniquement par des batteries de
méme type ou de type équivalent, recommendé par le fabricant. Eliminez les batteries usagées selon les instructions du fabricant.
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Différences de Modéles

Cette série de notebooks comprend quatre types de modeles différents (chaque modéle comprend différents styles de de-
sign). L'aspect extérieur exact et certaines des boutons Hot-Key peuvent apparaitre légerement différents de ce qui est il-
lustré dans ce manuel, cependant les ports, les composants et les fonctions etc. sont tous les mémes pour chaque style de
design.Les modeéles different comme indiqué dans le tableau ci-dessous.

Caractéristique Modele A Modele B Modele C Modele D
Core logic Intel(R) GM45 + ICH9M Chipset Intel(R) PM45 + ICH9M Chipset
7] Adaptateur Vidéo Vidéo intégrée Intel (Interne sur puce) Vidéo discret NVIDIA (Externe sur carte)
gﬂ Adaptateur CA/CC 65W (Sortie c.c. 19V, 3,42A ou 18,5V, 3,5A) 90W (Sortie c.c. 19V, 4,74A)
:LE Tipo de LCD 14,1" WXGA/ WXGA+ 15,4° V\\/l\;(sci('z'XYrXGAH 14,1" WXGA/ WXGA+ 15,4° V\\//\;(SC;J(A(\;A\{XXGAH

Tableau 1 - Différences entre modéles

. |
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Guide de démarrage rapide

1.

2.
3.

Enlevez tous les emballages.

Posez 'ordinateur sur une surface stable.

Connectez fermement les périphériques que vous souhaitez utiliser avec votre ordinateur portable (par ex. clavier et souris) a leurs
ports respectifs.

Branchez l'adaptateur CA/CC a la prise d'entrée CC sur la gauche de l'ordinateur, branchez ensuite le cordon secteur a une prise
murale, puis a I'adaptateur CA/CC.

D'une main, soulevez soigneusement le couvercle/LCD pour obtenir un angle de vision confortable (ne pas dépasser 130 degrés),
de l'autre main (comme illustré dans la Figure 1 ci-dessous) maintenez la base de l'ordinateur (Remarque : Ne soulevez jamais
I'ordinateur par le couvercle/LCD).

Pressez le bouton de mise en marche pour allumer.

Arrét

Veuillez noter que vous devriez toujours éteindre votre ordinateur en utilisant la commande Arréter du menu du
bouton de verrouillage de Windows Vista. Cette précaution évite des problemes de disque dur ou de systeme.

Figure 1 - Ouvrir le couvercle/LCD/ordinateur avec un adaptateur CA/CC branché
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n
u
Q
S

0O
QL
n




2
@©
O
c
-
LL

Guide Utilisateur Concis

Logiciel systeme

\otre ordinateur peut étre livré avec un logiciel systeme
pré-installé. Si ce n’est pas le cas, ou si vous re-configurez
votre ordinateur pour un systeme différent, vous constaterez
gue ce manuel fait référence au systéme d’exploitation Mi-
crosoft Windows Vista. De plus amples informations sur
I’installation des pilotes et utilitaires sont disponibles aux
Chapitres 4 & 7 du Manuel de I’Utilisateur sur le disque
Device Drivers & Utilities + User’s Manual.

4

Pilotes

Si vous installez/réinstallez un nouveau logiciel systeme, vous
devrez installer les pilotes appropriés. Les pilotes sont les pro-
grammes qui servent d'interface entre |'ordinateur et un maté-
riel, par exemple un module réseau sans fil. Il est tres
important d'installer les pilotes dans l'ordre indiqué dans le
Tableau 5 ala page 111. Vous ne pourrez pas utiliser les con-
troles les plus avancés tant que les pilotes et les utilitaires né-
cessaires n'auront pas été correctement installés.

Systemes d'exploitation pris en charge

Systéme
d’exploitation

Remarque

Windows XP
(Home Edition ou
Professional)

Pour les informations sur le systéme
d'exploitation Windows XP (consultez le
disque Device Drivers & Utilities +User’s
Manual).

Windows Vista
avec Service Pack
1 (64-bit) Home
Basic Edition/
Home Premium
Edition/Business

Prenez soin d'installer Windows Vista
Service Pack 1 (ou une version de Win-
dows Vista comprenant Service Pack 1),
avant d'installer tout pilote. Consultez
le site de Microsoft pour télécharger les
informations détaillées, ou contactez le
service clientele.

Editon/Enterprise | pouyr utiliser Windows Vista sans limita-
Editon/Ultimate | tions ni baisse de performances, votre
Editon ordinateur doit comporter au minimum
1Go de mémoire vive (RAM).
Non inclus

Les Systéemes d’exploitation (par ex. Windows Vista/Win-
dows XP, etc.) ainsi que les applications (par ex. program-
mes de traitement de texte, tableur et base de données) ont
leurs propres manuels, aussi veuillez consulter les manuels
appropriés.
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Carte du systéme : Vue de face avec I’écran LCD
ouvert (Modeles A & C)

G
S
Utilisation des appareils sans
fil a bord d'un avion

L'utilisation de tout appareil élec-
tronique de transmission est gé-
néralement interdite a bord d'un
avion. Assurez-vous que les
modules sans fil sont éteints
si vous utilisez I'ordinateur a
bord d'un avion.

Utilisez les combinaisons de

touches pour basculer I'alimen-
tation sur les modules 3.5G/
WLAN/Bluetooth, et reportez-
vous a l'icone d'indicateur/barre
des taches d'état pour voir si les
modules sont allumés ou pas
(voir

Figure 2
Vue du face avec
I'écran LCD ouvert
(Modéles A &C)

Caméra PC optionnelle

Ecran LCD

Haut-parleurs

Bouton de mise en

marche

Boutons Hot-Key

Clavier

Microphone

Pavé tactile (TouchPad)

et boutons

9. Lecteur d'empreintes
digitales (optionnel)

10. Indicateurs LED

PoONPE

©No:

\ /
Boutons du pavé tactile
(TouchPad)
(zone d'utilisation valide)
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i N

9.

© N o

Figure 3
Vue du face avec
I'écran LCD ouvert
(Modéles B & D)

Caméra PC optionnelle
Ecran LCD
Haut-parleurs

Bouton de mise en
marche

Boutons Hot-Key
Clavier

Microphone

Pavé tactile (TouchPad)
et boutons

Lecteur d'empreintes
digitales (optionnel)

10. Indicateurs LED

98 - Carte du systéeme : Vue de face avec I’écran LCD ouvert (Modeles B & D)

\ /
Boutons du pavé tactile
(TouchPad)

(zone d'utilisation valide)

Carte du systéeme : Vue de face avec I'’écran LCD
ouvert (Modeles B & D)

N
s
Utilisation des appareils sans fil
abord d'un avion

L'utilisation de tout appareil électro-
nique de transmission est générale-
ment interdite & bord d'un avion.
Assurez-vous que les modules
sans fil sont éteints si vous utili-
sez |'ordinateur a bord d'un avi-
on.

Utilisez les combinaisons de tou-

ches pour basculer ['alimentation
sur les modules 3.5G/WLAN/Blue-
tooth, et reportez-vous a licone
d'indicateur/barre des taches d'état
pour voir si les modules sont allu-
més ou pas (voir




Indicateurs LED

Les indicateurs LED sur votre ordinateur affichent des informations utiles sur I’état actuel de votre ordinateur.

Tableau 2 - Indicateurs d’etat

Guide Utilisateur Concis

Icone | Couleu Description Icone | Couleur Description
Orange | L'adaptateur CA/CC est branchée Orange La batterie est en charge
Vert L'ordinateur est allumé Vert La batterie est complétement chargée
D) 1]
Vert Le systéme est dans le mode de Veille Orange La batterie a atteint le niveau bas criti-
clignotant | configuré clignotant | que
[E] Vert Verrouﬂlgqe numérique (pave numeri- ﬁ Vert Le disque dur est en cours d'utilisation
que) activé
Vert Verrouillage majuscule activé Vert Le module LAN sans fil est allumé
()
El Vert Verrouillage défilement activé Orange Le module Bluetooth est allumé

Indicateurs LED - 99
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Boutons Hot-Key & clavier

Les boutons Hot-Key donnent un acces instantané au navi-
gateur Internet par défaut et au programme de messagerie,
et vous permettent d'activer/désactiver le Mode Silencieux
d'une simple pression sur un bouton.

Bouton Hot-Key Fonction

Activer le programme d’e-mail par
défaut

Activer le navigateur Internet par
défaut

Passer en Mode Silencieux* (pour
I'économie d'énergie)

Tableau 3 - Boutons Hot-Key

*Quand il est activé, le Mode Silencieux diminuera le bruit
du ventilateur et permettra de consommer moins de courant.
Remarquez que cela peut diminuer les performances de I'or-
dinateur.

Le clavier est doté d'un pavé numérique intégré pour une
saisie des données numériques plus facile. Il est également
doté de touches fonction pour vous permettre de changer
instantanément de mode opérationnel (voir la Figure 4).

Ecrap | [P [

ESlE Touches Fonction g
=7 ‘& 2 3“ 4¢ £ 7l g & (g
: . e_z = = B /\ctiver/Désactiver
= "l (¢ module 3.5G Touches
8 al|’s o Hi g K2 Le NumLk & ScrLk
= ' i iz I H

Figure 4 - Clavier

4

Caracteres Spéciaux

Certaines applications permettent que les touches du pavé
numérique soient utilisées avec Alt pour produire des carac-
teres spéciaux. Ces caractéres spéciaux peuvent étre pro-
duits uniguement en utilisant le pavé numérique. Les touches
normales des chiffres (sur la rangée supérieure du clavier) ne
le permettent pas. Assurez-vous que NumLk (pavé numéri-
que) soit allumé.

100 - Boutons Hot-Key & clavier
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Touches fonction & indicateurs visuels

Les touches de fonctions (F1-F12 etc.) agiront comme touches de raccourci (hot-key) quand pressée en maintenant la
touche Fn appuyée. En plus des combinaisons des touches de fonction de base, les indicateurs visuels sont disponibles
quand le pilote de touches de raccourci (HotKey Driver) est installé (reportez-vous a “Hot-Key” a la page 113). Une fois
le pilote installé une icéne ¥ apparaitra dans la barre des taches.

Boutons Hot-Key & clavier - 101

Touches Fonction/indicateurs visuels Touches Fonction/indicateurs visuels
Diminution/Augmenta-
Fn+~ Lecture/Pause (dans les programmes audio/vidéo) Fn + F8/F9 | tion de la luminosité m
de I'écran LCD 2adad,
Activer/Désactiver le | Activer/Désactiver le T
r + | | -
Fn+ o module 3.5G ,Q ° ..G Fn+F10 module Caméra PC < ',r',,,jﬁd % :ﬂ %
Activer/Désactiver le — e - Activer/Désactiver le ) @ O
+ - + ) 1
Fn+Fl TouchPad \Q—'\\Q— Fn+Fll module LAN sans fil ® .umg‘l) @ Radloon s D
— — (7))
Eteindre le rétroéclairage LCD (Appuyez sur une Activer/Désactiver le
+ +
Fn+F2 touche ou utilisez le TouchPad pour allumer) Fn+F12 module Bluetooth F i 5 .
Fn + F3 Allume/Eteind le son : ® NFn +|_k Actlv,er/Des,a_ctlver le verrouillage numérique
Volume *  On Volume *  Mute um (pave nume”que)
Fn+F4 Permutation veille Fn + ScrLk | Activer/Désactiver I'arrét défilement
Diminution/Augmen- . . .
: Activer/Désactiver le Nl Silent
Fn + F5/F6 | tation du volume BTN (@ Mode Silencieux o mndc@
sonore
Tabl 4-T h fonction indi rs vi-
Fn+ F7 Alternance d'affichage ableau ouches desuc;IsCt ons & indicateurs
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Figure 5 Carte du systeme : Vues de face & gauche

Vues de face & gauche

Indicateurs LED
Prise d'entrée CC
Port moniteur externe
Prise réseau RJ-45
Port eSATA

Prise de sortie HDMI
Ventilation

2 Ports USB 2.0

Logement
d'ExpressCard/54(34)
10. Lecteur de carte 7-en-1
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Lecteur de carte 7-en-1

Le lecteur de carte vous permet d'utiliser certaines des cartes de stockage numériques les plus res-
sentes.

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) /
MS Pro (Memory Stick Pro) / MS Duo (nécessite un PC adaptateur) /
Mini SD (nécessite un PC adaptateur) / RS MMC (nécessite un PC adaptateur)

Port eSATA

Remarquez que le pilote d'Intel Matrix Storage est requis pour activer le port eSATA (reportez-
vous a “Support du port eSATA” a la page 122).

.|
102 - Carte du systéme : Vues de face & gauche
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Carte du systeme : Vues droite & arriere

N/
2 &
Ejection d’'urgence du CD

Si vous devez éjecter manuellement un
CD ou DVD (par ex. suite a une coupure
de courant) vous pouvez enfoncer I'ex-
trémité d’'un trombone redressé dans le
trou d’ejection d’'urgence. N'utilisez pas
la pointe d’un crayon, ou tout autre objet
similaire qui pourrait se casser et rester
coincé dans le trou.

Mise en garde média

N’essayer pas d’enlever un CD pendant
que le systeme est en train de la lire ou
d'y écrire. Vous pourriez faire « planter »
le systeme.

Changer les codes régionaux des DVD

Allez au Panneau de configuration et double-cliquez
sur Gestionnaire de périphériques (Matériel et
audio), et cliquez le + a coté de Lecteurs DVD/CD-
ROM. Double-cliquez sur le périphérique DVD-ROM
pour afficher le menu Propriétés, et sélectionnez l'on-
glet Région du DVD pour afficher le panneau de con-
figuration pour vous permettre d'ajuster le code
régional.

La détection de codes régionaux est liée a l'appareil,
pas au systeme d’exploitation. Vous pouvez changer le
code régional de votre module 5 fois. La cinquieme sé-
lection est permanente. Elle ne peut pas étre changée
méme si vous changez votre systéme d’exploitation ou
si vous utilisez le module dans un autre ordinateur.

Figure 6
Vues droite & arriére

Prise de sortie S/PDIF
Prise d'entrée de
microphone

Prise de sortie haut-
parleurs/casque

Port USB 2.0

Baie de périphérique
optique (pour lecteur CD/
DVD)

Trou d’ejection d’'urgence
Prise téléphone RJ-11
Fente de verrouillage de
sécurité

Batterie

.|
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Figure 7
Vue d’en dessous

Batterie

Couvercle du module
Bluetooth

Couvercle de baie CPU/
RAM

. Ventilation

Couvercle de baie de
disque dur
Emplacement de la carte
3.5G USIM

Guide Utilisateur Concis

2N\
I

CPU

Veuillez ne pas essayer d'ouvrir ou de
forcer le processeur UC de votre ordi-
nateur. Le fait d'accéder au CPU de
quelque maniére que ce soit risque de

violer la garantie.

Surchauffe

Afin de ne pas causer une surchauffe
de votre ordinateur, verifiez que rien ne
bouche la (les) ventilation(s) quand le
systeme est allume.

4

Informations batterie

Décharger puis rechargez toujours
complétement une batterie neuve

avant de ['utiliser. Déchargez compléte-
ment puis rechargez la batterie au
moins une fois tous les 30 jours ou
apres environ 20 décharges partielles.

104 - Carte du systéme : Vue d’en dessous
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4
Modeles B & D
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Menu Démarrer & Panneau de configuration de Windows Vista

\Vous pouvez accéder a la plupart des panneaux de contréle, utilitaires et programmes dans Windows Vista (et la plupart des
autres versions de Windows) a partir du menu Démarrer. Quand vous installez des programmes et utilitaires ils seront installés
sur votre disque dur, et un raccourci sera habituellement placé dans le menu Démarrer et/ou le bureau. Faites un clic droit sur
I'icone menu Démarrer [, et sélectionnez Propriétés si vous voulez personnaliser I'apparence du menu Démarrer.

Ouvrir \@1 Programmes par défaut e s
Explorer - e 8 E27 Vindous Updte 2 L
Rechercher... % Courrer dlectronique - .
T L] mdows ) Progemmes Ay
priétés B 3
Ouviir Tous les utilsateurs g Aervetinon Ly Documents & P
Explorer Tous les utiisateurs ) Paramétres B Panneau de configur e e
z O 1 Comneionsésezu
- echercher
% ey r <k Imprimantes i i
\J o @ Aide et support [ Barre des tiches et menu Démarrer o
— ¥
Ba & 5] Becuter..
&l ©
a0 .
20 .,

Cliquez ici pour basculer vers
I'affichage classique

b Mol programmes

Figure 8 - Menu Démarrer & Panneau de configuration

A de nombreuses reprises dans ce manuel vous verrez une instruction pour ouvrir le Panneau de configuration. Vous pou-
vez accéder au Panneau de configuration a partir du menu Démarrer. Le Panneau de configuration vous permet de con-
figurer les parameétres pour la plupart des fonctionnalités clés dans Windows (ex. alimentation, vidéo, réseau, audio etc.).
Windows Vista offre les panneaux de contrdles de base pour un grand nombre des fonctionnalités, cependant de nouveaux
panneaux de contrbles sont ajoutés (ou certains existants sont améliorés) quand vous installez les pilotes énumérés dans le
Tableau 5 a la page 111. Pour voir tous les contrdles il peut s'avérer nécessaire de basculer vers I'affichage classique.

.|
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Caractéristiques vidéo

Cet ordinateur présente deux options vidéo différentes (soit Intel pour les modéles A & B, soit NVIDIA pour les modeles
C & D). Vous pouvez permuter les périphériques d'affichage depuis le panneau de controle Parameétres d'affichage dans
Windows ou le panneau de configuration Intel GMA Driver for Mobile/Panneau de configuration NVIDIA, a partir du
moment ou le pilote vidéo est installé.

Pour accéder aux Parameétres d'affichage dans Windows Vista:

1. Cliguez sur le menu Démarrer, et cliquez sur Panneau de configuration (ou pointez sur Paramétres et cliquez sur Panneau de
configuration).

2. Cliguez sur Ajuster la résolution de I'écran dan le menu Apparence et personnalisation (ou double-cliquez sur
Personnalisation > Parameétres d'affichage).

3. Déplacez le curseur sur le parametre préféré dans Résolution: o (voir la Figure 9 a la page 107).
4. Cliquez sur la fleche et faites défiler jusqu’au paramétre préféré dans Couleurs: 9 (voir la Figure 9 a la page 107).
5. Cliguez sur Paramétres avancés G pour faire apparaitre les onglets Parameétres avancés (voir la Figure 9 a la page 107).
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Pour accéder au Panneau de configuration Intel GMA Driver for Mobile (Modéles A & B):

1. Vous pouvez accéder au panneau de contrdle d'Intel GMA en cliquant sur l'icbne dans la barre des taches et en sélectionnant
Propriétés graphiques dans le menu (ou a partir du Intel GMA Driver for Mobile dans le Panneau de configuration de Windows).

Pour accéder au Panneau de configuration NVIDIA (Modéles C & D):

1. Vous pouvez accéder au Panneau de configuration NVIDIA en cliquant avec le bouton droit de la souris sur le bureau, et en cli-
guant sur Panneau de configuration NVIDIA (ou a partir du Panneau de configuration NVIDIA (NVIDIA Control Panel) dans le
Panneau de configuration de Windows).

106 - Caractéristiques vidéo



Guide Utilisateur Concis

Bl . Ordinaten
portabls
Made de fenctiannamant

Propriétés graphiques..,
I

Optamsgraphrore:

foanrae

Quitter le plateau

Parsmeas  atichage SRRSO

Intel* Graphics Media
Accelerator Driver
for mobile

Affichage 3
Trier par 3
Actualiser

Coller

Coller le raccourci

Panneau de configuration NVIDIA

Nouveau 2

n
u
Q
S

0O
QL
”

Bs Personnaliser

Figure 9 - Parameétres d'affichage & panneau de configuration Intel GMA Driver for Mobile/Panneau de
configuration NVIDIA

Brancher un autre affichage

Hormis le LCD intégré vous pouvez aussi utiliser un moniteur/écran plat/TV (TV via la prise de sortie HDMI seulement),
connecté au port moniteur externe ou a la prise de sortie HDMI (High-Definition Multimedia Interface) comme périphéri-
que d'affichage.

Caracteéristiques vidéo - 107
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Caractéristiques Audio

\Vous pouvez configurer les options audio sur votre ordina-
teur & partir du panneau de configuration de Sons  dan
Windows, ou a partir de I'icone du Gestionnaire audio DD
Realtek /@ dans la barre des taches/panneau de con-
figuration (cliquez avec le bouton droit sur I'icone [gj de la
barre des taches pour faire apparaitre un menu audio). Le
volume peut aussi étre réglé a l'aide de la combinaison de
touches Fn + F5/F6.

{;]] Gestionnaire de sons /

» Appareils Audic

% Evén. Son Systéme

@ Windows Media Player Le niveau du volume sono-
o | re est réglé a l'aide du con-

HEf tonnoleduvolume trole de volume dans

Windows (et les touches

de fonctions de volume sur

l'ordinateur). Cliquez sur

Réglages du Volume
Sonore

Enregistreur de sons

Cliquez avec le bou-
ton droit sur l'icbne |

l'icbne Volume dans la
barre des taches pour véri-

Configuration audio HDMI

Etant donné que HDMI (High-Definition Multimedia Inter-
face) transporte a la fois les signaux audio et vidéo vous de-
vrez configurer la sortie audio en suivant les instructions ci-
dessous.

Configuration audio de Windows pour HDMI

1. Connectez un appareil avec support HDMI a la prise de
sortie HDMI.

2. Cliquez sur le menu Démarrer, et cliquez sur Panneau de

configuration (ou pointez sur Paramétres et cliquez sur

Panneau de configuration).

Cliquez sur Son «» (Matériel et audio).

4. Cliquez sur Lecture (onglet), et cliquez pour choisir
Périphérigue HDMI (modéles A & B)/NVIDIA HDMI
Output (modeles C & D).

5. Cliquez sur Par défaut (bouton).

Cliquez sur OK pour fermer la fenétre Son .

7. \ous pourrez maintenant écouter des sources audio lues
dans Windows Media Player.

w

o

pour accéder au
menu ci-dessus.

fier le réglage.

.|
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. . Remarques HDMI
gu?ggzvzﬁjﬂr:j:endlcgé « Connectez un appareil avec support HDMI a la prise de sor-
la barre des taches tie HDMI AVANT d'essayer de lire des sources audio/vidéo
quand  Périphéri- via l'appareil.
que HDMI est sé-  « Sjvous débranchez le cable HDMI le périphérigue de lec-

lectionnée, et vous ture audio par défaut ne rétablira pas les haut-parleurs tant
remarquerez  que

l'icone au sommet que l'ordinateur n'aura pas redémarré (si vous ne désirez pas
de l'indicateur de ni- redémarrer l'ordinateur allez alors dans le panneau de con-

veau de volume a tréle Son et sélectionnez Haut-parleurs comme périphéri-
change. que de lecture audio par défaut).

Cliquez sur l'indica-
teur de volume L{ de
la barre des taches
quand NVIDIA
HDMI Output est
sélectionnée, et vous
remarquerez que
I'icbne au sommet
de l'indicateur de ni-
= veau de volume a
changé.

n
u
)
S

0O
D
n

Figure 10 - Périphérigue HDMI/NVIDIA HDMI Output
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Caractéristiques de gestion de 'alimentation

Le panneau de configuration Options d'alimentation de votre systeme Windows (voir la page 105) vous permet de con-
figurer la gestion d'alimentation de votre ordinateur. Vous pouvez économiser de I'énergie a l'aide de modes de gestion de
I'alimentation et configurer les options pour le bouton d‘alimentation, bouton de veille, couvercle de I'ordinateur
(lorsqu'il est ferme), mode Affichage et Veille dans le menu de gauche. Remarquez que le mode de gestion d'économie
d'énergie peut avoir un impact sur les performances de l'ordinateur.

Cliquez pour sélectionner I'un des modes existants, ou cliquez sur Créer un mode de gestion d'alimentation dans le menu gau-
che et sélectionnez les options pour créer un nouveau mode. Cliquez sur Modifier les paramétres du mode et cliquez sur Mo-
difier les paramétres d'alimentation avancés pour accéder a plus d'options de configuration.

]
(o]

= @ - =
GL=@ hoousud jon » Options dsienentsts - [ 43 | [Recherche 2 G- H i Looos
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e pasamibtres A abmentation. [nfizemasions sur ley me:

Choiir Paction qes i b tation
Fermetuee du capet
s Mades pris en compe sur b jauge de batterie

Crber un mode de getion de
Falimertation

& Usage namal Durée de ls bastesie : 99
Wodiies s paremitres do made Pefurmunces : 999

90 Chomr qeand élessdee écran

L Modfier les conditions de mite
e veille de [cedeateit

Duree de s bettene: 933339
Pedurmances: 88

0 Rigler o humincsté de Téeran Petormances devees Durée de s battere : 93
paramétres d mede Pedormances : 839938

Remarque : Veille est I'état d'économie d'énergie par défaut dans Windows Vista
Figure 11 - Options d’alimentation
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Installation du pilote Pilote (Windows Vista avec SP1) Page#
Le disque Device Drivers & qtl|ltle§ + User’s Manual con- Chipset page 112
tient les pilotes et les utilitaires nécessaires pour un bon Vide 0
fonctionnement de votre ordinateur. Insérez le disque et cli- 1aeo page
quez sur Install Drivers (bouton) ou cliquez sur Option Son page 112
Drivers (bouton) pour accéder au menu de pilote optionnel. Modem page 112
Installez les pilotes en respectant I'ordre indiqué dans le Réseau page 112
Tableau 5. Apreés avoir installé chaque pilote il apparaitra Pavé tactile (TouchPad) page 112
en grisé (si vous devez réinstaller un pilote, cliquez sur le octeur do carte bage 112
bouton Unlock). T
Hot-Key page 113 -
- - m
Installation manuelle du pilote Support eSATA page 122 a
Cliquez le bouton Browse CD (Parcourir le CD) dans I'ap- Caméra PC (option) page 113 QD
. . . . . f . . , m
plication Drivers Installer et naviguer jusquau fichier exeé- Module 3.5G (option) page 118
cutable dans le dossier de pilote approprié. . .
Module LAN sans fil (option) page 121
Wi ndows Update Module de mémoire Intel Turbo (option) page 122
Apres avoir installé tous les pilotes vérifiez que vous avez Lecteur d'empreintes digitales (option) page 123
activé Windows Update afin d'obtenir toutes les derniéres Bluetooth (option)
mises a jour de sécurité etc. (toutes les mises a jour inclu- Remarque: Pas d'installation de pilote requise (voir la
ront les derniers correctifs de Microsoft). page 125)
Activer Windows Update (voir a gauche)

Tableau 5 - Procédure d'Installation

Installation du pilote - 111
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Nouveau matériel détecté Modem

Si I’assistant Nouveau matériel détecté apparait pendantla 1. Cliquez sur 4.Install Modem Driver > Oui.
procédure d'installation, cliquez sur Annuler pour fermer 2. Cliquez sur OK.

I’assistant, et suivez la procedure d'installation comme indi- 3. Le modem est prét pour la configuration de connexion.

qué.
_ Réseau
Ch|pset 1. Cliquez sur 5.Install LAN Driver > Oui.
1. Cliquez sur 1.Install Chipset Driver > Oui. 2. Cliquez sur Suivant > Installer.
2. Cliquez sur Suivant > Oui > Suivant > Suivant. 3. Cliquez sur Terminer.
3. Cliquez sur Terminer pour redémarrer votre ordinateur. 4. La carte réseau est maintenant préte a étre configurée.
(%))
s Vidéo Pavé tactile (TouchPad)
= 1. Cliquez sur 2.Install VVideo Driver > Oui. 1. Cliquez sur 6.Install Touchpad Driver > Oui.
II Modeéles A & B (Intel): 2. Cliquez sur Suivant.

3. Cliquez sur Terminer > Redémarrer maintenant pour

2. Cliquez sur Suivant > Oui > Suivant > Suivant. 1 ;
redémarrer votre ordinateur.

3. Cliquez sur Terminer pour redémarrer votre ordinateur.

Modéles C & D (NVIDIA): Lecteur de carte
4. Cliquez sur Suivant. 1. Cliquez sur 7.Install Cardreader Driver > Oui.
5. Cliquez sur Terminer pour redémarrer votre ordinateur. 2. Cliquez sur Suivant > Installer.

3. Cliquez sur Terminer.
Son
1. Cliquez sur 3.Install Audio Driver > Oui.
2. Cliquez sur Suivant.
3. Cliquez sur Terminer pour redémarrer votre ordinateur.
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Hot-Key

1. Cliquez sur 8.Install Hotkey Utility > Oui.

2. Cliquez sur Next > Install.

3. Cliquez sur Finish > Finish pour redémarrer votre
ordinateur.

Support eSATA

\Voir “Configuration d'Intel Turbo Memory & Matrix
Storage et installation du pilote” a la page 122 pour les
instructions sur l'installation de ce pilote afin d'activer le
port eSATA.

Guide Utilisateur Concis
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Guide Utilisateur Concis

Caméra PC

Le module caméra PC utilise I'application BisonCap pour
capturer les fichiers vidéo.

N A
Z_ S

Derniéeres informations sur le pilote de caméra PC

Reportez-vous au disque Device Drivers & Utilities + User's Ma-
nual, et toutes les pages insérées qui accompagnent, pour les
derniéres informations de mise a jour concernant le pilote de
Caméra PC, qui peuvent remplacer les informations fournies ici.

Installation du pilote de la caméra PC

1. Activez le module a I'aide de Fn + F10 (I'indicateur visuel
. .. @ al'écran s'affichera brievement lors de I'activation
du module).

2. Cliquez sur Option Drivers (bouton).

3. Cliquez sur 1.Install WebCam Driver > Oui.

4. Choisissez la langue que vous préférez, et cliquez Suivant
> Suivant.

5. Cliquez sur Terminer pour redémarrer votre ordinateur.

6. Exécutez le programme d'application BisonCap a partir
du raccourci sur le bureau, ou a partir de I'élément
BisonCam dans le menu Démarrer >Programmes/Tous
les programmes (si le matériel est éteint utilisez la
combinaison de touches Fn + F10 pour le rallumer).

Paramétrage audio de caméra PC

Si vous souhaitez capturer de la vidéo et du son avec votre
caméra, il est nécessaire de régler les options d'enregistre-
ment du son dans Windows.

1. Cliquez sur le menu Démarrer, et cliquez sur Panneau de
configuration (ou pointez sur Parametres et cliquez sur
Panneau de configuration).

2. Cliquez sur Son 7 (Matériel et audio).

3. Cliquez sur Enregistrement (onglet).

4. Cliquez avec le bouton droit de la souris sur Microphone
(Realtek High Definition Audio) et vérifiez que I'élément n'est
pas désactivé.

5. Double-cliquez sur Microphone (ou sélectionnez Propriétés
dans le menu contextuel).

6. Cliquez sur Niveaux (onglet), et réglez les curseurs
Microphone et Ampli microphone au niveau requis.

7. Cliquez sur OK et fermez les panneaux de contrble.

8. [Exécutez le programme d'application BisonCap a partir de
I'élément BisonCam dans le menu Démarrer >
Programmes/Tous les programmes.

9. Allez aux en-tétes de menu des Périphériques et
sélectionnez Microphone (Realtek....) (il devrait y avoir une
marque sur le c6té)

10. Allez aux en-tétes de menu des Capture et sélectionnez
Capture Audio (il devrait y avoir une marque sur le coté).
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BisonCap

L'application BisonCap est un afficheur vidéo utile pour vi-
sualiser et tester les vidéos en général, et permet de capturer
des fichiers vidéo au format .avi..

1. Démarrez le programme BisonCap par le menu Démarrer >
Programmes/Tous les Programmes > BisonCam (il est
recommandé de Définir le fichier de capture avant la cap-
ture - voir "Définir le fichier de capture" ci-dessous).

2. Allez al'en-téte du menu Capture (si vous désirez capturer de
I'audio, reportez-vous a “ Paramétrage audio de caméra PC”
ala page 114) et sélectionnez Démarrer la capture.

3. Cliguez sur OK (I'emplacement du fichier s'affichera dans la
fenétre contextuelle) pour démarrer la capture, et appuyez sur
Echap pour arréter (vous pouvez visionner le fichier en
utilisant Windows Media Player).

Définir le fichier de capture

Avant de capturer des fichiers vidéo vous pouvez sélectionner
I'option Définir le fichier de capture dans le menu Fichier et
définir le nom et I'emplacement du fichier avant de capturer
(ceci permettra d'éviter d'écraser accidentellement des fi-
chiers). Définissez le nom et I'emplacement puis cliquez sur
Ouvrir, puis définissez la "Taille du fichier de capture :" et cli-
quez sur OK. Vous pouvez alors lancer le processus de capture
comme ci-dessus.

Guide Utilisateur Concis

Zoom
Le programme BisonCap vous permet de faire un zoom
avant et arriére avec la caméra.

1. Exécutez le programme d'application BisonCap.

2. Allez al'en-téte du menu Zoom et sélectionnez Zoom avant/
Zoom arriére.

Prendre des images fixes
Le programme BisonCap vous permet de prendre des ima-
ges fixes.

1. Exécutez le programme d'application BisonCap.
2. Allez al'en-téte du menu Options et sélectionnez Prendre
une photo.

3. Limage (au format JPEG) sera placée dans le dossier
Snapshot & sur le bureau (ne pas déplacer ni renommer
le dossier).

Cameéra PC - 115
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Guide Utilisateur Concis

Eliminer le scintillement d'écran

Si vous trouvez que I'écran vidéo dans le programme Bison-
Cap scintille, vous pouvez essayer d'ajuster le parameétre
dans les options Video Capture Filter... (Filtre de capture
vidéo).

1. Exécutez le programme d'application BisonCap.

Allez a I'en-téte du menu Options et sélectionnez Video
Capture Filter....

3. Cliquez sur 50Hz ou 60Hz sous Fréquence dans l'onglet
Page de propriétés.

Réduire la taille des fichiers vidéo

Notez que la capture de fichiers vidéo a haute résolution né-
cessite un espace substantiel sur le disque pour chaque fi-
chier. Aprés avoir enregistré la vidéo, vérifiez la taille du
fichier vidéo (cliquez avec le bouton droit de la souris sur le
fichier et sélectionnez Propriétés) et I'espace disponible
restant sur votre disque dur (allez & Ordinateur, cliquez
avec le bouton droit de la souris sur le disque dur, et sélec-
tionnez Propriétés). Si nécessaire, vous pouvez retirer le fi-
chier vidéo enregistré sur un support amovible ex. CD,
DVD ou mémoire Flash USB.

Notez que le systeme Windows Vista nécessite un minimum
de 15Go d'espace libre sur la partition systeme du lecteur

C:. Pour éviter tout probléme systéme, il est recommandé
d'enregistrer le fichier vidéo capturé dans un autre emplace-
ment que le lecteur C: (reportez-vous a “Définir le fichier
de capture” a la page 115), limitez la taille du fichier de la
vidéo capturée ou réduisez la résolution vidéo.

Pour réduire la taille de sortie de la résolution vi-

déo:

1. Lancez le programme BisonCap.

2. Allez a Options et faites défiler vers le bas pour
sélectionner Video Capture Pin... (Broche de capture
vidéo...).

3. Cliquez sur la liste déroulante Taille de sortie et
sélectionnez une taille de résolution inférieure afin de
diminuer la taille du fichier capturé.
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Module 3.5G

Si votre option d'achat comporte un module 3.5G option-
nel, suivez les instructions ci-dessous pour installer la carte
USIM (qui vous sera fournie par votre fournisseur de servi-
ce), et installez ensuite I'application.

A&
2 &
Mise en garde pour le sécurité electrique
Avant d’entreprendre des procédures de mise a niveau, assu-

rez-vous d’avoir éteint I'ordina-teur, et déconnecté tous les pé-
riphériques et ca-bles (y compris les cor-dons téléphoniques). Il
est également conseillé d’enlever la batterie afin d'éviter d’allu-
mer I'ap-pareil par mégarde.

1. Eteignez l'ordinateur, retournez-le et retirez la batterie.

2. Repérez le couvercle de la carte SIM et desserrez la vis o
dans la Figure 12.

3. Retirez le couvercle @) dans la Figure 12.
Insérez la carte USIM comme vous le feriez dans votre
téléphone mobile.

5. Faites coulisser le SIMLOCK vers la charniére (dans la
direction opposée a celle de la fleche illustrée dans la Figure
13) afin de libérer le verrouillage et le soulever.

Guide Utilisateur Concis

Figure 12 - Retirer le couvercle de la carte SIM

6. Insérez la carte SIM comme illustré dans (Figure 13) et
fermez le SIMLOCK.

7. Verrouillez le SIMLOCK en appuyant sur celui-ci dans la
direction de la fleche dans la Figure 13 jusqu'a ce gqu'elle se
mette en position verrouillée en émettant un clic.

8. Replacez le couvercle, la vis et la batterie.
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Figure 13 - Insérez la carte USIM & verrouillez le
SIMLOCK
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Application 3G Watcher

Le module 3.5G et la carte USIM (fournie par votre four-
nisseur de service) étant installés vous pouvez alors installer
I'application 3G Watcher. L'application 3G Watcher vous
permet d'accéder directement a votre service internet 3.5G
depuis I'ordinateur.

Installation de I'application 3G Watcher

1. Assurez-vous que vous avez activé I'alimenation du
module en appuyant sur la combinaison de touches Fn +

" (I'indicateur visuel ;< a I'écran, indiquera I'état
d'alimentation du module).

2. SiI’assistant Nouveau matériel détecté apparait, cliquez
sur Annuler.

3. Cliquez sur Option Drivers (bouton).

4. Cliquez sur 2.Install 3G Driver > Oui.

5. Cliquez sur Suivant.

6. Cliquez sur le bouton J’accepte les termes de ce contrat
de licence, puis cliquez sur Installer.

7. Quand I'écran suivant apparait patientez environ 2
minutes avant de cliquer sur Terminer (pour permettre
au matériel de détecter le module 3.5G).

8. L'icobne 3G Watcher ﬁ apparait sur le bureau.

9. Vous pouvez accéder a I’application 3G Watcher depuis
le menu Démarrer (Démarrer > Programmes/Tous les

rogrammes > 3G Watcher), ou en cliquant sur I'icone
& dans la barre des taches.

Installer un profil de porteuse

Bien que les informations de connexion soient stockées sur
la carte USIM fournie par le fournisseur de service, vous de-
vrez installer le profil de porteuse approprié a lI'aide du logi-
ciel 3G Watcher.

1. Utilisez la combinaison de touches Fn + |
module 3.5G.

2. Vous pouvez accéder a I'application 3G Watcher depuis le
menu Démarrer (Démarrer > Programmes/Tous les
programmes > 3G Watcher), ou en cliquant sur l'icbne
dans la barre des taches.

pour allumer le

3. Cliquez sur Outils et sélectionnez Options.

4. Cliquez sur Profils et puis sur Ajouter un profil ‘;i’ (bouton)
et sélectionnez Profil d’accés distant. -

ED o

Figure 14 - Ajouter un profil WWAN
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Vous pouvez ensuite entrer un nouveau nom de profil ou
choisir un profil dans la liste déroulante fournie par le logiciel.

Cliguez sur Appliquer > OK pour enregistrer les informations.

Vous pouvez choisir le profil dans le menu déroulant.

i <
o N
- Crinaeble__ S\
M - China Mobile
/WM - Chung 'wa Telecom

WM - Far Eas Tone
SIEARA WIRELEES

Détails du profil

Si vous avez choisi le profil dans la liste déroulante alors la
plupart des informations dans les onglets Général et Avancé
devraient étre automatiquement remplies pour vous (cepen-
dant consultez votre fournisseur de service pour les derniéres
informations car vous aurez besoin d'ajouter au moins votre
Nom d'utilisateur et votre Mot de passe).

Figure 15 - Options de l'utilisateur et choix du profil

Guide Utilisateur Concis

Connexion au fournisseur d'acces

1.

2.

Utilisez la combinaison de touches Fn +

le module 3.5G.

Vous pouvez acceder a I’application 3G Watcher depuis

le menu Démarrer (Démarrer > Programmes/Tous les
rogrammes > 3G Watcher), ou en cliquant sur I'icne
§ dans la barre des taches.

i1 pour allumer

Le logiciel s'exécutera et affichera le nom du fournisseur
de service (les informations de connexion sont obtenues
depuis la carte USIM).

Figure 16
3G Watcher

d
Cliquez sur Se connecter pour démarrer le processus de
connexion.
L'application 3G Watcher affichera alors les informations
de connexion dans la fenétre.
Quand la connexion est réussi une notification apparaitra
dans la barre des tches (comme ci-dessous).

S 3G Watcher |

-
“ Connecte a Far Eas

Figure 17
Notification de con-
nexion de labarre des
taches

SEnHL WnnsLEss

Wil (3 45 14:40
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Guide Utilisateur Concis

10.
11.

12.

13.

14.

Vous pouvez accéder a Internet, télécharger des e-mails
etc. comme toute connexion Internet.

Quand vous étes connecté I'icdne de la barre des taches est
verte m (elle devient rouge i quand le programme est
en cours d'exécution mais non connecté).

Pour déconnecter cliquez sur I'icobne Déconnecter.

Le programme se déconnectera du fournisseur de service.
Le module sera toujours allumé, et vous devrez appuyer
sur la combinaison de touches Fn +

Si vous cliquez sur I'icone [ de fermeture de 3G Watcher
un message s'affichera vous demandant de cliquer sur OK
pour confirmer de quitter le programme.

fomtmimment =

A

Vous aver demandé & uitter e 3G Watther.

Figure 18
Avertissement pour
Quitter

Me phus afficher Ge message

%
i

o=
w
I
|V
o
g
S

o Aevnier

Le fait de quitter le programme N'ETEINT PAS le module
3.5G, et vous devrez appuyer sur la combinaison de
touches Fn + . pour éteindre le module (faites trés
attention a cela a bord d'un avion - reportez-vous a
“Utilisation des appareils sans fil a bord d'un avion” a la
page 90).

Si le module est allumé et que I'ordinateur entre en état
d'économie d'énergie, alors I'état d'alimentation du module

reprenant a partir de I'état d'‘économie d'énergie sera
comme indiqué au verso.

« Si le module 3.5G est allumé et que I'ordinateur est
Eteint/et que vous Redémarrez I'ordinateur; le module
sera éteint au démarrage de I'ordinateur.

« Si le module 3.5G est allumé et que I'ordinateur entre en
Veille/\eille prolongée; le module sera éteint quand
I'ordinateur sortira de la veille.

Service de messagerie court

En plus des services internet traditionnels, vous pouvez aus-
si envoyer et recevoir des messages texte SMS a l'aide du
programme 3G Watcher.

1.

L'indicateur &8 de message SMS dans la fenétre princi-
pale vous informera de la réception des nouveaux messa-
ges.

Double-cliquez sur I'icone & ou sélectionnez Outils >
SMS Express....

Sélectionnez le dossier de boite de réception et
sélectionnez un message pour le lire, ou sélectionnez
Fichier > Nouveau message eléctronique ou cliquez sur
le bouton Nouveau pour préparer un nouveau message.

Pour plus de détails sur SMS voir l'aide en ligne de 3G

Watcher dans le menu Aide > Rubriques d'aide.
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Module LAN sans fil
4

Actionner I'alimentation pour le module LAN sans fil

Allumer le module LAN sans fil a I'aide de la combinaison de
touches (Fn + F11). Quand le module LAN sans fil est sous
tension, la LED (i) sera vert et lindicateur visuel , ¥ a
I'écran s'affichera brievement.

Installation du pilote du LAN sans fil

Assurez-vous que le module est allumé.

Cliquez sur Option Drivers (bouton).

Cliquez sur 3.Install Wireless Lan Driver > Oui.
Cliquez sur Suivant > Suivant.

Cliquez sur le bouton J’accepte les termes de ce contrat
de licence, puis cliquez sur Suivant.

6. Cliquez sur Suivant > Suivant > Terminer.

apswn e

Remarque: Le systeme d'exploitation est le paramétre par dé-
faut pour le contréle LAN sans fil dans Windows Vista.

Guide Utilisateur Concis

Se connecter a un réseau sans fil
Assurez-vous que le module LAN sans fil est allumé.

1.

e

Cliquez sur l'icobne de WLAN dans la barre des taches, et
puis cliquez sur Connexion a un réseau (ou cliquez avec le
bouton droit de la souris sur l'icbne , et puis cliquez sur
Connexion & un réseau).

Dans la liste Afficher, cliguez pour choisir Sans fil dans le
menu déroulant.

Une liste des réseaux actuellement disponibles apparaitra.
Cliquez sur un réseau, et cliquez ensuite sur Connecter.

Si vous ne voyez pas de réseau auquel vous voulez vous
connecter, cliquez sur Configurer une connexion ou un
réseau (une liste d'options apparaitra permettant une
recherche manuelle, et créant un nouveau réseau).

Déplacez le curseur sur l'icbne E de la barre des taches pour
voir I'état de la connexion.

Pour vous déconnecter du réseau sans fil, vous pouvez
cliquer sur l'icdne E sans fil de la barre des taches, et
sélectionner ensuite Se connecter ou se déconnecter pour
accéder au menu réseau, et cliquez sur Déconnecter (ou
cliquez avec le bouton droit de la souris sur l'icone [Bd, et puis
cliquez sur Déconnexion de).

I
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Module de mémoire Intel Turbo
4

Support du port eSATA

Remarquez que le pilote d'Intel Matrix Storage est requis
pour activer le port eSATA méme si vous n'avez pas inclus
de module de mémaoire Intel Turbo dans votre configuration
d'achat.

Suivez les instructions fournies ici pour installer le pilote.

Si votre option d'achat comporte un module de mémoire In-
tel Turbo (Robson), vous devrez alors installer le pilote con-
formément aux instructions ci-dessous (n'installez pas ce
pilote sous Windows XP).

La technologie Intel Turbo Memory (aussi appelée Rob-
son flash memory) est une technologie Intel réduisant le
temps nécessaire a un ordinateur pour démarrer, charger des
applications, et écrire des données sur le disque dur. La
technologie Intel Turbo Memory est supportée dans Win-
dows Vista seulement (elle supporte aussi les fonctionnali-
tés de Windows Vista telles que ReadyBoost, ReadyDrive,
et Superfetch).

Configuration d'Intel Turbo Memory &

Matrix Storage et installation du pilote

1. Allumez I’ordinateur et appuyez sur F2 pour aller dans le
BIOS.

2. Allez au menu Advanced, sélectionnez "Installed O/S" et
assurez-vous que "Vista" est I'option sélectionnée.

3. Allez a I'élément "SATA Mode Selection” (Sélection du
mode SATA) et assurez-vous que "AHCI" est sélectionne.

4. Sélectionnez Exit Saving Changes du menu Exit (ou
appuyez sur F10, sélectionnez “Yes” et puis appuyez sur
Entrée) et appuyez sur Entrée pour sortir du BIOS et
démarrer l'ordinateur.

5. Insérez le disque Device Drivers & Utilities + User’s

Manual dans le lecteur de CD/DVD.

Cliquez sur Option Drivers (bouton).

Cliquez sur 4.Install TM&iMSM Driver > Oui.

Cliquez sur Next > Yes > Next > Next.

Cliquez sur Finish pour redémarrer votre ordinateur.

© N

TN ===« Windows ReadyBoost - utilise

@ o— la mémoire flash comme solu-

= tion de cache de disque dur.

« Windows ReadyDrive - utilise
des lecteurs hybrides comme
solution de cache de disque dur.

Figure 19 - Intel Turbo Memory Console
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Lecteur d'empreintes digitales

Si votre option d'achat comporte un lecteur d'empreintes di- e
gitales vous devrez installer le pilote en vous reportant aux Aide & Manuel
instructions ci-dessous. Faites un clic droit sur l'icone [ de la barre des taches pour
faire apparaitre le menu afin de sélectionner Aide.

Ver_lflez que vous avez les droits d'administrateur sur votre Insérez le disque Device Drivers & Utilities + User's Manual

ordinateur, et que vous avez un mot de passe Windows et cliquez sur Option Drivers (bouton). Cliquez sur Unlock

activé pour une protection totale. (bouton) et puis cliquez sur 5.Install FingerPrint Driver >
Oui.

Avant de commencer le Processus d'enregi_Streme_nta il est Cliquez sur Documentation pour ouvrir le dossier conte-

recommandé de prendre connaissance du didacticiel d'em- nant le manuel au format .pdf.

preintes digitales. Pour lancer le didacticiel cliquez sur Dé- bour installer le loaiciel Adobe Acrobat Read e lo f
our installer le logicie obe Acrobat Reader pour lire le Ti-
marrer > Programmes/Tous les programmes > chier, insérez le disque Device Drivers & Utilities + User's

Protector Suite QL > Didacticiel de Fingerprint. Manual et cliquez sur User's Manual (bouton), et cliquez sur
Install Acrobat Reader (bouton).

I
)
S
O
Q.
o

Installation du pilote du lecteur d'em-

preintes digitales

1. Insérez le disque Device Drivers & Utilities + User’s
Manual dans le lecteur de CD/DVD.

Enregistrement de l'utilisateur

1. Cliquez sur Démarrer > Programmes/Tous les program-
mes > Protector Suite QL > Enregistrement d’utilisateurs,

2. Cliquez sur Option Drivers (bouton). ou double-cliquez sur l'icone E‘ dans la barre des taches.

3. Cliquez sur 5.Install FingerPrint Driver > Oui. 2. Lors du premier lancement du programme, vous serez invité a
4. Cliquez sur Installation du logiciel. cliquer sur le bouton pour accepter la licence, et cliquer

5. Cliquez sur Suivant > Suivant > Suivant. ensuite sur OK.

6. Cliquez sur Terminer > Qui pour terminer l'installation. 3. Cliquez sur Suivant (“Enregistrement sur le disque dur”

sera automatiquement sélectionné) et cliquez sur Oui.

.|
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11.
12.

13.
14.
15.

Si vous n'avez pas défini de mot de passe de Windows vous
serez invité a le faire (remarque: Si vous n'avez pas défini de
mot de passe, Protector Suite QL ne peut pas sécuriser
I'accés a votre ordinateur).

Cliquez sur Suivant et vous serez invité & entrer votre mot de
passe de Windows.

Cliguez sur Suivant > Suivant (cochez la case a cocher
“Lancer le didacticiel interactif” pour prendre connaissance
du didacticiel Fingerprint).

Cliguez sur Suivant pour chaque fenétre du didacticiel (vous
pouvez cliquer sur le bouton “Passer le didacticiel” a tout
moment).

Cliquez sur le bouton au-dessus I'un des doigts pour lancer
I'enregistrement de ce doigt.

Tapez trois fois le doigt pour enregistrer ce doigt.

. Répétez le processus pour tous les doigts que vous voulez

enregistrer, puis cliquez sur Suivant.

Cliquez sur Terminer.

Cliquez sur I'un des en-tétes “En savoir plus sur” pour
obtenir plus d'informations sur tous les sujets.

Cliquez sur Fermer.

Redémarrez I'ordinateur.

Faites un clic droit sur l'icone E| de la barre des taches pour
faire apparaitre le menu vous permettant d'Modifier les
empreintes digitales, Lancer le Centre de contrdle, accéder
au menu Aide etc. Vous pouvez aussi exécuter le Centre de
contrdle etc. a partir de I'élément Protector Suite QL dans le
menu Démarrer > Programmes/Tous les programmes.

16.

17.

18.

Reportez-vous a “Aide & Manuel” a la page 123 pour plus
de détails.
Si vous passez votre doigt sur le lecteur, a tout moment, vous
pouvez accéder au Biomenu pour Verrouiller I'ordinateur,
Enregistrer des sites web, Déverrouiller Mon coffre, ouvrir
le Centre de contrble et accéder au menu Aide.
Le Centre de contrdle vous permet de modifier les
Paramétres, enregistrement d'empreintes numériques et
d'obtenir de I'Aide.

I Pretecter Sute Softman =

Gestion de Fingerprint Software

- @®a
= Empraintes digitales il
Enregistror ou modifior kes moddles d'empremies digtales do
Tutlisatour octuei
= Paramétres
Configurer fingorprnt sofftware.
@ Aide
Obbane ks informaons o ade
* Introdaction
@ Dvdachciel

&

0 Cotroyer bes priviléges dadministrateur & Mutiisateisr
Quand doincie tamy o0 T

L
Z S

Enregistrement de I'empreinte digitalet

Il est fortement recommandé d'enregistrer plus d'un doigt
en cas de blessure etc.

Figure 20 - Centre de contrél & Biomenu
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Configuration Bluetooth — -
Configurez votre périphérique Blue- Z
. . Transfert de données
tooth afin que votre ordinateur le trouve Bluetooth
1. Allumez votre périphérique Bluetooth (ex. PDA, téléphone Remarquez que le trans-
mobile etc.). fert de données entre l'or-
2. Rendez le périphérique détectable (pour cela consultez la —T— dinateur et Ui
documentation de votre périphérique). périphérique Bluetooth est
Ajouter un périphérique Bluetooth pris en charge dans une
Afficher les périphériques Bluetooth direction seulement (Ie
Allumer le module Bluetooth SR transfert simultané de T
3 BN . RECevhir o Fchiat données n'est pas pris -
1. Activez le module Bluetooth a I'aide de Fn + F12. en charge). Q
2. Une icone 3 Bluetooth apparaitra sur la barre des taches S e s i 3
(vous devrez peut-étre activer l'option a partir du panneau de e Q)
contrble des périphériques Bluetooth). Supprimer lcone Blugtooth Iy
3. Vous pouvez alors procéder comme suit pour accéder au d
panneau de contréle des périphériques Bluetooth. Figure 21 - Périphériques Bluetooth et cliquer sur le Menu
d'icbne

* Double-cliquez sur I'icdne g pour accéder au panneau de

contrdle des périphériques Bluetooth. . L. L.
« Cliquez sur le menu Démarrer et cliquez sur Panneau de ~ Ajouter un périphérique Bluetooth

configuration (ou pointez sur Parameétres et cliquez sur 1. Accédez au panneau de contréle des périphériques Bluetooth.
Panneau de configuration), et puis cliquez sur Périphéri- 2. Cliquez sur Options (onglet), et assurez-vous que la case &
ques Bluetooth (Matériel et audio). cocher Autoriser les périphériques Bluetooth a se
« Cliquez/Cliquez avec le bouton droit de la souris sur connecter a cet ordinateur (Connexions) est cochée.
I'icbne 3 et sélectionnez une option dans le menu. 3. Cliquez sur Périphériques (onglet), et puis cliquez sur
Ajouter.

.|
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4. L'Assistant Ajout de périphérique Bluetooth apparait.

5. Cliguez pour choisir “Mon périphérique est configuré et
prét a étre détecté.”, et puis cliquez sur Suivant.

Sttt ot 84 gyt Bt =} Attpd dpint de pirphirns Blementh )

g It rnae () 8 i Awwintant Ajout de peripherique
Blustooth

o . ; b e

i o .

- §

Al e T

B 3 s oo pern e s s

Figure 22 - Assistant Ajout de périphérique Bluetooth

6. L'Assistant recherchera alors tous les périphériques
Bluetooth disponibles a portée.

7. Sélectionnez le périphérique avec lequel vous souhaitez
communiquer et cliguez sur Suivant.

8. Sélectionnez une option de clé de sécurité appropriée et
cliquez sur Suivant > Terminer.

Acsatent Ly dt prpharins Bustocth Es
L R e e TR 8

Figure 23 - Option de clé de sécurité

Changer les parametres du périphéri-
gue Bluetooth

1. Accédez au panneau de controle des périphériques Bluetooth.
2. Cliquez sur le périphérique que vous voulez modifier et
cliqguez sur Propriétés pour:
e Changer le nom du périphérique (cliquez sur Général,
tapez un nouveau nom et cliquez sur OK).
« Activer/Désactiver un service (cliquez sur Services,
cochez/décochez la case a cocher proche du service et cli-
quez sur OK).

Pour rendre votre ordinateur détectable

aux périphériques Bluetooth
1. Accédez au panneau de contrble des périphériques Bluetooth.

2. Cliquez sur Options (onglet), et assurez-vous que la case a
cocher Autoriser les périphériques Bluetooth arechercher
cet ordinateur (Découverte) est cochée.

3. Assurez-vous que la case a cocher M'avertir lorsqu’un
nouveau périphérique Bluetooth souhaite se connecter
(Connexions) est cochée, si vous voulez étre averti quand un
périphérique Bluetooth veut se connecter.

Figure 24
Périphériques
Bluetooth -
Options
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Probleme

Cause possible - résolution

Les modules LAN sans fil/
Bluetooth ne peuvent pas étre
détectés.

Le(s) module(s) est (sont) désactivé(s). Vérifiez lindicateur LED (i) pour voir si le(s) module(s)
est (sont) activé(s) ou désactivé(s). Si l'indicateur LED est désactivé, alors appuyez sur la (les)
combinaison(s) de touches Fn + F11 (WLAN) ou Fn + F12 (Bluetooth) key combination(s) pour
activer le(s) module(s) (voir le Tableau 4 a la page 101).

Le module Bluetooth est
désactivé aprés la reprise
depuis Veille.

L'état par défaut du module Bluetooth sera désactivé aprés la reprise a partir de I'état Economie
d'énergie de veille. Utilisez la combinaison de touches (Fn + F12) pour activer le module Bluetooth
qguand l'ordinateur reprend a partir de I'état de Veille.

Un fichier ne peut étre copié
sur/depuis un périphérique
Bluetooth connecté.

Le transfert de données entre I'ordinateur et un périphérique Bluetooth est pris en charge dans
une direction seulement (le transfert simultané de données n'est pas pris en charge). Si
vous copiez un fichier depuis votre ordinateur sur un périphérique Bluetooth, vous ne pourrez pas
copier un fichier a partir d'un périphérique Bluetooth sur votre ordinateur tant que le transfert de
fichier depuis l'ordinateur ne sera pas terminé.

Les fichiers vidéo capturés
depuis la Caméra PC prennent
trop de place sur le disque.

Notez que la capture de fichiers vidéo a haute résolution nécessite un espace substantiel sur le
disque pour chaque fichier. Reportez-vous a “Réduire la taille des fichiers vidéo” a la
page 116.

Aucun son audible a via un
périphérique d'affichage
connecté par HDMI.

Vous n'avez pas configuré la sortie audio HDMI. Reportez-vous a “ Configuration audio HDMI” &
la page 108.

.|
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Guide Utilisateur Concis

Spécifications

4

Dernieres informations de spécification

Les spécifications énumérées dans cet Appendice sont correctes a I'heure de la mise sous presse. Certains éléments (parti-
culierement les types de processeur/vitesse unique) peuvent étre modifi€és ou mis a niveau en fonction du calendrier des pa-

rutions du fabricant. Voyez auprés de votre service clientéle pour les détails.

Caractéristique Spécification

Types de Processeur Intel Core 2 Duo (45nm) Procédé de gravure en 45 nm

processeurs Micro-FCPGA package (478-broches), 35W Cache L2 6Mo & Bus principal & 1066MHz
T9400/ T9600 2,563/ 2,8 GHz
Processeur Intel Core 2 Duo (45nm) Procédé de gravure en 45 nm
Micro-FCPGA package (478-broches), 25W Cache L2 6Mo & Bus principal & 1066MHz
P9500 2,53 GHz
Processeur Intel Core 2 Duo (45nm) Procédé de gravure en 45 nm
Micro-FCPGA package (478-broches), 25W Cache L2 3Mo & Bus principal & 1066MHz
P8400/ P8600 2,26/ 2,4 GHz

Core logic Modéles A & B Modéles C & D
Chipset Intel GM45 + ICH9M Chipset Intel PM45 + ICHOM
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Caractéristique Spécification
Options d’écrans Modeles A & C Modeéles B & D
LCD 14,1" - WXGA/ WXGA+ Type Ecran Plat TFT Reflet | 15,4" - WXGA/ WXGA+/ WSXGA+ Type Ecran Plat
TFT Reflet
Affichage Modéles A & B Modéles C & D
Vidéo intégrée Intel GM45 (Interne sur puce) Vidéo discréte NVIDIA GeForce 9300M GS
Accélérateur graphique 2D/3D de haute (Externe sur carte)
performance RAM Vidéo interne GDDR2 256Mo
Architecture de mémoire partagée (jusqu'a TurboCache™ supportant la mémoire
256Mo de mémoire vidéo partagée attribuée graphique totale jusqu'a 512Mo (selon la
dynamiquement a partir de la mémoire systeme mémoire systéme) I'
guand nécessaire) Prend totalement en charge DirectX® 10.0 &y
Prend totalement en charge DirectX® 10.0 3
Mémoire Deux emplacement SODIMM, supportant la mémoire DDRII 667/800 %
Mémoire extensible jusqu’a 4Go
Sécurité Fente de verrouillage de sécurité (type Kensington) Mot de Passe du BIOS
Lecteur d'empreintes digitales (Option d’usine)
BIOS Phoenix BIOS (SPI Flash ROM de 32Mb) Phoenix™ BIOS
Stockage de Un lecteur de type unité optique SATA (CD/DVD) 12,7mm(h) remplagable (reportez-vous a “Options” a
données la page 132 pour les options de lecteur)
Une disque dur SATA facilement échangeable de 2,5" 9,5 mm (H)
Son Interface conforme Intel HDA (Son Haute Définition)  Sortie numérique S/PDIF
Systeme sonore stéréo 3D amélioré 2 haut-parleurs intégrés
Compatible avec Sound-Blaster PRO™ Microphone intégré
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Caractéristique Spécification
Clavier Clavier “Win Key”
Dispositif de TouchPad intégré (avec fonction de défilement)
pointage
Lecteur de carte Lecteur de carte 7-en-1 (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)
Remarque: Cartes MS Duo/ Mini SD/ RS MMC nécessitent un PC adaptateur
Interface Trois ports USB 2.0 Un port eSATA
Un port de Sortie HDMI (High-Definition Multimedia eSATA supporté dans Windows Vista
Interface) (supporte canal 5.1) avec sortie audio seulement:
i) Une prise de sortie haut-parleurs/casque Le mode AHCI supporte le remplacement a
8,, Une prise d'entrée de microphone chaud
C Une prise de sortie S/PDIF Le mode IDE ne supporte pas le changement a
© chaud
| -
LL

Une prise RJ-11 pour modem
Une prise RJ-45 pour réseau
Une prise d’entrée en CC
Un port moniteur externe

Logement Logement d'ExpressCard/54(34)

d'ExpressCard

Logements Mini- Un logement Mini-carte pour module WLAN

carte Un logement Mini-carte pour module mémoire turbo Intel ou module 3.5G
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Caractéristique Spécification
Communication 56K Plug & Play Fax/Modem (conforme V.90 & V.92)
1Gbit réseau Ethernet PCI-E intégré s
. _ RS
Options du module LAN sans fil :
Module Mini-carte LAN sans fil Intel® WiFi Link 5300 (802.11 a/g/n) Modes UMTS
Module Mini-carte LAN sans fil Intel® WiFi Link 5100 (802.11 a/g/n) Remarquez que les mo-
des UMTS NE PEUVENT
1,3M ou 2,0M pixel caméra PC USB (Option d’usine) PAS étre utilisés en Amé-

Module Bluetooth 2.0 + EDR USB (Option d’usine) rique du Nord.
Module 3.5G basé sur UMTS/HSPDA avec Mini interface de carte

(Option d’'usine) II
Quad-band GSM/GPRS (850 MHz, 900 MHz, 1800 MHz, 1900 MHz) %
UMTS WCDMA FDD (2100 MHz) WO
Gestion de Supporte ACPI v3.0 %
I'alimentation
Mise en marche Modeéles A & B Modeéles C & D
Adaptateur CA/CC pleine bande Adaptateur CA/CC pleine bande
Entrée c.a.: 100-240V, 50-60Hz Entrée c.a.: 100-240V, 50-60Hz
Sortie c.c.: 19V, 3,42A Ou 18,5V, 3,5A (65W) Sortie c.c.: 19V, 4,74A (90W)

Batterie Smart Lithium-lon a 6 éléments, 4000mAH Ou 4400mAH
Batterie Smart Lithium-lon a 9 éléments, 7200mAH (Option)

Spécifications Température Humidité relative
environnementales En fonction : 5°C- 35°C En fonction : 20% - 80%
Eteint : -20°C - 60°C Eteint : 10% - 90%
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Caractéristique Spécification

Dimensions Modéles A & C Modeles B & D

physiques & Poids 336 (1) x 250 (p) x 24,8 - 35,7 (h) mm 359 (1) x 268 (p) x 24,8 - 37 (h) mm
2,3 kg avec batterie & 6 éléments 2,6 kg avec batterie & 6 éléments

Options Options de module de lecteur optigue : Module de mémoire Intel Turbo (Robson) - 2Go
Module de lecteur Combo SATA ou

Module de lecteur DVD-Dual (Super Multi) SATA Module 3.5G basé sur UMTS/HSPDA avec Mini
interface de carte (Option d’'usine)

Quad-band GSM/GPRS (850 MHz, 900 MHz,
1800 MHz, 1900 MHz)

Options du module LAN sans fil :
Module Mini-carte LAN sans fil Intel® WiFi Link

2 5300 (802.11 a/g/n) UMTS WCDMA FDD (2100 MH

‘< Module Mini-carte LAN sans fil Intel® WiFi Link ( 2)

On 5100 (802.11 a/g/n)

c . - S 0 A4 SNE

@® Batterie Smart Lithium-lon & 9 éléments, 7200mAH ﬂ:

| -

L 1,3M ou 2,0M pixel caméra PC USB (Option Modes UMTS
d'usine) Remarquez que les modes UMTS NE PEUVENT
Lecteur d'empreintes digitales (Option d’usine) PAS étre utilisés en Amérique du Nord.
Module Bluetooth 2.0 + EDR USB (Option
d’usine)
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AViso

La compafiia se reserva el derecho a revisar esta publicacion o cambiar su contenido sin previo aviso. La informacion
contenida aqui sirve sélo como referencia y no constituye ninguna obligacion por parte del fabricante o cualquier vendedor.
No se asume responsabilidad o compromiso por cualquier error o inexactitud que pueda aparecer en esta publicacion ni nos
hacemos responsables de cualquier pérdida o dafio como resultado del uso (0 mal uso) de esta publicacion.

Esta publicacion y cualquier software que la acomparie no puede, en parte o en su totalidad, ser reproducida, traducida,
transmitida o reducida a cualquier forma legible sin el previo consentimiento del vendedor, fabricante o creadores de esta
publicacion, excepto para copias de seguridad guardadas por el propio usuario.

Los nombres de productos y marcas mencionados en esta publicacidn pueden ser 0 no marcas con derechos de copia y/o
marcas registradas de sus respectivas compafiias. Se mencionan aqui sélo para propdsitos de identificacion y no como
apoyo a ese producto o su fabricante.

© Mayo de 2008

Marcas registradas

Este producto incorpora tecnologia de proteccidn de derechos de autor amparada por las exigencias de ciertas patentes de
EE.UU. y otros derechos de propiedad intelectual pertenecientes a Macrovision Corporation y otros propietarios de
derechos. El uso de esta tecnologia de proteccidn de derechos de copia debe ser autorizado por Macrovision Corporation
y esta limitado a uso exclusivo doméstico u otros usos de visualizacién limitados a menos que exista autorizacién previa
de Macrovision Corporation. Quedan prohibidas las modificaciones o el desmontaje.

Intel e Intel Core son marcas/marcas registradas de Intel Corporation.
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Acerca de esta Guia del Usuario Concisa

Esta guia rapida es una breve introduccién para poner su sistema en funcionamiento. Es un suplemento y no un sustituto
del Manual del usuario completo en inglés en formato Adobe Acrobat del disco Device Drivers & Utilities + User's Manual
suministrado con el ordenador. En este disco también se encuentran los controladores y utilitarios necesarios para utilizar
el ordenador correctamente.

Algunas o todas las caracteristicas del ordenador pueden haberse configurado de antemano. Si no lo estan, o si desea
reconfigurar (o reinstalar) partes del sistema, consulte el Manual del usuario completo. El disco Device Drivers & Utilities
+ User’s Manual no contiene un sistema operativo.

Informacién de regulacion

Las notas de regulacion e informacidn estan contenidas en el Manual del usuario completo en el disco Device Drivers &
Utilities + User’s Manual.

AN
I

Uso de dispositivos inalambricos a bordo de un avién

Normalmente se prohibe el uso de cualquier dispositivo de transmision electronica a bordo de
un avion. Compruebe que los médulos inalambricos estén DESCONECTADOS si va a
utilizar el ordenador en el avion.
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Instrucciones para el cuidado y funcionamiento

El ordenador portatil es muy robusto, pero puede dafarse. Para evitar esto, siga estas sugerencias:

Servicio

No intente arreglar el ordenador por su cuenta. Si lo hace, puede violar la garantia y exponerse usted y el ordenador a
descarga eléctrica. Encargue las reparaciones a personal técnico autorizado. Desenchufe el ordenador de la fuente de
alimentacién. Encargue las reparaciones a personal cualificado en los siguientes casos:

No lo deje caer ni lo exponga a golpes fuertes. Si el ordenador se cae, la carcasa y los componentes podrian dafiarse.
Manténgalo seco y no lo sobrecaliente. Mantenga el ordenador y fuente de alimentacidn alejados de cualquier tipo
de fuente de calor. Esto es un aparato eléctrico. Si se derrama agua u otro liquido en su interior, el ordenador podria
dafiarse seriamente.

Evite las interferencias. Mantenga el ordenador alejado de transformadores de alta capacidad, motores eléctricos y
otros campos magnéticos fuertes. Estos pueden dificultar el correcto funcionamiento y dafiar los datos.

Siga las instrucciones apropiadas de manejo del ordenador. Apague el ordenador correctamente y no olvide
guardar su trabajo. Recuerde guardar periédicamente sus datos, pues los datos pueden perderse si la bateria se
descarga.

Tenga cuidado cuando utilice dispositivos periféricos.

Cuando el cable de alimentacion esté dafiado o pelado.

Si el ordenador ha estado expuesto a la lluvia u otros liquidos.

Si el ordenador no funciona con normalidad tras seguir las instrucciones de uso.

Si el ordenador se ha caido o dafiado (no toque el liquido venenoso si el panel LCD se rompe).
Si hay un olor fuera de lo normal, calor o humo que sale del ordenador.
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Seguridad sobre la alimentacion
El ordenador tiene unos requisitos de alimentacion especificos:

» Utilice solamente un adaptador de alimentacion aprobado para su uso con este ordenador.

» Su adaptador de CA/CC puede estar disefiado para viajes internacionales, pero puede que necesite una fuente de alimentacion
continuada. Si no esta seguro de las especificaciones de alimentacion locales, consulte con el servicio de asistencia o compafiia de
electricidad del lugar.

» Eladaptador de alimentacion puede tener un enchufe de 2 dientes o un enchufe con tierra de 3 dientes. El tercer diente es una caracteristica
de seguridad; no lo elimine. Si no tiene acceso a un enchufe de pared compatible, haga que un electricista cualificado instale uno.

» Cuando desee desenchufar el cable de alimentacidn, asegUrese de desconectarlo por la cabeza del enchufe, no por su cable.

« Compruebe que la toma y cualquier alargadera que utilice puedan soportar la carga de corriente total de todos los dispositivos
conectados.

« Antes de limpiar el ordenador, asegurese de que esté desconectado de cualquier fuente de alimentacién externa.

G
s
Aviso de seguridad sobre la corriente

Antes de llevar a cabo cualquier procedimiento de actualizacion, asegurese de haber apagado la alimentacion y desconectado todos
los periféricos y cables (incluyendo las lineas telefonicas). También es aconsejable quitar su bateria para evitar que la maquina se
encienda por accidente.

Apéaguelo antes de viajar

Compruebe que su portatil esté completamente apagado antes de introducirlo en una bolsa de viaje (o en cualquier funda). Si introduce
un portatil encendido en una bolsa de viaje, puede que la(s) rejilla(s) se bloquee(n). Para evitar que el ordenador se sobrecaliente,
asegurese de que nada bloguea la(s) rejilla(s) con el ordenador encendido.

Limpieza
* No aplique limpiador directamente en el ordenador, utilice un trapo suave y limpio.
* No utilice limpiadores volatiles (derivados del petr6leo) o limpiadores abrasivos en ningtn lugar del ordenador.

.|
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Precauciones con la bateria

» Utilice solo baterias disefiadas para este ordenador. Una bateria inadecuada podria explotar, perder o dafar el equipo.

* Nunca utilice una bateria que se haya caido o que parezca dafiada (p. ej. doblada o retorcida). Incluso si el ordenador
sigue funcionando con una bateria dafiada, puede provocar dafios en el circuito que podrian causar fuego.

« Recargue la bateria con el sistema del ordenador. Una recarga incorrecta puede hacer que la bateria explote.

* No intente reparar baterias. Solicite la reparacion o la sustitucidn a su representante de servicio o a personal de
servicio cualificado.

» Mantenga las baterias dafiadas fuera del alcance de los nifios y deséchelas inmediatamente. La eliminacion de baterias
debe efectuarse con cuidado. Las baterias pueden explotar o perder si se exponen al fuego o si se manipulan o
desechan de manera inadecuada.

» Mantenga las baterias lejos de elementos metalicos.

» Cubra los contactos de la bateria con cinta adhesiva antes de desecharla.

» No toque los contactos de la bateria con las manos o con objetos metalicos.

\ L/
2§
Eliminacion de la bateria & Cuidado

El producto que usted ha comprado contiene una bateria recargable. La bateria es reciclable Terminada su vida util, segun las
leyes locales y estatales, puede ser ilegal desecharla junto con los residuos ordinarios. Verifiqgue con las autoridades locales
responsables de los desechos sélidos cuéles son las opciones de eliminacion y reciclado existentes en su zona.

Peligro de explosion si la bateria esta mal colocada. Sustitiyala con un tipo de bateria igual o equivalente al recomendado por
el fabricante. Elimine la bateria usada de conformidad con las instrucciones del fabricante.

.|
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Diferencias de modelos

Esta serie de portatiles incluye cuatro tipos de modelos distintos (cada modelo incluye estilos de disefio diferentes). La
apariencia externa exacta y algunos de los botones Hot-Key pueden diferir ligeramente de las ilustraciones en este manual,
sin embargo, todos los puertos, componentes, funciones, etc. son los mismos para cada estilo de disefio. Los modelos di-

fieren segun se indica en la siguiente tabla.

Caracteristica Modelo A Modelo B Modelo C Modelo D
Nucleo logic Intel(R) GM45 + ICHI9M Chipset Intel(R) PM45 + ICH9M Chipset
Adaptador de video Video Integrado Intel (Chip Interno) Video discreto NVIDIA (Externo Incorporado)
Adaptador de CA/CC 65W (Salida CC 19V, 3,42A 0 18,5V, 3,5A) 90W (Salida CC 19V, 4,74A)
. " 15,4" WXGA/ WXGA+/ ; 15,4" WXGA/ WXGA+/
Tipo de LCD 14,1" WXGA/ WXGA+ WSXGA+ 14,1" WXGA/ WXGA+ WSXGA+

Tabla 1 - Diferencias de modelos
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Guia rapida para empezar

P wnNhPR

Quite todos los materiales del embalaje.
Coloque el ordenador en una superficie estable.
Conecte en los puertos correspondientes los periféricos que desee utilizar con el ordenador portétil (p. ej. teclado y raton).

Conecte el adaptador de CA/CC al conector de entrada de CC que esta del lado izquierdo del ordenador, y luego conecte el cable
de alimentacion CA en un eschufe y al adaptador.

Utilice una mano para levantar con cuidado la tapa/LCD a un angulo de vision coémodo (no exceder 130 grados), mientras utiliza la
otra mano (como se muestra en la Figura 1 siguiente) para sostener la base del ordenador (Nota: Nunca levante el ordenador por
la tapa/LCD).

Presione el boton de encendido para “encender”.

Apagar

Por favor, tenga en cuenta que deberia siempre apagar el ordenador eligiendo la opcién Apagar desde el ment del
botén Bloguear en Windows Vista. Esto le ayudara a evitar problemas con el disco duro o el sistema.

Figura 1 - Abrir latapa/LCD/ordenador con el adaptador AC/DC enchufado
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Software de sistema Sistemas operativos suportados
P_uede ser que su ordenador Fenga mstalad_o un software de Sistema operativo Nota
sistema. Si no es el caso, o si desea reconfigurarlo con otro
sistema, este manual se refiere a Microsoft Windows Vista. . Para informaci6n sobre el SO Win-
. P hy . . Windows XP (Home ; .
Si desea mas informacion sobre cémo instalar controlado- Edition o Professional) dows XP consulte el disco Device
res y utilitarios consulte los capitulos 4 y 7 del Manual del Drivers & Utilities + User's Manual.
usuario completo, que se encuentra en el disco Device Dri- Aseglrese de haber instalado el Ser-
vers & Utilities + User’s Manual. vice Pack 1 para Windows Vista (o
una version de Windows Vista que
Windows Vista con | incluya el Service Pack 1), antes de
Service Pack 1 (64-bit) | instalar cualquier controlador.
4 Home Basic Editon/ | vaya al sitio web de Microsoft para
Controladores Home Premium Editon/ | descargar los detalles o contacte con
Business Editon/ su centro de servicios.
Si va a instalar o reinstalar un nuevo sistema, necesitara ins- Enterprise Editon/
talar los controladores apropiados. Los controladores son pro- Ultimate Editon Para ejecutar Windows Vista sin
gramas gue actllan como una interfaz entre el ordenador y un limitaciones ni menor rendimiento, su
componente hardware, p. ej. un médulo de red inalambrico. Es ordenador necesita un minimo de
muy importante que instale los controladores en el orden lista- 1GB de memoria del sistema (RAM).

do en la Tabla 5 en la pagina 155. No puede utilizar los con-
troles mas avanzados hasta que tenga instalados los
controladores y utilidades apropiadas. No incluido
Sistemas operativos (p. ej. Windows Vista/Windows XP)
tienen sus propios manuales, al igual que las aplicaciones
(p. €j. procesadores de texto, planillas de calculo y bases de
datos), por favor, consulte los manuales apropiados.

. |
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Mapa del sistema: Vista frontal con panel LCD

) Figura 2
abierto (MOdGlOS A & C) Vista frontal con panel
LCD abierto
_Il,_ (Modelos A & C)

Camara PC (opcional)
Panel LCD

Altavoces incorporados
Boton de encendido
Botones Hot-Key
Teclado

Micréfono incorporado
TouchPad (almohadilla
tactil) y botones

Lector de huellas

Uso de dispositivos
inalambricos a bordo

El uso de dispositivos electrénicos
portatiles a bordo de un avién
suele estar prohibido. Compruebe
gue los modulos inalambricos
estén DESCONECTADOS si va a
utilizar el ordenador en el avién.

© N O ®DNE

Utilice las combinaciones de teclas

©

para cambiar la alimentacion entre o -
los médulos WLAN/Bluetooth/3.5G digitales (opcional)

[any
o

y haga compruebe el icono . Indicadores LED

indicador de estado/barra de
tareas para ver si los modulos
estan encendidos o no (ver

Botones del TouchPad
(area valida de operacidn)
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Vista frontal con panel

©

[any
o

© N O WDNE

Figura 3

LCD abierto
(Modelos B & D)

Camara PC (opcional)
Panel LCD
Altavoces incorporados
Boton de encendido
Botones Hot-Key
Teclado
Micréfono incorporado
TouchPad (almohadilla
tactil) y botones
Lector de huellas
digitales (opcional)

. Indicadores LED

\ /
Botones del TouchPad

(area valida de operacion)

Mapa del sistema: Vista frontal con panel LCD
abierto (Modelos B & D)

3N

2 &
Uso de dispositivos
inalambricos a bordo

El uso de dispositivos electronicos
portatiles a bordo de un avién
suele estar prohibido. Compruebe
que los moédulos inalambricos
estén DESCONECTADOS si va a
utilizar el ordenador en el avién.

Utilice las combinaciones de teclas

para cambiar la alimentacion entre
los médulos WLAN/Bluetooth/3.5G

y haga compruebe el icono
indicador de estado/barra de
tareas para ver si los moédulos
estan encendidos o no (ver
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Indicadores LED

Los indicadores LED en su ordenador muestran una valiosa informacién sobre el estado actual del ordenador.

Tabla 2 - Indicadores LED de estado

Guia del Usuario Concisa

Icono | Color Descripcién Icono | Color Descripcion
Naranja | El adaptador de CA/CC esta conectado Naranja | La bateria se esta cargando
Verde El ordenador esta encendido Verde | La bateria estd completamente cargada
/LI) Verde m Naranja . -
. - | La bateria ha alcanzado el estado critico
parpa- El ordenador esta en modo Suspension parpa- | 4e poca energia
deante deante
[E] Verde El teclado numérico (NumLKk) esta acti- — Verde | El disco duro esta en uso
vado J
Verde El bloqueo de mayusculas esta activado Verde El modulo LAN Wireless (opcional) esta
activado
_ — () . _
ﬁl El bloqueo de desplazamiento esta acti- . El médulo Bluetooth (opcional) esta acti-
Verde vado Naranja vado
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Botones Hot-Key & teclado

Los botones Hot-Key ofrecen acceso instantdneo al  El teclado tiene un teclado numérico para una entrada facil
explorador de Internet y al programa de correo electronico  de datos numéricos. También incluye las teclas de funcion
predeterminado y le permiten activar o desactivar el Modo  para permitirle cambiar las caracteristicas operacionales al
silencio con una pulsacion de botén. instante (ver la Figura 4).

Figura 4 - Teclado

Tabla 3 - Botones Hot-Key

. SR Teclas de funcion el il a4
Botén Hot-Key Funcién W 2 o '
— Q
Activar el programa de correo electré- 2
nico predeterminado veauaes || |A (1S [1[D[1F [FlE@ [T []1J ‘ .
(@ Activar el buscador de Internet predeter- st A0 ) G A e 1 5 i e
inad - =
minado RS sar| W |f[~ bl
Cambiar Modo silencio* (para ahorro de
(@ bateria)
*Cuando se activa, el Modo silencio reduce el ruido del Caracteres especiales
ventilador y ahorra energia. Tenga en cuenta que esto puede - ,
. L. Algunas aplicaciones de software le permiten usar las teclas
reducir el rendimiento del ordenador. numeéricas con Alt para producir caracteres especiales. Es-

tos caracteres especiales s6lo pueden producirse utilizando
el teclado numérico. Las teclas numéricas normales (en la
fila superior del teclado) no funcionaran. Asegurese de que
el teclado numérico (NumLKk) esté activado.

144 - Botones Hot-Key & teclado
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Teclas de funcién & indicadores visuales

Las teclas de funcion (F1 - F12 etc.) actuaran como teclas directas (Hot-Key) cuando se pulsan junto con la tecla Fn.
Ademas de las combinaciones de teclas de funcion basicas los indicadores visuales estan disponibles cuando el controlador
de teclas directas (HotKey Driver) esta instalado (consulte “Hot-Key” en la pagina 157). Después de instalar el controlador
aparecera un icono &l en l1a barra de tareas.

Teclas Funcién/indicadores visuales Teclas Funcién/indicadores visuales
Fn+~ Reproducir/Pausar (en los programas Audio/Video) | Fn+ F8/F9 Rgducmon/Aumento
brillo LCD Moo
Activar/desactivar el | Activar/desactivar el : &
Fn+ moédulo 3.5G . O & ..G Fn+F10 moédulo Camara PC ’" “B’ & *ﬂ

Activar/desactivar el = p—— Activar/desactivar el ) (9
Fn+Fl TouchPad \” _‘\\Q_ Fn+F11 maédulo LAN Wireless | o ME‘E) ® m.“nl

Apagar luz de fondo del LCD

: - Activar/desactivar el
Fn+F2 | (presione una tecla o utilice el TouchPad para Fn+ F12 médulo Bluetooth ; . 2 .
encenderlo) i renersa T H
Fn+F3 Conmutacién mudo | o Fn + Activar/disactivar el teclado numérico (NumLKk)
NumLKk
Volume *  On Volume ¥ Mute
Fn+F4 Conmutacién dormir Fn + ScrLk | Cambia el bloqueo de desplazamiento
Fn + F5/ Reducci()n/Aumfsnto C_ambiar modo silen- e @ S @
F6 volumen de sonido 253 cio mode mode

Fn+F7 | Conmutacion pantalla Tabla 4 - Teclas de funcidon & indicadores visuales
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Mapa del sistema: Vistas frontal y izquierda

Partefrontal
1

Figura 5
Vistas frontal y izquier-
da

1. Indicadores LED

2. Conector de entrada de
CcC

3. Puerto para monitor

externo

Conector LAN RJ-45

Puerto eSATA

Puerto de salida de HDMI

Rejilla

2 Puertos USB 2.0

Ranura ExpressCard/

54(34)

10. Lector de tarjetas 7 en 1

© N oA

Lector de tarjetas 7 en 1

El lector de tarjetas le permite usar algunas de las Ultimas tarjetas de almacenamiento digital.
MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / MS Pro (Memory Stick Pro) / MS

Duo (requiere PC adaptador) / Mini SD (requiere PC adaptador) / RS MMC (requiere PC adaptador)

Puerto eSATA

Tenga en cuenta que necesita el controlador Intel Matrix Storage para habilitar el puerto eSATA
(consulte “Soporte puerto eSATA” en la pagina 166).

.|
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Mapa del sistema: Vistas derechay posterior

ey = —

Lateral derecho
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Parte posterior

\ A/
Z &
Expulsién de emergencia de CD

Si  necesita expulsar un CD/DVD
manualmente (p. ej. por un corte de
corriente inesperado) puede introducir la
punta de un clip en el orificio de expulsion
de emergencia. No utilice la punta de un
lapiz u otros objetos que puedan romperse
y quedar atrapados en el orificio.

Advertencia sobre soportes extraibles

No intente extraer un disquete o CD
mientras el sistema esté accediendo al
mismo. Esto puede causar un fallo.

9

4

Cambiar los cédigos regionales para DVD

Vaya al Panel de control y haga doble clic en Ad-
ministrador de dispositivos (Hardware y soni-
do), luego en + junto a Unidades de DVD/CD-
ROM. Haga doble clic en el dispositivo de DVD-
ROM para abrir el ment Propiedades y seleccio-
ne la Region DVD (ficha) para abrir el panel de
control y permitirle ajustar el cédigo regional.

La deteccion del cédigo regional de DVD depende
del dispositivo y no del sistema operativo. Es po-
sible seleccionar el cédigo regional 5 veces. La
quinta seleccion es permanente. No se puede al-
terar por mas que se cambie de sistema operativo
o el médulo se utilice en otro ordenador.

Figura 6
Vistas derechay
posterior

Conector de salida S/
PDIF

Conector de entrada
para micr6fono
Conector de salida de
auriculares

Puerto USB 2.0

Bahia de dispositivo
Optico

Orificio de expulsion de
emergencia

Conector de teléfono RJ-
11

Ranura del cierre de
seguridad

Bateria
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Figura 7 Mapa del sistema: Vista inferior
Vista inferior
\ A/
1. Bateria 7£l§
2. Tapa del médulo CPU
Bluetooth . .
3 T de la bahi El usuario no debe manipular la 3
’ C?S/Rihj ania para CPU. El acceso a la CPU de 4
h cualquier modo puede anular su Modelos A & C
4. Rejilla garantia.
5. Tapa de la bahia para el
disco duro Recalentamiento
6. Ubicacion de la tarjeta .
3.5G USIM Para evitar que su ordenador se

recaliente compruebe que nada
bloquea la(s) rejilla(s) con el equipo
encendido.

4

Informacion de la bateria

3

Siempre complete la descarga de

una bateria nueva y luego carguela & Modelos B & D
por completo antes de usarla. Des-
carguela por completo y vuelva a
cargarla al menos una vez cada 30
dias o tras unas 20 descargas par-
ciales.

148 - Mapa del sistema: Vista inferior
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Menu Inicio y Panel de control de Windows Vista

La mayoria de paneles de control, utilidades y programas en Windows Vista (y la mayoria de versiones de Windows)
pueden accederse a través del menu Inicio. Cuando instala programas y utilidades, se instalaran en su unidad de disco duro
y normalmente aparecera un acceso directo en el menu Inicio y/o escritorio. Haga clic con el bot6n derecho en el icono del
menu Inicio 3, luego seleccione Propiedades si desea personalizar la apariencia del men Inicio.

= = Em
Abrir @ Programas predeterminados - 5 ;
Explorar ) =
Internes 0 Windows Update - -
oy o= 4 P @: 8 .-
Propiedades %) Cotren slectrinis L
¥ 1) [t @ Progemas ™= :
Abrir todos los usuarios T - Y =
=, Documentos - .
Explorar todos los usuarios el
B Configuracién Bl Pancl e conirol & C g
| & Conexiones de red
U @ =

b Impresoras

L Barra de tareas y men nicio

Haga clic aqui para cambiar a la
vista clésica

Figura 8 - Menu Inicio y Panel de control

En muchos ejemplos a lo largo de este manual vera una ilustracién para abrir Panel de control. EI Panel de control se
accede desde el menu Inicio. EI Panel de control le permite establecer la configuracién de la mayoria de caracteristicas
principales en Windows (p. ej. energia, video, redes, audio, etc.). Windows Vista ofrece paneles de control basicos para
muchas de las caracteristicas, sin embargo, se afladen muchos paneles de control nuevos (o mejoran los existentes) cuando
instale los controladores listados en la Tabla 5 en la pagina 155. Para ver todos los controles puede que sea necesario
activar la vista Clasica.

.|
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Parametros de video

Este ordenador incluye dos opciones de video diferentes (Intel para los Modelos A & B o NVIDIA para los Modelos C
& D). Puede cambiar los dispositivos de pantalla y configurar las opciones de pantalla desde el panel de control
Configuracién de Pantalla (en Personalizacion) en Windows Vista o desde el panel de control de Intel GMA Driver for
Mobile/Panel de control de NVIDIA.

Para acceder a la Configuracion de pantalla en Windows Vista:

1. Hagaclic en Inicio (menu), y haga clic en Panel de control (o vaya a Configuracion y haga clic en Panel de control).

2. Hagaclic en Ajustar resolucion de pantalla en el mena Apariencia y personalizacion (o haga doble clic en Personalizacién >
Configuracion de pantalla).

3. En Resolucion, mueva el control deslizante a la configuracién preferida para resolucion 0 (ver la Figura 9 en la pagina 151).

En Calidad de color, haga clic en la flecha y desplace hasta la configuracién preferida para la profundidad del color 9 (ver la
Figura 9 en la pagina 151).

5. Haga clic en Configuracion avanzada... (boton) 6 (ver la Figura 9 en la pagina 151) para abrir las fichas de Configuracion
avanzada.

Para acceder al Panel de control de Intel GMA Driver for Mobile (Modelos A & B):

1. Puede acceder al panel de control Intel GMA haciendo clic en el icono en la barra de tareas y seleccionando Propiedades de
los gréficos en el menu (o en Intel GMA Driver for Mobile en el Panel de control de Windows).

Para acceder al Panel de control de NVIDIA (Modelos C & D):

1. Puede acceder al Panel de control de NVIDIA haciendo clic con el boton derecho en el escritorio y haciendo clic en Panel de
control de NVIDIA (o en NVIDIA Control Panel en el Panel de control de Windows).
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G PC paetitil

Mads de
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Salir de la bandeja

Intel* Graphics Media T g ] Dmpecs prcest
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Peg

1. Mesisse P genescs en NVIB Geferce $300M G5

Panel de control de NVIDIA

Raschucitn Cotcid do ot Nueve L
s | e [on i ata b
B Personalizar

1620 par 1090 s
sads St el e — B Personalizar ‘
C ] |Lcmoner
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Figura 9 - Configuracion de Pantalla & panel de control Intel GMA Driver for Mobile/Panel de control de NVIDIA

Conectar otra pantalla

Ademas del LCD incorporado también puede utilizar un monitor, una pantalla plana o un televisor externo (televisor sélo

a través del puerto de salida de HDMI), conectado al puerto para monitor externo o al puerto de salida de HDMI (High-
Definition Multimedia Interface) como dispositivo de pantalla.

Parametros de video - 151
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Caracteristicas de audio

Puede configurar las opciones de audio de su ordenador en
el panel de control de Sonido “”, o desde el icono de
Administrador de sonido Realtek HD /@ en la
barra de tareas o en el panel de control (haga clic en el icono
de la barra de tareas g para abrir el mend de audio). El
volumen también puede ajustarse con la combinacion de
teclas Fn + F5/F6.

& - ,
‘“]] Administrador de sonido

4

Ajuste del volumen del
sonido

2 Dispositives de audio

Reproducter de medios de Windows

% Eventos de sonido del sistema

»l
-

r L Control de volumen
Ei

Grabador de sonidos

q

!

Haga clic con el bot6n
derecho en el icono g
para acceder al menu
de arriba.

El nivel del volumen del so-
nido se ajusta utilizando el
control dentro de Windows
(y las teclas de funcion del
volumen en el ordenador).
Haga clic en el icono del
Volumen de la barra de ta-
reas para comprobar la
configuracion.

Configuracion de audio HDMI

Puesto que HDMI (High-Definition Multimedia Interface)
lleva a la vez las sefiales de audio y video, debera configurar
la salida de audio segun las instrucciones siguientes.

Configuracion de audio de Windows para

HDMI

1. Conecte un dispositivo con soporte HDMI al puerto de
salida de HDMIL.

2. Haga clic en Inicio (menu), y haga clic en Panel de
control (o vaya a Configuracion y haga clic en Panel de
control).

3. Hagaclic en Sonido «# (Hardware y sonido).

4. Haga clic en Reproduccion (ficha), y haga clic para
seleccionar Dispositivo HDMI (Modelos A & B)/
NVIDIA HDMI Output (Modelos C & D).

5. Haga clic en Predeterminar (botdn).

6. Haga clic en Aceptar para cerrar el panel de control
Sonido .

7. Ahora podra escuchar las fuentes de audio al reproducirlas
en Windows Media Player.

. |
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1

Haga clic en el indi-
cador del volumen
de la barra de tareas
i cuando Dispositi-
vo HDMI esté selec-
cionado y vera que el
icono de la parte su-
perior del indicador
del nivel del volu-
men ha cambiado.

Haga clic en el indi-
cador del volumen de
la barra de tareas [Jj
cuando NVIDIA
HDMI Output esté
seleccionado y vera
que el icono de la
parte superior del in-
dicador del nivel del
volumen ha cambia-
do.

Figura 10 - Dispositivo HDMI/NVIDIA HDMI Output
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Notas sobre HDMI

« Conecte un dispositivo con soporte HDMI al puerto de
salida de HDMI ANTES de intentar reproducir fuentes de
audio/video a través del dispositivo.

« Si desconecta cable HDMI el dispositivo de reproduccion de
audio predeterminado no volvera a los altavoces hasta que
reinicie el ordenador (si no desea reiniciar el ordenador vaya
al panel de control Sonido y seleccione Altavoces como
dispositivo de reproduccidn de audio predeterminado).
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Funciones de administracion de energia

El panel de control de las opciones de energia (meni Hardware y sonido) de Windows (ver la pagina 149) permite
configurar las funciones de administracion de energia del ordenador. Puede ahorrar energia con los planes de energia y
configurar las opciones para el botdn de encendido, botén de suspensién, tapa del ordenador (al cerrarla), pantalla y
modo de suspensidn en el menl de la izquierda. Tenga en cuenta que el plan economizador puede afectar al rendimiento
del ordenador.

Haga clic para seleccionar uno de los planes existentes o haga clic en Crear un plan de energia en el menl izquierdo y
seleccione las opciones para crear un plan nuevo. Haga clic en Cambiar la configuracion del plan y haga clic en Cambiar
la configuracion avanzada de energia para acceder a mas opciones de configuracion.

|4 » Panel e comrol » Opciones de energla = | 4 || Busn P @-.’-.v & = Opoones de energlt » Coofiguraciin del sitema | 4 }| fercar P

Seleccionar un plan de encrgia Deefinir hos botones de encendido y activar 1a proteccidn con contraseda

Los planes de energis pueden syudarle & maimizar el rendimients del equips y shoerar energia. Uiga o plan e energla deneado en o equps. Lia camiios reslsados en la confiurici S¢ ests pegina se
Selee np s b e

) Camibiar i corfigueacién schusimente 1 deporsble
Configaraciin de los botones ks tapa e encenddo y de sapenutn

' Cen batera P e

Crear un plan e energls
0 Hlegir rudnde se apsg
pantals

0 u:mau el botta de E " =

A Cambia la frecuencs com la
e e con i exade @ Hrenmassse &:?fm“'_
de napennon e I Suspender -
O Ajete o b 4 b parealls 'zi'_
‘ﬁ Al el tap Sangender = | Sowpnder )

Rescivacion protegeda con contraefia

o i s g g vl ol e e o oy ek
eschs comects pins desbloquest of epipe. g

Cunnn o agreipes e rebtive & st da ons tucpancibe, cuslquisr parsens padsi sbtuner sccass »
ko ot pomie o spaps e Bloqac

Nota: Suspensidn es el estado de ahorro de energia predeterminado en Windows Vista

Figura 11 - Opciones de energia

.|
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Instalacion de controladores

El disco Device Drivers & Utilities + User’s Manual
contiene los controladores y utilitarios necesarios para
utilizar el ordenador correctamente. Inserte el disco y haga
clic en Install Drivers (botdn), u Option Drivers (boton)
para acceder al men( de controladores opcional.

Instale los controladores en el orden indicado en la Tabla 5.
Tras instalar cada controlador, quedara en gris (si necesita
volver a instalar un controlador, haga clic en el botdn
Unlock).

Instalacion manual del controlador

Haga clic en el botén Browse CD en la aplicacion Drivers
Installer y busque el archivo ejecutable en la carpeta de
controladores apropiada

Windows Update

Tras instalar todos los controladores asegUrese de haber
habilitado Windows Update para obtener las dltimas
actualizaciones de seguridad, etc. (todas las actualizaciones
incluiran los ultimos parches de Microsoft).

Guia del Usuario Concisa

Controlador (Windows Vista con SP1) | Péagina#
Chipset pagina 156
Video pagina 156
Sonido pagina 156
Moédem pagina 156
Red (LAN) pagina 156
TouchPad (almohadilla tactil) pagina 156
Lector de tarjetas pagina 157
Hot-Key pagina 157
Soporte eSATA pagina 166
Céamara PC (opcion) pagina 157
Médulo 3.5G (opcion) pagina 162
Maodulo LAN Wireless (opci6n) pagina 165
Modulo de Turbo Memoria Intel (opcion) pagina 166
Lector de huellas digitales (opcion) pagina 167

Bluetooth (opcién) Nota: No se requiere instalacion de contro-

ladores (vea la pagina 169)

Activar Windows Update (ver a laizquierda)

Tabla 5 - Procedimiento de instalacién
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Nuevo hardware encontrado

Si durante el procedimiento de instalacion aparece el
asistente Nuevo hardware encontrado, haga clic en
Cancelar para cerrar el asistente y siga con el
procedimiento de instalacion.

Chipset

1. Hagaclic en 1.Install Chipset Driver > Si.

2. Haga clic en Siguiente > Si > Siguente > Siguiente.
3. Haga clic en Finalizar para reiniciar el sistema.

Video

1. Hagaclic en 2.Install Video Driver > Si.

Modelos A & B (Intel):
2. Haga clic en Siguiente > Si > Siguente > Siguiente.
3. Haga clic en Finalizar para reiniciar el sistema.

Modelos C & D (NVIDIA):

4. Haga clic en Siguiente.
5. Haga clic en Finalizar para reiniciar el sistema.

Sonido

1. Haga clic en 3.Install Audio Driver > Si.

2. Haga clic en Siguiente.

3. Hagaclic en Finalizar para reiniciar el sistema.

Modem
1. Hagaclic en 4.Install Modem Driver > Si.
2. Haga clic en Aceptar.

3. El mddem esta listo para la configuracion del acceso
telefonico.

Red (LAN)

1. Hagaclic en 5.Install LAN Driver > Si.

2. Haga clic en Siguiente > Instalar.

3. Hagaclic en Finalizar.

4. Ahora se pueden configurar los parametros de red.

TouchPad

1. Hagaclic en 6.Install Touchpad Driver > Si.

2. Haga clic en Siguiente.

3. Hagaclic en Finalizar > Reinicar ahora para reiniciar el
sistema

Lector de tarjetas

1. Hagaclic en 7.Install Cardreader Driver > Si.
2. Haga clic en Siguiente > Instalar.

3. Hagaclic en Finalizar.
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Hot-Key

1. Haga clic en 8.Install Hotkey Utility > Si.

2. Haga clic en Next > Install.

3. Haga clic en Finish > Finish para reiniciar el sistema.

Soporte eSATA

Consulte “Configuracion de Turbo Memoria Intel &
Matrix Storage e instalacion del controlador” en la
pagina 166 para instrucciones sobre la instalacion de este
controlador para habilitar el puerto eSATA.

. |
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Camara PC

El médulo camara PC utiliza la aplicacién BisonCap para
capturar archivos de video.

2N\
/ﬁl\
Ultima informacién del controlador de la camara PC

Compruebe el disco Device Drivers & Utilities + User's Manual

y las paginas insertadas que lo acompafen para la informacién
actualizada del controlador de la camara PC, que puede
sustituir a la informacién ofrecida aqui.

Instalacion del controlador de la

camara PC

1. Encienda el médulo utilizando Fn + F10 (el indicador
visual en pantalla _'__ < aparecerd brevemente cuando se
encienda el médulo).

2. Haga clic en Option Drivers (boton).

3. Haga clic en 1.Install WebCam Driver > Si.

4. Elija el idioma que prefiera y haga clic en Siguiente >
Siguiente.

5. Haga clic en Finalizar para reiniciar el sistema.

6. Ejecute el programa de la aplicacion BisonCap desde el
acceso directo (BisonCam) en el escritorio o desde la
opcioén BisonCam en el mend Inicio > Programas/Todos

los programas (si el hardware estéa apagado utilice la
combinacidn de teclas Fn + F10 para volver a
encenderlo).

Configuracion del audio de la camara
PC

Configure las opciones de grabacion de audio en Windows

para capturar video & audio con su camara.

1. Haga clic en Inicio (menu), y haga clic en Panel de control
(o vaya a Configuracién y haga clic en Panel de control).

2. Haga clic en Sonido ** (Hardware y sonido).

3. Haga clic en Grabar (ficha).

4. Haga clic con el botén derecho en Micréfono (Realtek High
Definition Audio) y compruebe que el item esté deshabilitado.

5. Haga doble clic en Micr6fono (o seleccione Propiedades en
el menu contextual).

6. Haga clic en Niveles (ficha) y ajuste los controles deslizantes
de Micr6fono y Amplificacion de micréfono hasta el nivel
deseado.

7. Haga clic en Aceptar y cierre los paneles de control.

8. Ejecute el programa BisonCap en el mena Inicio >
Programas/Todos los programas > BisonCam.

9. Vaya al menu Devices (Dispositivos) y seleccione Micréfono
(Realtek....) (deberia tener una marca al lado).

10. Vaya al menu Capture (Capturar) y seleccione Capture
Audio (deberia tener una marca al lado).
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BisonCap

La aplicacion BisonCap es un visor de video util para el
propdsito general de visualizacién y comprobacion de
video y puede capturar archivos de video en formato .avi.

1. Ejecute el programa BisonCap en el menu Inicio >
Programas/Todos los programas > BisonCam (se
recomienda que Ajuste el archivo de captura antes del
proceso de captura - ver “Ajustar archivo de captura” a
continuacion).

2. Vaya al menu de Capture (Capturar) (si desea capturar audio
cconsulte “Configuracién del audio de lacamara PC” en la
pagina 158) y seleccione Start Capture (Iniciar captura).

3. Haga clic en OK (Aceptar) (la ubicacion del archivo aparecera
en el cuadro emergente) para iniciar la captura y pulse Esc
para detenerla (puede ver el archivo usando Windows
Media Player).

Ajustar archivo de captura

Antes de capturar archivos de video puede seleccionar la
opcidn Set Capture File... (Ajustar archivo de captura...) en el
menu File (Archivo) y ajuste el nombre del archivo y la
ubicacidn antes de capturar (esto ayudara a evitar sobrescribir
archivos accidentalmente). Ajuste el nombre y la ubicacién y
luego haga clic en Abrir, luego ajuste el "Tamafio del archivo
de captura": y haga clic en OK (Aceptar). Luego podré iniciar
el proceso de captura como arriba.

Guia del Usuario Concisa

Zoom
El programa BisonCap le permite acercar y alejar con la
camara.

1. Ejecute el programa BisonCap.
2. Vaya al menu de Zoom y seleccione ZoomOut/Zoom In.

Tomar imagenes instantaneas
El programa BisonCap le permite tomar fotos instantaneas.

1. EjecuteelprogramaBisonCap.
2. Vaya al menu de Options y seleccione Take Picture.

3. Laimagen (en formato JPEG) sera colocada en la carpeta
Snapshot £ en el escritorio (ho mueva ni cambie el
nombre de la carpeta).
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Eliminar el parpadeo de pantalla

Si la pantalla de video del programa BisonCap parpadea,
puede intentar ajustar la configuracion en las opciones
Video Capture Filter.

1. Ejecute el programa BisonCap.

2. Vaya al menl de Options y seleccione Video Capture
Filter....

3. Haga clic en 50Hz o0 60Hz bajo Frecuencia en Pagina de
propiedades (ficha).

Reducir el tamafio de archivo de video
Tenga en cuenta que la captura de archivos de video a alta
resolucién necesita una cantidad considerable de espacio en
el disco para cada archivo. Tras grabar el video, compruebe
el tamafio del archivo de video (haga clic en el archivo y
seleccione Propiedades) y el espacio libre en su disco duro
(vaya a Equipo, haga clic con el botdn derecho en el disco
duroy seleccione Propiedades). Si lo necesita, puede pasar
el archivo de video grabado a un medio extraible, como CD,
DVD o unidad USB Flash.

Tenga en cuenta que el sistema Windows Vista necesita un
minimo de 15GB de espacio libre en la unidad C: para la
particion del sistema. Para evitar problemas en el sistema,
se recomienda que guarde el archivo de video capturado en

una ubicacién distinta a la unidad C: (consulte “Ajustar
archivo de captura” en la pagina 159), limite el tamafio de
archivo del video capturado o reduzca la resolucion del
video.

Para reducir el tamafio de salida de la resolucion

del video:

1. Ejecute el programa BisonCap.

2. Vaya a Opciones y seleccione Video Capture Pin....

3. Haga clic en el cuadro desplegable Tamafio de salida y
seleccione un tamafio de resolucién menor para reducir el
tamafio del archivo capturado.
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Modulo 3.5G

Si ha incluido un médulo opcional 3.5G en su opcion de
compra, siga las instrucciones siguientes para instalar la
tarjeta USIM (suministrada por su proveedor de servicios)
y luego instale la aplicacion.

2N
il
Aviso de seguridad sobre la corriente

Antes de llevar a cabo cualquier procedimiento de

actualizacion, asegurese de haber apagado la alimentacion y
desconectado todos los periféricos y cables (incluyendo las
lineas telefonicas). También es aconsejable quitar su bateria
para evitar que la maquina se encienda por accidente.

1. Apague el ordenador y girelo para quitar la bateria.

2. Localice la tapa de la tarjeta SIM y afloje el tornillo 0 dela
Figura 12.

3. Quite la tapa de la tarjeta SIM @) como en la Figura 12.
Inserte la tarjeta USIM como lo haria en un teléfono moévil.

5. Deslice SIMLOCK hacia la bisagra (en la direccion opuesta a
la flecha ilustrada en la Figura 13) para soltar el bloqueo y
levantarlo.

Guia del Usuario Concisa

Figura 12 - Quitar la tapa de la tarjeta SIM

Inserte la tarjeta USIM como aparece en (la Figura 13) y
cierre SIMLOCK

Bloquee SIMLOCK presionando en la direccion de la flecha
de la Figura 13 hasta que encaje en su posicion de blogueo.

Vuelva a colocar la tapa, el tornillo y la bateria.

Figura 13 - Insertar la tarjeta USIM & bloquear
SIMLOCK
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Ap|ica_cién 3G Watcher Sierra Wireless > 3G Watcher), o haciendo clic en el
Con el médulo 3.5G v la tarjeta USIM (suministrados por icono [ en la barra de tareas.

su proveedor de servicios) ya instalados, podra instalar la Configurar un perfil de portador
aplicacion 3G Watcher. La aplicacion 3G Watcher le A ,nque |a informacion de conexion esté almacenada en la
permite acceder directamente a su servicio de internet 3.5G tarjeta USIM suministrada por el proveedor de servicios

desde el ordenador. debera configurar un perfil de portador desde el software

L . L 3G Watcher.
Instalacion de la aplicacion 3G Watcher
presionando la combinacion de teclas Fn + ! = (el 2. Podra acceder a la aplicacion 3G Watcher en el men( Inicio

indicador visual en pantalla | €| indicaré el estado de (Inicio > Programas/Todos los programas > Sierra_
corriente del modulo) . Wireless > 3G Watcher), o haciendo clic en el icono a enla

5 s [ asi N hard doh barra de tareas.
. |_ aparece el asistente Nuevo hardware encontrado haga 3. Haga clic en Herram... y seleccione Opciones.
clic en Cancelar.

- . . 3 4. Haga clic en Perfiles y luego en Agregar perfil nuevo [:F
3. Haga clic en Option Drivers (boton). (botén), y seleccione Perfil WWAN. -
4. Haga clic en 2.Install 3G Driver > Si.
5
6

Haga clic en Siguiente.
Haga clic en el boton Acepto los términos del contrato
de licencia, luego haga clic en Instalar.

7. Cuando aparezca la siguiente pantalla, espere unos 2
minutos antes de hacer clic en Finalizar (para que el
hardware detecte el médulo 3.5G).

8. Elicono de 3G Watcher ﬁ aparecera en el escritorio.

9. Podré acceder a la aplicacion 3G Watcher en el menu

Inicio (Inicio > Programas/Todos los programas > Figura 14 - Agregar perfil WWAN
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5. Entonces podra introducir un nuevo nombre de perfil o elegir Conectar con el proveedor de servicios

un perfll. de la “St_a desplegable del programa. _ _ 1. Utilice la combinacién (Fn + ! ) para activar el médulo 3.5G.
6. Haga clic en Aplicar > Aceptar para guardar la informacion. 2. Podré acceder a la aplicacién 3G Watcher en el men Inicio
7. Puede elegir el perfil del menu desplegable. (Inicio > Programas/Todos los programas > Sierra__
Wireless > 3G Watcher), o haciendo clic en el icono h enla

barra de tareas.

' 3. El software se ejecutara y mostrara el nombre del proveedor
v ChigsSebcon ) de servicios (la informacién de la conexidn se obtiene desde
‘ la tarjeta USIM).

aEx

SIERAA WIRELESS. WWAN -AT & T
T 36 Watcher

. Figura 16
e 3G watcher

(_Conector )]

Detalles del perfil

Si ha elegido el perfil de la lista desplegable la mayor parte 4. Haga clic en Conectar para iniciar el proceso de conexion.
de la informacion de las fichas General y Avanzada deberia 5. La aplicacién 3G Watcher mostraréa entonces la informacién
estar rellanada automaticamente (sin embargo, compruebe de conexién en la ventana.

con su proveedor de servicios la ultima informaciéon pues
puede que necesite al menos agregar su Nombre de usua-
rio y Contrasefia)

6. Cuando la conexion tiene éxito aparecera una notificacion en
la barra de tareas (como abajo).

o wornar = Figure 17

Notificacion de
conexioén en laba-
e T rra de tareas
el fd T R S W) 1154

Figura 15 - Opciones de usuario y seleccionar perfil

7. Puede acceder a internet, descargar correo electrénico, etc.
igual que con cualquier conexién a internet.
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10.
11.

12.

13.

14.

Mientras esté conectado el icono de la barra de tareas estara
en verde m (estara en rojo cuando el programa se esté
ejecutando pero sin conexién).

Para desconectar haga clic en el icono Desconectar.
El programa desconectara del proveedor de servicios.
El médulo continuaré activado y debera pulsar la combinacién

?

de teclas Fn + .
Si hace clic en el icono para cerrar 3G Watcher [ aparecera
un mensaje pidiéndole que haga clic en OK para confirmar
salir del programa.

Advertencia ==l
&

Ha solicitado salir de 3G Watcher. Flgu ra 18
Aviso para salir

:
d

o
28]
I
|9
f—
<L
S

["INo volver a preguntar

hceptar || Cancelar |

Al salir del programa NO se apagara el modulo 3.5G, debera
pulsar la combinacién de teclas Fn + | | para apagar el
modulo (tenga especial cuidado cuando esté en un avién) -
consulte “Uso de dispositivos inaldmbricos a bordo de un
avion” en la pagina 134).

Si el modulo esta encendido y el ordenador entra en modo
ahorro de energia, el estado de energia del modulo al reanu-

dar del estado de ahorro de energia sera el indicado al dorso:

« Si el moédulo 3.5G esta encendido y el ordenador esta
apagado/reinicia el ordenador; el mddulo estara
apagado cuando el ordenador se inicie.

« Si el médulo 3.5G esta encendido y el ordenador entra
en modo de suspension/en modo de hibernacidn; el
madulo estard apagado cuando el ordenador se reanude
desde la suspension.

Servicio de mensajeria corta

Ademas de los servicios estandar de internet también podra
enviar y recibir mensajes de texto SMS utilizando la
aplicacion 3G Watcher.

1. Elindicador de mensajes SMS H de la ventana principal le
notificara sobre los nuevos mensajes recibidos.

2. Haga doble clic en el icono H o seleccione Herram... >
SMS Express....

3. Seleccione la carpeta de entrada y cualquier mensaje para
leerlo o seleccione Archivo > Nuevo mensaje de correo o
haga clic en el botdbn Nuevo para preparar un mensaje nuevo.

Para mas detalles sobre SMS consulte la Ayuda en linea de
3GWatcher en el meni Ayuda > Temas de ayuda.
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Modulo LAN Wireless Conectar a unared inalambrica
Compruebe que el mddulo WLAN esté activado.
/ 1. Hagaclic en el icono WLAN en la barra de tareas, y luego
Botén de encendido para el médulo WLAN haga clic en Conectarse a una red (o haga clic con el boton
. . . - ) derecho en el icono E y luego haga clic en Conectarse a
Active la alimentacion al médulo WLAN utilizando la combina- una red).

cion de teclas (Fn + F11). Cuando el médulo WLAN esta encen-
dido, el LED (i) estara en verde y el indicador visual en
pantalla '@ aparecera brevemente.

2. Enlalista Mostrar, haga clic en Inaldmbrico en el menu
desplegable.

3. Aparecera una lista con las redes disponibles.

Haga clic en una red y luego en Conectar.

Instalacic')n del controlador del mc’)d ulo Sino ve la red a la que quiere conectarse, haga clic en
Configurar una conexidn o red (aparecera una lista con

WLAN opciones permitiendo la busqueda manual y creando una
nueva red).

o &

1. Compruebe que el médulo esté activado. _ =
2. Haga clic en Option Drivers (boton). 6. Mueva el cursor sobre el icono de la barra de tareas para
. . . , ver el estado de la conexion.
3. Hagaclic en 3.Install Wireless Lan Driver > Si. e .
. . .. 7. Para desconectarse de la red inaldambrica puede hacer clic en el
4. Haga CI!C en Siguiente > Siguiente. _ icono (& inaldmbrico de la barra de tareas y luego seleccionar
5. Haga clic en el boton Acepto los términos del contrato Conectar o desconectar para acceder al ment de la red y
de licencia, luego haga clic en Siguiente. hacer clic en Desconectar (o haga clic con el botén derecho
6. Haga clic en Siguiente > Siguiente > Finalizar. en el icono B4, y luego haga clic en Desconectar de).

Nota: EI sistema operativo es la configuracion
predeterminada para el control de LAN inaldmbrica en
Windows Vista.

. |
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Modulo de Turbo Memoria Intel
4

Soporte puerto eSATA

Tenga en cuenta que necesita el controlador Intel Matrix
Storage para habilitar el puerto eSATA incluso aunque no
haya incluido un médulo de Turbo Memaria Intel en su op-
cion de compra.

Siga las instrucciones incluidas aqui para instalar el controla-
dor.

Si ha incluido un médulo de Turbo Memoria Intel (Robson)
en su opcién de compra, debera instalar el controlador
segin las instrucciones siguientes (no instalar este
controlador en Windows XP).

Intel Turbo Memory Technology (también conocida como
memoria flash Robson) es una tecnologia de Intel que
reduce el tiempo de arranque de un ordenador, de carga de
aplicaciones y de escritura de datos en el disco duro. Intel
Turbo Memory Technology es soportado solamente en
Windows Vista (también soporta caracteristicas de Windows
Vista como ReadyBoost, ReadyDrive y Superfetch).

Configuraciéon de Turbo Memoria Intel
& Matrix Storage e instalacion del
controlador

1. Inicie su ordenador y pulse F2 para entrar en la BIOS.

2. Vaya al menu Advanced, seleccione "Installed O/S" y
asegurese de que "Vista" sea la opcidn seleccionada.

3. Vaya a la opcién "SATA Mode Selection" y asegurese de
que "AHCI" esté seleccionado.

4. Seleccione "Exit Saving Changes" en el menu Exit (o
pulse F10y seleccione "Yes" y luego pulse Entrar)y
pulse Entrar para salir de la BIOS y reiniciar el ordenador.

5. Inserte el disco Device Drivers & Utilities + User’s

Manual en la unidad de CD/DVD.

Haga clic en Option Drivers > Si.

Haga clic en 4.Install TM&iMSM Driver > Si.

Haga clic en Next > Yes > Next > Next.

Haga clic en Finish para reiniciar el sistema.

© 0N o

e — ===« Windows ReadyBoost - utiliza
@ == la memoria flash como solucion
o de caché del disco duro.

* Windows ReadyDrive - utiliza
las unidades hibridas como
solucién de caché del disco duro.

Figura 19 - Intel Turbo Memory Console
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Lector de huellas digitales

Si su opcidn de compra incluye un lector de huellas digita-
les necesitara instalar el controlador como se indica a con-
tinuacion.

Asegurese de tener derechos de administrador en su ordena-
dor y de tener una contrasefia Windows habilitada para una
proteccion de seguridad completa.

Antes de comenzar el proceso de inscripcion, se
recomienda que siga el tutorial de huellas digitales. Para
ejecutar el tutorial, haga clic en Inicio > Programas/Todos
los programas > Protector Suite QL > Tutorial de
huellas digitales.

Instalacion del controlador para

huellas digitales

1. Inserte el disco Device Drivers & Utilities + User’s
Manual en la unidad de CD/DVD.

Haga clic en Option Drivers (button).

Haga clic en 5.Install FingerPrint Driver > Si.
Haga clic en Instalacion del software.

Haga clic en Siguiente > Siguiente > Siguiente.
Haga clic en Finalizar > Si para reiniciar el sistema.

IS
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4

Ayuda & Manual

Haga clic con el botén derecho en el icono de la barra de tareas
& para abrir el men0 y seleccionar Ayuda.

Inserte el disco Device Drivers & Utilities + User's Manual y
haga clic en Option Drivers (botén). Haga clic en Unlock (bo-
tén) y luego haga clic en 5.Install FingerPrint Driver > Si.

Haga clic en Documentacion para abrir la carpeta que contie-
ne el manual en formato .pdf.

Para instalar el Adobe Acrobat Reader para leer el archivo, inserte
el disco Device Drivers & Utilities + User's Manual y haga clic
en User’s Manual (botén) y haga clic en Install Acrobat Rea-
der (boton).

Inclusion de usuarios

Haga clic en Inicio > Programas/Todos los programas >
Protector Suite QL > Inclusién de usuario, o haga doble
clic en el icono [§£] en la barra de tareas.

La primera vez que ejecute el programa se le pedira que haga
clic en el bot6n para aceptar la licencia, luego haga clic en
Aceptar.

Haga clic en Siguiente (“Registro en el disco duro” sera
elegido automaticamente) y haga clic en Finalizar.
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11.
12.

13.
14.
15.

Si no ha configurado una contrasefia de Windows se le
pedira que lo haga (nota: Si no ha configurado una
contrasefia Protector Suite QL no puede asegurar el acceso
a su ordenador).

Haga clic en Siguiente y se le pedira que escriba su
contrasefia de Windows.

Haga clic en Siguiente > Siguiente (puntee en el cuadro
“Ejecute el tutorial interactivo” para ejecutar el Tutorial de
huellas digitales).

Haga clic en Siguiente en cada ventana del tutorial (puede
hacer clic en el botén “Omitir el tutorial” en cualquier
momento).

Haga clic en el bot6n sobre cualquiera de las huellas digitales
para iniciar el proceso de inclusién de ese dedo.

Coloque el dedo tres veces para incluirlo.

. Repita el proceso para todos los dedos que desee incluir, y

luego haga clic en Siguiente.

Haga clic en Finalizar.

Haga clic en cualquiera de los titulos en “Obtener mas
informacion:” para obtener mas informacion sobre un tema.
Haga clic en Cerrar.

Reinicie el ordenador.

Haga clic con el boton derecho en el icono E| de la barra de
tareas para abrir el menu que le permitird Editar huellas
digitales, iniciar el Centro de control, acceder al menu
Ayuda, etc. También puede ejecutar el Centro de control
etc. desde la opcion Protector Suite QL en el mend Inicio >
Programas/Todos los programas.

16.

17.

18.

Consulte “Ayuda & Manual” en la pagina 167 para mas
detallas.

Si coloca su dedo sobre el lector en cualquier momento,
podra acceder al BiomenU para bloquear el ordenador,
registrar sitios de la web, Desbloquear Mi seguridad, abrir
el Centro de control y acceder al menu Ayuda.

El Centro de control le permite cambiar la Configuracion,
registrar huellas digitales y obtener Ayuda.

=]

Gestidn del software de huellas digitales
® Huslias digitales
Inchryn o et ks plartias do ol dighsl de usuio s

= Configuracién
Configure ol sofwarn da huollas digitaios.

® acorease

# Ayuda
Obionga b miormacién do syuda

» Eoduccion

* Tutorial

* Apuda

2N\Z
A

Inclusién de huellas digitales

Tenga en cuenta que se recomienda encarecidamente que
incluya mas de un dedo en caso de lesidn, etc.

Figura 20 - Centro de control & Biomenu
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Configuracion de Bluetooth

Configurar su dispositivo Bluetooth para
que el ordenador pueda encontrarlo

1.

Encienda su dispositivo Bluetooth (p. ej. PDA, teléfono movil,
etc.).

Deje al dispositivo accesible (para hacerlo consulte la
documentacion del dispositivo).

Para encender el médulo Bluetooth

1.

Utilice la combinacién Fn + F12 para activar el médulo
Bluetooth.

Aparecera un icono de Bluetooth fj en la barra de tareas
(puede que necesite activar la opcién del panel de control
Dispositivos Bluetooth).

Luego podra hacer lo siguiente para acceder al panel de
control Dispositivos Bluetooth.

» Haga doble clic en el icono 3 para acceder al panel de
control Dispositivos Bluetooth.

* Haga clic en Inicio (menu) y haga clic en Panel de control
(o vaya a Configuracion y haga clic en Panel de control),
y luego haga clic en Dispositivos Bluetooth (Hardware y
sonido).

 Haga clic en/Haga clic con el botdn derecho en el icono £
y elija una opcion desde el mend.

Guia del Usuario Concisa
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Transferenciade datos
Bluetooth

Tenga en cuenta que la
transferencia de datos
entre el ordenador y un
dispositivo con Bluetoo-
th se realiza sélo en una
direccién (no soporta
la transferencia de da-
tos simultanea).

Agregar un dispositive Bluetooth

PMostrar dispositivos Bluetooth

Enviar un archive

Recibir un archivo
Unirse a una red de drea personal

Abrir la configuracién Bluetooth

Quitar el icono Bluetooth

Figura 21 - Dispositivos Bluetooth y menu contextual

del icono

Para agregar un dispositivo Bluetooth

1.
2.

Acceda al panel de control Dispositivos Bluetooth.

Haga clic en Opciones (ficha), y asegurese de que la casilla
de verificacion Permitir que los dispositivos Bluetooth se
conecten a este equipo (Conexiones) esta marcada.

Haga clic en Dispositivos (ficha), luego haga clic en Agregar.
El Asistente para agregar dispositivos Bluetooth aparecera.
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5. Haga clic para seleccionar “Mi dispositivo esta configurado
y listo para ser detectado”, luego haga clic en Siguiente.

EE | 0 smrtmon s rmaw semcstens B

=]
habirte (3]

I —r—
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Figura 22 - Asistente para agregar dispositivos Blue-
tooth

6. El Asistente buscara los dispositivos Bluetooth dentro del
alcance.

7. Seleccione la unidad con la que se desea comunicar y haga
clic en Siguiente.

8. Seleccione una opcion de clave de paso apropiada y haga clic
en Siguiente > Finalizar.

| @ st s g i b =
(Pt s s Claes 56 ke s e s Sagatira ! e

Figura 23 - Opciones de clave de paso

Para cambiar la configuracion del
dispositivo Bluetooth

1. Acceda al panel de control Dispositivos Bluetooth.

2. Haga clic en el dispositivo que desea cambiar y haga clic en
Propiedades para:

¢ Cambie el nombre del dispositivo (haga clic en General,
escriba un nuevo nombre y haga clic en Aceptar).

¢ Activar/desactivar un servicio (haga clic en Servicios,
marque/quite la casilla de verificacion junto al servicio y
haga clic en Aceptar).

Para hacer su ordenador accesible a
dispositivos Bluetooth

1. Acceda al panel de control Dispositivos Bluetooth.
Haga clic en Opciones (ficha), y asegirese de que la casilla
de verificacion Permitir que los dispositivos Bluetooth
encuentren este equipo (Descubrimiento) esta marcada.

3. Asegurese de que la casilla de verificacion Alertarme
cuando un nuevo dispositivo Bluetooth desee conectarse
(Conexiones) esta marcada si desea que se le avise cuando
un dispositivo Bluetooth quiera conectarse.

[ rr—n (=+=]

Figura 24
Dispositivos
Bluetooth -

Opciones
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Solucidon de problemas

Problema Posible causa - Solucién

Los médulos WLAN y El (Los) modulo(s) esta(n) desactivado(s). Compruebe el indicador LED {ip) para ver si el médulo
Bluetooth no pueden esté activado o desactivado. Si el indicador LED esté apagado, entonces pulse la(s) combinacién(es)
detectarse. Fn + F11 (WLAN) o Fn + F12 (Bluetooth) para activar el médulo(s) (vea la Tabla 4 en la

pagina 145).
El médulo Bluetooth esta El estado predeterminado del médulo Bluetooth sera apagado tras reanudar desde el estado de
apagado tras reanudar ahorro de energia Suspension. Utilice la combinacion de teclas (Fn + F12) para encender el médulo
desde la Suspension. Bluetooth tras reanudar el ordenador desde Suspension.
Un archivo no puede La transferencia de datos entre el ordenador y un dispositivo con Bluetooth se realiza s6lo en una
copiarse a o desde un direccién (no soporta la transferencia de datos simultanea). Si copia un archivo de su ordenador a un
dispositivo conectado con dispositivo con Bluetooth, no podra copiar un archivo del dispositivo Bluetooth a su ordenador hasta
Bluetooth. gue se haya completado el proceso de transferencia del ordenador.
Los archivos de video Tenga en cuenta que capturar archivos de video de alta resolucion requiere una cantidad sustancial
capturados de la Camara PC | de espacio en el disco para cada archivo. Vea “Reducir el tamafio de archivo de video” en la
ocupan demasiado espacio pagina 160.
en el disco.
No se escucha sonido a No ha configurado la salida de audio HDMI. Consulte “Configuracién de audio HDMI” en la
través del dispositivo de pagina 152.
pantalla HDMI conectado.

.|
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Especificaciones

4

Informacién actualizada de especificaciones

Las especificaciones listadas en este Apéndice son correctas en el momento de publicacion. Ciertas opciones (particularmente tipos/
velocidades de procesadores) pueden cambiar o actualizarse segun la fecha de lanzamiento del fabricante. Dirijase a su centro de
servicios para mas detalles.

Caracteristica

Especificacion

Tipos de
procesadores

Procesador Intel Core 2 Duo
Micro-FCPGA package (478 contactos), 35W
T9400 / T9600

Procesador Intel Core 2 Duo
Micro-FCPGA package (478 contactos), 25W
P9500

Procesador Intel Core 2 Duo
Micro-FCPGA package (478 contactos), 25W
P8400 / P8600

(45nm) tecnologia de proceso de 45 nm
Caché de nivel 2 de 6MB & bus de sistema de
1066MHz

2,53/ 2,8 GHz

(45nm) tecnologia de proceso de 45 nm
Caché de nivel 2 de 6MB & bus de sistema de
1066MHz

2,53 GHz

(45nm) tecnologia de proceso de 45 nm
Caché de nivel 2 de 3MB & bus de sistema de
1066MHz

2,26/ 2,4 GHz
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Caracteristica

Especificacion

Nucleo logic Modelos A & B Modelos C & D
Chipset Intel GM45 + ICH9M Chipset Intel PM45 + ICHOM
Opciones del LCD | Modelos A& C Modelos B & D
Pantalla plana TFT tipo brillo, 14,1" - WXGA/ Pantalla plana TFT tipo brillo, 15,4" - WXGA/WXGA+/
WXGA+ WSXGA+
Adaptador de Modelos A & B Modelos C & D
video Video Integrado Intel GM45 (Chip Interno) Video discreto NVIDIA GeForce 9300M GS (Externo
Acelerador gréfico 2D/3D de alto rendimiento Incorporado)
Arquitectura de memoria compartida (hasta 256MB de RAM de video GDDR2
256MB de memoria de video compartida dina- Memoria gréfica total con soporte TurboCache™
micamente asignada desde la memoria del sis- hasta 512MB (dependiendo de la memoria del sis-
tema cuando se necesita) tema)
Soporta DirectX 10.0 de Microsoft Soporta DirectX 10.0 de Microsoft
Memoria Dos z6calos de 200 pins SODIMM, para memoria DDRII (DDR2) 667/800
Memoria expansible hasta 4GB
Seguridad Ranura para cierre de seguridad (tipo Kensington®) Contrasefia de BIOS
Médulo lector de huellas digitales (opcion de
fabrica)
BIOS Phoenix BIOS (SPI Flash ROM de 32Mb)

Dispositivos de
almacenamiento

Una unidad de dispositivo 6ptico (CD/DVD) SATA de 12,7mm(h) intercambiable (consulte “Opciones” en la
pagina 176 para las opciones del médulo de unidad éptica)
Un HDD SATA facil de cambiar de 2,5" 9,5 mm (h)
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Caracteristica

Especificacion

Audio Interfaz compatible Intel HDA (Sonido Intel de alta S/PDIF salida digital
definicion) 2 altavoces incorporados
Sistema de sonido estéreo 3D Microéfono incorporado
Compatible con Sound-Blaster PRO™

Teclado Teclado “Win Key”

Dispositivo TouchPad incorporado (funcionalidad de tecla de desplazamiento integrada)

puntero

Lector de tarjetas

Médulo lector de tarjetas 7 en 1 (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)
Nota: Tarjetas MS Duo/ Mini SD/ RS MMC requieren PC adaptador

Interfaz Tres puertos USB 2.0 Un puerto eSATA
Un conector de salida HDMI (High-Definition Multi- €SATA soportado en Windows Vista solamente:
media Interface) (soporta 5.1 canales) con salida de El modo AHCI soporta el intercambio en caliente
audio El modo IDE no soporta el intercambio en caliente
Un conector de salida de altavoces/auriculares .
- Un puerto para monitor externo
Un conector de entrada para micréfono )
Un conector de salida S/PDIF Un conector RJ-11 para modem
Un conector RJ-45 para LAN
Un conector de entrada de CC
Ranura Ranura ExpressCard/54(34)
ExpressCard
Ranuras Mini- Una ranura Mini-Card para médulo WLAN
Card Una ranura Mini-Card para médulo de Turbo Memoria Intel O médulo 3.5G
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Caracteristica

Especificacion

Comunicaciones

Fax/Mo6dem de 56K Plug & Play (compatible con V.90 y V.92)
LAN Ethernet de 1Gbit PCI-Express incorporada

2NZ
Opciones del médulo LAN inalambrico: /ﬂ\
Médulo Mini-Card LAN inalambrica Intel® WiFi Link 5300 (802.11 a/g/n) Modos UMTS
Médulo Mini-Card LAN inalambrica Intel® WiFi Link 5100 (802.11 a/g/n)

) ) Tenga en cuenta que los
Médulo camara PC USB del,3M o 2,0M pixeles (opcion de fabrica) modos UMTS NO PUEDEN

Médulo Bluetooth USB + EDR - V2.0 (opcién de fabrica) usarse en Norteamérica.
Médulo UMTS/HSPDA-based 3.5G con interfaz Mini Card (opcién de
fabrica)
Quad-banda GSM/GPRS (850 MHz, 900 MHz, 1800 MHz, 1900 MHz)
UMTS WCDMA FDD (2100 MHz)

Administraciénde
energia

Soporta ACPI v3.0

Alimentacién

Modelos A & B Modelos C & D

Adaptador de CA/CC autodetector de corriente Adaptador de CA/CC autodetector de corriente
Entrada CA: 100-240V, 50-60Hz Entrada CA: 100-240V, 50-60Hz

Salida CC: 19V, 3,42A O 18,5V, 3,5A (65W) Salida CC: 19V, 4,74A (90W)

Bateria

Bateria de Litio-lon inteligente de 6 elementos, 4000mAH O 4400mAH
Bateria de Litio-lon inteligente de 9 elementos, 7200mAH (opcion)

Especificaciones
del ambiente

Temperatura Humedad relativa
En funcionamiento: 5°C - 35°C En funcionamiento: 20% - 80%
Apagado: -20°C - 60°C Apagado: 10% - 90%
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Caracteristica

Especificacion

Dimensiones y
Peso

Modelos A& C
336 (a) x 250 (I) x 24,8 - 35,7 (h) mm
2,3 kgs con bateria de 6 elementos

Modelos B & D
359 (a) x 268 (I) x 24,8 - 37 (h) mm
2,6 kgs con bateria de 6 elementos

Opciones

Opciones del médulo de unidad 6ptica:
Mddulo unidad SATA Combo
Médulo unidad SATA DVD Dual (Super Multi)

Opciones del médulo LAN inalambrico:

Médulo Mini-Card LAN inaldmbrica Intel® WiFi Link
5300 (802.11 a/g/n)

Moédulo Mini-Card LAN inalambrica Intel® WiFi Link
5100 (802.11 a/g/n)

Bateria de Litio-lon inteligente de 9 elementos,
7200mAH

Modulo camara PC USB del,3M o 2,0M pixeles
(opcion de fabrica)

Médulo lector de huellas digitales (opcion de
fabrica)

Médulo Bluetooth USB + EDR - V2.0 (opcién de
fabrica)

Moédulo de Turbo Memoria Intel (Robson) - 2GB

o

Moédulo UMTS/HSPDA-based 3.5G con interfaz Mini
Card (opcidn de fabrica)

Quad-banda GSM/GPRS (850 MHz, 900 MHz, 1800
MHz, 1900 MHz)

UMTS WCDMA FDD (2100 MHz)

2N\L
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Modos UMTS

Tenga en cuenta que los modos UMTS NO
PUEDEN usarse en Norteamérica.
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AVVisO

La societa si riserva il diritto di revisionare la presente pubblicazione o di modificarne il contenuto senza preavviso. Le
informazioni qui contenute sono per solo riferimento e non costituiscono obbligo sulle parti del produttore o di qualsiasi
venditore successivo. Essi non si assumono alcuna responsabilita o obbligo per qualsiasi errore o imprecisione presente in
questa pubblicazione, né sono responsabili per qualsiasi perdita o danno risultante dall'uso (o cattivo uso) della presente
pubblicazione.

Questa pubblicazione e ogni software fornito a corredo non puo, in parte o per intero, essere riprodotta, tradotta, trasmessa
o ridotta in una forma leggibile da macchine senza previo consenso dei venditori, produttori e creatori della pubblicazione
stessa, eccetto per le copie tenute dall'utente a scopo di backup.

I marchi e i nomi dei prodotti menzionati in questa pubblicazione possono 0 meno costituire copyright e/o marchi registrati
delle rispettive societa. Essi sono menzionati per solo scopo identificativo e non sono intesi come avallo di tale prodotto o
del suo produttore.

© Maggio del 2008

Marchi registrati

Il presente prodotto incorpora una tecnologia di protezione di copyright protetta dalle rivendicazioni di metodo di alcuni
brevetti degli Stati Uniti o di altri diritti di proprieta intellettuale posseduti da Macrovision Corporation e altri possessori
di diritti. L'uso di questa tecnologia di protezione di copyright deve essere autorizzata da Macrovision Corporation, ed &
intesa per I'uso domestico o altri usi di visualizzazione limitata solo se non diversamente autorizzato da Macrovision
Corporation. La decodifica, la decompilazione e il disassemblaggio sono proibiti.

Intel ed Intel Core sono marchi/marchi registrati della Intel Corporation.

Avviso - 177
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Guida Rapida per I'Utente

Informazioni sulla Guida Rapida per I'Utente

Questo manuale rappresenta un’introduzione rapida all’avvio del sistema. Si tratta di un supplemento e non di una
sostituzione del Manuale per I'utente completo in lingua inglese nel formato Adobe Acrobat, memorizzato sul CD-ROM
Device Drivers & Utilities + User's Manual fornito a corredo del computer. Inoltre, questo CD-ROM contiene i driver e
le utilita necessari per il corretto uso del computer.

E possibile che alcune o tutte le funzionalita del computer siano gia state configurate. In caso contrario, o se si sta
pianificando di riconfigurare (o reinstallare) componenti del sistema, fare riferimento al Manuale utente completo. Il CD-
ROM Device Drivers & Utilities + User’s Manual non contiene il sistema operativo.

Informazioni di regolamentazione

Le informazioni e le comunicazioni di regolamentazione sono contenute nel Manuale utente completo memorizzato sul
CD-ROM Device Drivers & Utilities + User’s Manual.

2N\Z
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Funzionamento delle periferiche Wireless in aereo

In genere, l'utilizzo di dispositivi di trasmissione elettronici portatili € proibito a bordo degli aerei.
Accertarsi che i moduli WLAN/Bluetooth/3.5G siano spenti quando si utilizza il computer in
aereo.
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Istruzioni per la custodia e il funzionamento

Il computer notebook & abbastanza rigido, ma & possibile che possa essere danneggiato. Per evitare qualsiasi danno,
attenersi ai seguenti suggerimenti:

« Non lasciarlo cadere ed evitare urti. Se il computer cade, & possibile che il telaio e i componenti possano esserne
danneggiati.

« Tenerlo all'asciutto e non provocarne il surriscaldamento. Tenere il computer e lI'alimentazione lontani da ogni tipo di
impianto di riscaldamento. Si tratta di un apparato elettrico. Se acqua o altri liquidi dovessero penetrarvi, esso potrebbe
risultarne seriamente danneggiato.

« Evitare le interferenze. Tenere il computer lontano da trasformatori ad alta capacita, motori elettrici e altri intensi campi
magnetici. Cio ne pud impedire il corretto funzionamento e danneggiare i dati.

» Attenersi alle corrette procedure di lavoro con il computer. Spegnere il computer correttamente e non dimenticare di
salvare il proprio lavoro. Ricordare di salvare frequentemente i propri dati poiché essi potrebbero essere persi nel caso in cui
la batteria si esaurisse.

» Porre particolare cura nell'utilizzo delle periferiche.

Assistenza

Non provare a riparare il computer da soli. Una tale azione invaliderebbe la garanzia ed esporrebbe I'utente del computer
al pericolo di una scossa elettrica. Fare riferimento al personale dell'assistenza autorizzata. Scollegare il computer
dall'alimentazione. Fare riferimento all'assistenza di personale qualificato nei seguenti casi:

e Quando il cavo di alimentazione & danneggiato o logorato.

e Seil computer ¢ stato esposto alla pioggia o ad altri liquidi.

e Se il computer non funziona normalmente dopo aver seguito correttamente le istruzioni operative.

« Seil computer ¢ caduto o si & danneggiato (non toccare il liquido velenoso in caso di rottura dello schermo LCD).
e Sec'e un odore non usuale, calore o fumo che fuoriesce dal computer.

.|
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Sicurezza relativa all'alimentazione
Il computer presenta specifici requisiti di alimentazione:

»  Utilizzare esclusivamente un adattatore approvato per I'utilizzo di questo computer.

e L'adattatore CA/CC potrebbe essere stato progettato per viaggi all'estero, ma richiede ugualmente un'alimentazione stabile e
continua. Se non si & certi delle specifiche elettriche locali, consultare I'assistenza tecnica o la societa locale di fornitura elettrica.

» L'adattatore di alimentazione deve avere una spina dotata di messa a terra a due o tre poli. Il terzo polo costituisce un'importante
funzionalita di sicurezza. Non rinunciare al suo impiego. Se non € disponibile una presa compatibile, farne installare una da un
elettricista qualificato.

* Quando si desidera scollegare il cavo dell'alimentazione, accertarsi di scollegarlo toccando la testa della spina, non il suo cavo.

»  Accertarsi che la presa e ogni prolunga utilizzata siano in grado di supportare il carico di corrente totale risultante da tutte le
periferiche collegate.

«  Primadi pulire il computer, assicurarsi di scollegarlo da qualsiasi sorgente di alimentazione esterna.

SN
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Avviso Sicurezza Alimentazione

Prima di effettuare qualsiasi procedura di aggiornamento, accertarsi di aver spento il computer e di aver scollegato tutti i cavi e le
periferiche (incluse le linee telefoniche). E inoltre consigliabile rimuovere la batteria al fine di evitare I'accensione accidentale del

computer.
Spegnimento prima di un viaggio
Assicurarsi che il notebook sia completamente spento prima di inserirlo in una borsa da viaggio (o in un contenitore simile). Inserendo

un computer ancora acceso in una borsa da viaggio, la (le) ventola (ventole) ne saranno ostruite. Per evitare il surriscaldamento del
computer, accertarsi di non ostruire la (le) ventola (ventole) quando il computer & in uso.

Pulizia
Non applicare alcun detergente direttamente sul computer, utilizzare solo un panno morbido e pulito. Non utilizzare
detergenti volatili (distillati di petrolio) o abrasivi su qualsiasi parte del computer.

.|
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Precauzioni relative alla batteria

Utilizza unicamente batterie progettate per questo computer. Un tipo di batteria errato potrebbe esplodere, avere perdite o
danneggiare il computer.

Non continuare a usare in alcun modo una batteria che sia caduta in terra o che sembri danneggiata (es. piegata o torta).
Anche se il computer continua a funzionare con una batteria danneggiata, questa pud provocare danni ai circuiti risultanti in
pericolo di incendio.

Ricaricare le batterie utilizzando il sistema del notebook. Un'operazione di ricarica non corretta puo far esplodere la
batteria.

Non provare a riparare il pacco batteria. Fare riferimento sempre all'assistenza tecnica o a personale qualificato per la
riparazione o la sostituzione del pacco batteria.

Tenere i bambini lontani da una batteria danneggiata e provvedere tempestivamente al suo smaltimento. Smaltire sempre
con cura le batterie. Le batterie possono esplodere o presentare perdite se esposte a fuoco oppure se manipolate o smaltite
impropriamente.

Tenere la batteria lontana da qualsiasi apparecchio di metallo.

Apporre del nastro adesivo sui contatti della batteria prima di smaltirla.

Non toccare i contatti della batteria con le mani o con oggetti metallici.

N A
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Smaltimento della batteria & Attenzione

Il prodotto acquistato contiene una batteria ricaricabile. La batteria € riciclabile. Al termine della durata di uso, in base alle diverse
leggi locali e statali, puo essere illegale smaltire questa batteria insieme ai rifiuti comuni. Controllare i requisiti previsti nella propria

zona consultando i funzionari locali addetti allo smaltimento dei rifiuti solidi per le opzioni di riciclo o lo smaltimento corretto.
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Pericolo di esplosione in caso sostituzione errata della batteria. Sostituire solamente con lo stesso tipo o con uno analogo
raccomandato dal produttore. Eliminare la batteria usata seguendo le istruzioni del produttore.
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Differenze dei modelli

Questa serie di notebook comprende quattro tipi di modelli differenti (ciascun modello comprende diversi stili di design).
L'aspetto esteriore definitivo e alcuni pulsanti Hot-Key possono apparire leggermente diversi da quelli illustrati in questo
manuale. Tuttavia tutte le porte, i componenti, le funzioni e cosi via sono le stesse per tutti gli stili di design. Le differenze
tra i modelli sono riportate nella tabella seguente.

Funzionalita Modello A Modello B Modello C Modello D
Logica del core Intel(R) GM45 + ICH9M Chipset Intel(R) PM45 + ICH9M Chipset
Scheda Video Video integrato Intel (interno sul chip) Video discreto NVIDIA (esterno su scheda)
Adattatore CA/CC 65W (Uscita CC 19V, 3,42A o 18,5V, 3,5A) 90W (Uscita CC 19V, 4,74A)
Tipo di schermo " 15,4" WXGA/ WXGA+/ " 15,4" WXGA/ WXGA+/
LCD 14,1" WXGA/ WXGA+ WSXGA+ 14,1" WXGA/ WXGA+ WSXGA+

Tabella 1 - Differenze dei modelli
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Gmda di avvio rapido

Eliminare tutti i materiali di imballo.
Appoggiare il computer su una superficie stabile.
Collegare bene le periferiche che si desidera usare con il notebook (per esempio tastiera e mouse) alle porte corrispondenti.

Collegare l'adattatore CA/CC al jack di ingresso CC situato alla sinistra del computer, quindi inserire il cavo di alimentazione CA in
una presa e collegare il cavo di alimentazione CA all'adattatore CA/CC.

5. Con una mano sollevare con cautela il coperchio/LCD fino a un angolo di visione comodo (non superare i 130 gradi), mentre con
I'altra mano (come illustrato nella seguente Figura 1) si mantiene la base del computer (nota: non sollevare mai il computer
tenendolo dal coperchio/LCD).

6. Premere il pulsante di alimentazione per accendere.

P wnhPRE

Spegnimento

E importante tenere presente che & sempre necessario spegnere il computer scegliendo il comando Arresta il sistema dispo-

prsy
D
! e . er coma 11 SISe D
nibile dal menu del pulsante Blocca di Windows Vista. In questo modo si evitano problemi al sistema o al disco rigido. >
@)

Figura 1 - Apertura del coperchio/LCD/Computer con alimentatore AC/DC collegato
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Software del sistema Sistemi operativi supportati

E possibile che il software sia gia pre-installato sul

computer. In caso contrario, oppure in casi di Sistema Nota
riconfigurazione del computer per un sistema diverso, operativo

questo manuale si riferisce al sistema operativo Microsoft Windows XP Per informazioni sul SO Windows XP
Windows Vista. Ulteriori informazioni sull’installazione di (Home Edition o | consultare il CD-ROM Device Drivers &
driver e utilita sono disponibili nei Capitoli 4 & 7 del Professional) Utilities + User’s Manual.

Manuale per I’utente esteso oppure nel CD-ROM Device

. —_ i Accertarsi di installare il Service Pack 1
Drivers & Utilities + User’s Manual.

Windows Vistacon | di Windows Vista (o una versione di
Service Pack 1 Windows Vista che include il Service

(64-bit) Home Pack 1) prima di installare qualsiasi
/ Basic Editon/ driver. Andare al sito web della Micro-
Home Premium soft per i dettagli relativi al download, o
Driver Editon/Business rivolgersi al proprio centro servizi.
Se si sta installando/disinstallando un nuovo software di siste- Editon Per avviare Windows Vista senza limi-
ma, sara necessario installare i driver appropriati. | driver sono [Enterprise Editon/ | tazjoni o prestazioni inferiori, € necessa-
programmi che agiscono da interfaccia tra il computer e il com- Ultimate Editon rio che il computer disponga di almeno
ponente hardware (ad es. il modulo di rete wireless). E molto 1GB di memoria di sistema (RAM).

importante installare i driver nell'ordine elencato nella
Tabella 5 a pagina 199. Non sara possibile utilizzare la mag-
gior parte dei controlli avanzati finché i driver e le utilita neces- NO n | nc | uso
sarie non sono state correttamente installate.

| sistemi operativi (per esempio Windows Vista/Windows
XP) sono dotati di manuali propri, come pure le
applicazioni (per esempio, programmi di elaborazione
testo, fogli di calcolo e database), quindi consultare i
manuali specifici.

o
c
&
'
=

184 - Software del sistema



Guida Rapida per I'Utente

Descrizione del sistema: Vista anteriore con
pannello LCD aperto (Modelli A & C)

Figura 2
Vista anteriore con pan-

nello LCD aperto
(Modelli A & C)

711/( 1. Camera PC opzionale
Funzionamento del dispositivo 2. Schermo LCD
senza fili a bordo di un aereo 3. Altoparlanti incorporati
. , . o 4. Pulsante di
S_olltarrjgnte | uso o] qgalgasn alimentazione
dispositivo di trasmissione .
elettronica e proibito a bordo di un 5. Puls.antl Hot-Key
aereo. Accertarsi che i moduli 6. Tastiera
wireless siano spenti quando si 7. Microfono incorporato
utilizza il computer in aereo. 8. TouchPad e pulsanti
Utilizzare la combinazione di tasti 9. Lettore d'impronte digitali
appropriata per disattivare i moduli (opzionale)
WLAN/Bluetooth/3.5G e verificare 10. Indicatori LED

stato e licona

l'indicatore di
nell'area di notifica per accertarsi
che i moduli siano spenti (vedere

(area operativa valida)

=
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Pulsanti TouchPad
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Figura 3
Vista anteriore con pan-
nello LCD aperto
(Modelli B & D)

Camera PC opzionale
Schermo LCD
Altoparlanti incorporati
Pulsante di
alimentazione
Pulsanti Hot-Key
Tastiera

Microfono incorporato
TouchPad e pulsanti
Lettore d'impronte digitali
(opzionale)

10. Indicatori LED

PwbnPE

© N O;

Pulsanti TouchPad
(area operativa valida)
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Descrizione del sistema: Vista anteriore con
pannello LCD aperto (Modelli B & D)

SE

2L &
Funzionamento del dispositivo
senza fili a bordo di un aereo

Solitamente l'uso di qualsiasi
dispositivo di trasmissione
elettronica e proibito a bordo di un
aereo. Accertarsi che i moduli
wireless siano spenti quando si
utilizza il computer in aereo.

Utilizzare la combinazione di tasti

appropriata per disattivare i moduli
WLAN/Bluetooth/3.5G e verificare
lindicatore di stato e licona
nell'area di notifica per accertarsi
che i moduli siano spenti (vedere




Indicatori LED

Gli indicatori LED sul computer segnalano importanti informazioni relative allo stato corrente del computer.

Tabella 2 - Indicatori LED di stato

Guida Rapida per I'Utente

Icona Colore Descrizione Icona | Colore Descrizione
Arancione | L'alimentatore é collegato Arancione | La batteria & in carica
Verde Il computer & acceso Verde Batteria completamente carica
DY) 1
Aran- . . .
Verde lam- L . . . La batteria ha raggiunto lo stato critico
. Il computer € in modalita Sospensione cione lam- S
peggiante . di carica bassa
peggiante
La funzione blocco numerico (tastierino == . L
Verde - . Verde Il disco rigido € in uso
Iﬁ numerico) € attivata O
Verde Bloc Maiusc é attivato Verde Il modulo LAN Wireless € attivo
‘)
@l Verde Bloc Scorr € attivato Arancione | Il modulo Bluetooth € attivo

Indicatori LED - 187
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Pulsanti Hot-Key & tastiera

I pulsanti Hot-Key forniscono accesso immediato al
browser Internet predefinito e al programma di posta
elettronica. Inoltre consentono di attivare/disattivare la
Modalita silenziosa con la pressione di un pulsante quick.

Tabella 3 - Pulsanti Hot-Key

Pulsante
Hot-Key

oy

Funzione

Attivare il programma di posta elettronica
predefinito

Attivare il browser Internet predefinito

Attivazione/disattivazione modalita silen-
ziosa* (per risparmio energetico)

Y

*Quando attivata, la Modalita silenziosa riduce il rumore
della ventola e consente di ridurre il consumo energetico.
Tuttavia & possibile che le prestazioni del computer
subiscano un calo.

188 - Pulsanti Hot-Key & tastiera

Nella tastiera é stato integrato un tastierino numerico per un
facile inserimento dei numeri. Dispone anche di tasti
funzione che consentono di cambiare istantaneamente le
funzionalita operative (vedere la Figura 4).

Figura 4 - Tastiera

R S| Tasti funzione [ kel (RS}

Attiva/disattiva S
modulo 3.5G

A s D F G H J [ .
8 Tastierino numerico =

o (12 12 [11% (1 [[1v [1i8 [[[N [TIMEEE T =¥ o t

< ' . - Fagt

-} -
- o |t |

4

Caratteri speciali

Alcune applicazioni software consentono di utilizzare i tasti
numerici insieme al tasto Alt per produrre caratteri speciali.
Tali caratteri speciali possono essere riprodotti solo utiliz-
zando il tastierino numerico. | tasti numerici regolari (nella
riga superiore della tastiera) non funzionano. Accertarsi che
sia attivo il Bloc Num (tastierino numerico).




Tasti funzione/indicatori visivi
| tasti funzione (da F1 a F12) agiscono come Hot-Key quando premuti tenendo premuto il tasto Fn. In aggiunta alle
combinazioni di tasti funzione base, quando é installato il driver hot key (HotKey Driver) sono disponibili gli indicatori
visivi (vedere “Hot-Key” a pagina 201). Dopo aver installato il driver, nella barra delle applicazioni appare I'icona ¥
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Tasti Funzione/indicatori visivi Tasti Funzione/indicatori visivi
. . S Riduzione/Aumento
Fn+~ Play/pausa (nei programmi Audio/Video) Fn + F8/F9 luminosita LCD
" Attiva/disattiva | Attiva/disattiva . )
Fn+ | modulo 3.5G i ,0 : ,,G Fn+F10 | cameraPC " ,,‘W"ﬂ S _“"&
Attiva/disattiva Tou- — = Attiva/disattiva LAN D P
Fn * Fl Chpad @ ;\\\Q_ Fn ¥ Fll WIrE|eSS . mmngl) . Rm:uuuni
Spegne la retroilluminazione dello schermo LCD . L
Fn+F2 | (premere un tasto o utilizzare il TouchPad per Fn+F12 gltﬂ\é%gltiattlva .
ripristinare lo schermo) L Tmem T et
Commutazione Fn + Bloc | Attiva/disattiva blocco numerico (tastierino nume-
Fn+F3 | ® .
Mute ; - Num rico)
Volume * On Volume ¥ Mute
. . Fn + Bloc . T .
Fn+F4 Commutazione Sospendi Scorr Attiva/disattiva il blocco dello scorrimento
Fn + F5/ | Riduzione/Aumento Attiva/disattiva la Normal Silent
F6 volume audio Aatsaiariiaiaing ] (@ modalita silenziosa mode’ mode
Fn+F7 | Commutazione Display Tabella 4 - Tasti funzione e indicatori visivi

Pulsanti Hot-Key & tastiera - 189
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Figura 5 Descrizione del sistema: Vista anteriore e

Vista anteriore e sinistra SINistra
Indicatori LED

Jack uscita delle cuffie Lato anteriore

Porta per monitor esterno 1

Jack di rete tipo RJ-45
Porta eSATA

Porta uscita HDMI
Ventola

2 Porte USB 2.0

Slot ExpressCard/54(34)
10 Lettore di schede 7-in-1

©ONOO P~ WDNPE

Lettore di schede 7-in-1
Il lettore di schede consente di utilizzare alcune tra le piu recenti schede di memoria digitali.

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) /
MS Pro (Memory Stick Pro) / MS Duo (richiede PC adattatore) /
Mini SD (richiede PC adattatore) / RS MMC (richiede PC adattatore)

Porta eSATA

o
c
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Si noti che il driver Intel Matrix Storage € necessario per attivare la porta eSATA (vedere “Sup-
porto porta eSATA” a pagina 210).
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Descrizione del sistema: Vista destra e posteriore

Figura 6
Vista destra e
posteriore

Lato destro

1. Jack uscita S/PDIF

2. Jack ingresso del
microfono

3. Jack uscita delle cuffie

4. PortaUSB 2.0

5. Bay unita ottica (per
periferiche CD/ DVD)

Espulsione di emergenza €D Modifica dei Codici Regionali dei DVD 6. Foro di espulsione di
o _ - emergenza
Se si desidera estrarre manualmente un CD/ Aprire il Pannello di controllo, fare doppio clic su 7. Jack telefonico tipo RJ-
DVD (per esempio a causa di un‘inaspettata fGestl(I)_ne dIISpOSItIVI (Hardware e syf)nl;))\./g;ungl 11
interruzione dell'alimentazione) & possibile ElS (18 L dsegpo T acclfimto a\_f Uitz o 8. Slot blocco di sicurezza
spingere l'estremita di una graffetta per IO Fare REEpl 18 aule prmEdes DD Eeh 9 Batteri
per visualizzare il menu Proprieta, quindi selezio- - batteria

carta raddrizzata nel foro di espulsione di
emergenza. Non usare una matita appuntita
0 un oggetto analogo che potrebbe rompersi
oppure rimanere incastrato nel foro. La rilevazione regionale DVD dipende dal disposi-
tivo e non dal sistema operativo. E possibile sele-

Avvertenza supporti zionare il codice regionale del modulo 5 volte. La

. . quinta selezione & permanente. Non pud essere

Non cercare di estrarre un disco floppy/CD modificata anche cambiando il proprio sistema

durante I'accesso del sistema. Cio puo operativo, oppure usando il modulo in un altro com-
provocare un arresto del sistema. puter.

nare la scheda Regione DVD per avviare il pannel-
lo che consente di selezionare il codice regionale.
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Figura 7 Descrizione del sistema: Vista inferiore

Vista inferiore

\ 7/
1. Batteria ’ﬁl\

2. Coperchio modulo CPU
BIuetooth La CPU non & un componente che 3
3. Coperchio bay CPU/ necessita  assistenza da  parte
RAM dellutente. Accedere alla CPU in 4 Modelli A & C
4. \entola qualsiasi modo implica una violazione
5. Coperchio bay disco della garanzia.
rigido
6. Posizione scheda USIM Surriscaldamento
3.5G

Per prevenire il surriscaldamento del
computer, accertarsi che non vi sia nulla
che ostruisca la (le) ventola (ventole)
durante I'uso del computer.

4

Informazioni sulla batteria

3

yil
Prima di utilizzare una batteria nuova, Modelli B & D
scaricarla prima completamente, quindi

caricarla al massimo. Scaricare comple-
tamente e caricare la batteria almeno
una volta ogni 30 giorni oppure dopo una

o
=
@©
©
=
ventina di cariche parziali.
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Menu Start e Pannello di controllo di Windows Vista

La maggior parte dei pannelli di controllo, utilita e programmi che compongono Windows Vista (e la maggior parte delle
versioni di Windows) sono accessibili tramite il menu Start. Quando si installano programmi e utilita, essi vengono
installati sul disco rigido, mentre un collegamentoche punta ad essi viene inserito nel menu Start e/o sul desktop. Fare clic
con il tasto destro sull'icona &, del menu Start quindi selezionare Proprieta per personalizzare I'aspetto del Menu Start.

= * | i— | P ==
Apri | 'S ) et i a= w@ Programmi predefint Rl E .
] < e 1 H
Fy Internet 2 I .
Ecplos D e tain ED Windors e T ] B
Cerca... '-' Posta elettronica @
Proprieta ot m Progiammi i e
Apri cartella Utenti '*,“' Datirecenti L3 b I
Esplora cartella Utenti @

4

raY | Connessioni di rete
1] }J Cera H
Y, & Stampanti

> @ Guidaesupportotecnico |, Baa delle spplicaion emenu Stat
- |

oo v ki T o R

B dude picamr | T drvs s | B gt pvumers

5] Eequi.

B [0 cricisesione..

wEe

e il

1 . . .
Fare clic qui per passare alla Visua-
lizzazione classica

»  Tumi progammi

Figura 8 - Menu Start & Pannello di controllo

In molte sezioni del presente manuale I'utente avra modo di notare riferimenti al Pannello di controllo. Al Pannello di
controllo é possibile accedere attraverso il menu Start. Il Pannello di controllo consente di configurare le impostazioni
per la maggior parte delle funzionalita principali presenti in Windows (ad es. alimentazione, video, rete, audio, ecc.). Win-
dows Vista fornisce pannelli di controllo di base per molte delle funzionalita, tuttavia molti altri pannelli di controlli ven-
gono aggiunti (o quelli esistenti migliorati) quando si installano i driver elencati nella Tabella5 a pagina 199. Per
visualizzare tutti i controlli potrebbe essere necessario attivare la visualizzazione classica.

. |
Menu Start e Pannello di controllo di Windows Vista - 193
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Funzioni video

Questo computer presenta due opzioni video differenti (Intel per Modelli A & B 0 NVIDIA per Modelli C & D). E
possibile modificare le Impostazioni di visualizzazione dal pannello di controllo Impostazioni schermo (in
Personalizzazione) in ambiente Windows Vista o dal pannello di controllo Intel GMA Driver for Mobile/Pannello di
controllo NVIDIA.

Per accedere alle Impostazioni schermo in Window Vista:

1. Fare clic su Start, e fare clic su Pannello di controllo (oppure scegliere Impostazioni e fare clic su Pannello di controllo).

2. Fare clic su Modifica risoluzione dello schermo nel menu Aspetto e personalizzazione menu (o fare doppio clic
personalizzazione > Impostazioni schermo).

3. Scorrere l'indicatore nella posizione desiderata in Risoluzione o (vedere la Figura 9 a pagina 195).
Fare clic sulla freccia e selezionare l'impostazione desiderata in Colori 9 (vedere la Figura 9 a pagina 195).

5. Fare clic su Impostazioni avanzate... 9 (vedere la Figura 9 a pagina 195) per visualizzare le schede delle Impostazioni
avanzate.

Per accedere al pannello di controllo Intel GMA Driver for Mobile (Modelli A & B):

1. E possibile accedere al pannello di controllo Intel GMA facendo clic sullicona nella barra delle applicazioni e selezionando
Proprieta grafiche dal menu (oppure da Intel GMA Driver for Mobile nel Pannello di controllo di Windows).

Per accedere al Pannello di controllo NVIDIA (Modelli C & D):

1. E possibile accedere al Pannello di controllo NVIDIA facendo clic con il pulsante destro del mouse sul desktop e scegliendo
Pannello di controllo NVIDIA (oppure da NVIDIA Control Panel nel Pannello di controllo di Windows).
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Proprieta grafiche...
‘ ~~Swaicni graficke— »

Esci dall'area di notifica

|l Intel* Graphics Media -
| Accelerator Driver intel

L 2 pigas fu | for mobile

Visualizza 3

Ordina per L
Aggiorna

Incolla

Incolla collegamenta

Pannello di controllo NVIDIA

Nuovg 3

. ] M M
Fs, Personalizza
1686 pn 550 1

Figura 9 - Impostazioni schermo & pannello di controllo Intel GMA Driver for Mobile/Pannello di controllo NVIDIA

Collegamento di un altro schermo

Oltre allo schermo LCD integrato, € possibile utilizzare una periferica di visualizzazione esterna quale un monitor/schermo
piatto/TV (TV solo tramite la porta uscita HDMI) collegato alla porta per monitor esterno o alla porta uscita HDMI (High-
Definition Multimedia Interface).

Funzioni video - 195
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Funzionalita audio

E possibile configurare le opzioni audio del computer dal
pannello di controllo Audio “? di Windows, oppure
dall'icona Gestione Audio Realtek HD gjil/@ nell'area
di notifica/pannello di controllo (fare clic con il pulsante
destro del mouse sull'icona gfij per aprire un menu audio).
I volume pud essere regolato anche con la combinazione di
tasti Fn + F5/F6.

"\J] Gestione Sonoro
vz Dispositivi audio /

% Eventi sistema sonoro
@ Windows Media Player

Regolazione del volume
audio

Il livello del volume del suo-

f._',g Controllo volume no viene impostato utiliz-
= . .
: _ zando il comando di
§ et regolazione volume di Win-
T B P P dows (e i tasti funzione vo-
lume sul computer). Fare

Fare clic con il clic sull'icona Volume nella

barra delle applicazioni per

pulsante destro del 9 _
controllare I'impostazione.

mouse sull'icona Ej
per accedere al
menu sopra.

Configurazione audio HDMI

Dato che HDMI (High-Definition Multimedia Interface)
trasporta segnali sia audio che video sara necessario
configurare l'uscita audio secondo le istruzioni seguenti.

Configurazione audio di Windows per HDMI

1. Collegare un dispositivo con supporto HDMI alla porta
uscita HDMI.

2. Fare clic su Start, e fare clic su Pannello di controllo
(oppure scegliere Impostazioni e fare clic su Pannello di
controllo).

3. Fare clic Audio 2 (Hardware e suoni).

4. Fare clic Riproduzione (scheda), e fare clic per
selezionare Periferica HDMI (Modelli A & B)/NVIDIA
HDMI Output (Modelli C & D).

5. Fare clic Predefinito (pulsante).

6. Fare clic su OK per chiudere il pannello di controllo Audio

7. Sara ora possibile ascoltare le sorgenti audio quando
riprodotte in Windows Media Player.

196 - Funzionalita audio
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Facendo clic sull'in-
dicatore del volume
nell'area di notifica
B quando si sele-
ziona  Periferica
HDMI si notera che
l'icona nella parte
alta dell'indicatore
di livello del volu-
me & cambiata.

Facendo clic sull'in-
dicatore del volume
nell'area di notifica

quando si selezio-
na NVIDIA HDMI
Output si notera che
l'icona nella parte
alta dell'indicatore di
livello del volume &
cambiata.

Figura 10 - Periferica HDMI/NVIDIA HDMI Output
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Note su HDMI

Collegare un dispositivo con supporto HDMI alla porta
uscita HDMI PRIMA di provare a riprodurre sorgenti
audio/video tramite il dispositivo.

Scollegando il cavo HDMI dal dispositivo di riprodu-
zione audio predefinito non sara possibile ripristinare gli
altoparlanti finché il computer non sara stato riavviato
(per non riavviare il computer aprire il pannello di con-
trollo Suoni e selezionare Altoparlanti come dispositivo
di riproduzione audio predefinito).

Funzionalita audio - 197
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Funzioni di risparmio energetico

Il pannello di controllo delle Opzioni risparmio energia (menu Hardware e suoni) di Windows (vedere la pagina 193)
consente la configurazione delle funzioni di risparmio energetico del computer. Selezionando Risparmio di energia &
possibile attivare questa funzione e configurare le opzioni relative al pulsante di alimentazione, pulsante di sospensione,
coperchio del computer (chiuso), schermo e modalita sospensione. Nota: la funzione Risparmio di energia pud influire
sulle prestazioni del computer.

Fare clic su una delle combinazioni esistenti o su Crea combinazione per il risparmio di energia sul menu di sinistra e
personalizzarla per creare una nuova combinazione. Fare clic su Modifica impostazioni combinazione, quindi su Cambia
impostazioni avanzate risparmio energia per accedere a ulteriori opzioni di configurazione.

BN g hats S0y 51 | @ = opoon mpmio s+ Ipetacon s ~Talle "

& attivare la protezione con password

Selezionare una combinazione per il risparmio di energia

desicusste par d computis in i, Lo msdiiche appostate sl

o

c
=
'
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Nota: Sospensione € lo stato di risparmio di energia predefinito per Window Vista

Figura 11 - Opzioni risparmio energia

.|
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Installazione driver

Il CD-ROM Device Drivers & Utilities + User’s Manual
contiene i driver e le utilita necessari per il corretto
funzionamento del computer. Inserire il CD-ROM e fare
clic su Install Drivers (pulsante), oppure il pulsante
Option Drivers per accedere al menu del driver opzionale.

Installare i driver attenendosi all'ordine indicato nella
Tabella 5. Dopo l'installazione di ciascun driver, lo stesso
viene oscurato (se occorre reinstallare uno dei driver, fare
clic sul pulsante Unlock).

Installazione manuale dei driver

Fare clic sul pulsante Browse CD (Sfoglia CD)
nell'applicazione Drivers Installer e selezionare il file
eseguibile nella cartella del driver corrispondente.

Windows Update

Dopo l'installazione di tutti i driver assicurarsi di aver
attivato Window update per ottenere tutti i recenti
aggiornamenti di sicurezza ecc. (tutti gli aggiornamenti
includeranno i piu recenti hotfixes di Microsoft).

Guida Rapida per I'Utente

Driver (Windows Vista con SP1) Pagina#
Chipset pagina 200
Video pagina 200
Audio pagina 200
Modem pagina 200
Rete (LAN) pagina 200
TouchPad pagina 200
Lettore di schede pagina 201
Hot-Key pagina 201
Supporto per eSATA pagina 210
Camera PC (opzione) pagina 201
Modulo 3.5G (opzione) pagina 205
Modulo LAN Wireless (opzione) pagina 209
Modulo Intel Turbo Memory (opzione) pagina 210
Lettore d’'impronte digitali (opzione) pagina 211
Bluetooth (opzione)

Nota: Non & necessaria nessuna installazione i driver (vedere
la pagina 213)

Attivare Window update (vedere a sinistra)

Tabella 5 - Procedura di installazione

Installazione driver - 199
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Trovato nuovo hardware Audio

Se compare [I’installazione guidata Trovato nuovo 1. Fareclic su 3.Install Audio Driver > Si.
hardware durante la procedura di installazione, fare clicsu 2. Fare clic su Avanti.

Annulla per chiudere I’installazione guidata e seguire la 3. Fare clic su Fine per riavviare il computer.
procedura di installazione come descritto.

. Modem
Chlpset 1. Fare clic su 4.Install Modem Driver > Si.
1. Fare clic su 1.Install Chipset Driver > Si. 2. Fare clic su OK.
2. Fare clic su Avanti > Si > Avanti > Avanti. 3. I modem ¢ pronto per la configurazione della
3. Fare clic su Fine per riavviare il computer. connessione.
Video Rete (LAN)
1. Fare clic su 2.Install Video Driver > Si. 1. Fare clic su 5.Install LAN Driver > Si.

. . 2. Fare clic su Avanti > Installa.

Modelli A & B (Intel): 3. Fare clic su Fine.

2. Fare clic su Avanti > Si > Avanti > Avanti.

. . T 4. Ora e possibile configurare le impostazioni di rete.
3. Fare clic su Fine per riavviare il computer.

Modelli C & D (NVIDIA): TouchPad
4. Fare clic su Avanti. 1. Fare clic su 6.Install Touchpad Driver > Si.
5. Fare clic su Fine per riavviare il computer. 2. Fare clic su Avanti.

3. Fare clic su Fine > Riavvia ora per riavviare il computer.
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Lettore di schede

1. Fare clic su 7.Install Cardreader Driver > Si.
2. Fare clic su Avanti > Installa.

3. Fare clic su Fine.

Hot-Key

1. Fare clic su 8.Install Hotkey Utility > Si.

2. Fare clic su Next > Install.

3. Fare clic su Finish > Finish per riavviare il computer.

Supporto per eSATA

Vedere “Configurazione e installazione del driver Intel
Turbo Memory e Matrix Storage” a pagina 210 per le
istruzioni su come installare questo driver per abilitare la
porta eSATA.

Guida Rapida per I'Utente
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Camera PC

Il modulo camera PC utilizza I'applicazione BisonCap per
catturare i file video.

\ A/

2

Informazioni piu recenti sui driver della camera PC

Verificare sul disco Device Drivers & Utilities + User's Manual, e

su qualsiasi inserto a corredo, la presenza di informazioni
recenti relative al driver della camera PC che potrebbero
differire da quelle fornite in questo documento in quanto piu
aggiornate.

Installazione del driver della camera PC

1. Accendere il modulo con la combinazione Fn + F10
('indicatore visivo .© @ viene visualizzato per breve
tempo quando il modulo & acceso).

Fare clic su Option Drivers (pulsante).

Fare clic su 1.Install WebCam Driver > Si.

Scegliere la lingua desiderata e fare clic su Avanti.
Fare clic su Avanti > Fine per riavviare il computer.
Eseguire I'applicazione BisonCap dal collegamento sul
desktop oppure dalla voce BisonCam del menu Start >
Programmi/Tutti i programmi (se I'hardware é spento,
utilizzare la combinazione di tasti Fn + F10 per
riaccenderlo).

ok wd

Configurazione audio della camera PC

Configurare le opzioni di registrazione audio in Windows
per catturare video e audio con la camera.

1. Fareclic su Start, e fare clic su Pannello di controllo
(oppure scegliere Impostazioni e fare clic su Pannello di
controllo).

2. Fare clic Audio ** (Hardware e suoni).

3. Fare clic Registrazione (scheda).

4. Fare clic con il pulsante destro del mouse su Microfono
(Realtek High Definition Audio) et accertarsi che la voce non
sia disabilitata.

5. Fare doppio clic su Microfono (o selezionare Proprieta dal
menu di scelta rapida ottenuto con il tasto destro del mouse).

6. Scegliere Livelli (scheda) e regolare i cursori Microfono e
Preamplificazione microfono) per ottenere il livello richiesto.

7. Fare clic su OK, quindi chiudere i pannelli di controllo.

8. Awviare il programma BisonCap dal menu Start >
Programmi/Tutti i programmi > BisonCam.

9. Aprire il menu Dispositivi e selezionare Microfono (Realtek,
ecc.) (accanto ad esso dovrebbe essere presente un segno di
spunta).

10. Aprire il menu Cattura e selezionare Audio cattura (accanto
ad esso dovrebbe essere presente un segno di spunta).

202 - Camera PC
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BisonCap Zoom

L’applicazione BisonCap & un utile visualizzatore video !l programmi BisonCap consente di ingrandire e ridurre
per la visualizzazione e il test di video generali, ed & inoltre ~ con la camera.

in grado di catturare file video in formato .avi. 1. Awviare il programma BisonCap.

1. Awviare il programma BisonCap dal menu Start > 2. Aprire il menu Zoom e selezionare Nagyitas/Kicsinyités.

Programmi/Tutti i programmi > BisonCam (si consiglia di ) S
Impostare Cattura File prima del processo di cattura - vedere Prendere im magini fisse

"Imposta cattura file" di seguito). Il programmi BisonCap consente di prendere immagine
2. Aprire il menu Cattura (se si desidera catturare file di audio fisse.
vedere “Configurazione audio della camera PC” a
pagina 202) e selezionare Avvia cattura. 1. AwviareilprogrammaBisonCap.
3. Fare clic su OK (la collocazione del file verra visualizzata nella 2. Aprire il menu Opzioni e selezionare Scatta foto.
casella a scomparsa), per avviare la cattura, quindi premere 3. La fotografia (in formato JPEG) viene inserita nella cartella
Esc per interromperla (€ possibile visualizzare il file Snapshot & del desktop (non rimuovere o rinominare la
utilizzando Windows Media Player). cartella).

Imposta cattura file

Prima di effettuare la cattura dei file di video si puo selezionare
I'opzione Imposta file di cattur nel menu File e impostare il
nome del file e la collocazione prima della cattura (questo
contribuira a evitare la sovrascrittura dei file). Impostare il
nome e la collocazione poi cliccare Apri, quindi impostare la
"dimensione del file di cattura:" e cliccare "OK". Quindi ¢
possibile avviare il processo di cattura di cui sopra.
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Eliminazione dello sfarfallio dello schermo
Se la schermata del video nel programma BisonCap ha uno
sfarfallio, & possibile provare a regolare I'impostazione
nelle opzioni Video Capture Filter (filtro di cattura
video).

1. Awviare il programma BisonCap.
Aprire il menu Options e selezionare Video Capture Filter....

3. Scegliere 50Hz oppure 60Hz sotto Frequenza nella scheda
Pagina delle proprieta.

Riduzione delle dimensioni dei file video

Si noti che la cattura di file video ad alta risoluzione
richiede una grande quantita di spazio sul disco rigido per
ogni file. Dopo aver registrato il video, controllare le
dimensioni del file video (fare clic con il pulsante destro del
mouse sul file e scegliere Proprieta) e lo spazio libero
rimanente sul disco rigido (aprire Computer, fare clic con
il pulsante destro del mouse sul disco rigido e scegliere
Proprieta). Se necessario € possibile spostare il file video
registrato su un supporto rimovibile, ad esempio CD, DVD
0 unita flash USB.

Si noti che il sistema operativo Windows Vista richiede
almeno 15GB di spazio libero sulla partizione di sistema
dell'unita C:. Per evitare problemi al sistema si consiglia di

salvare il file del video in una posizione diversa dall'unita
C: (vedere “Imposta cattura file” a pagina 203), limitare
le dimensioni dei file del video catturato o ridurre la
risoluzione del video.

Per ridurre le dimensioni della risoluzione di ou-

tput del video

1. Eseguire il programma BisonCap.

2. Aprire Opzioni e scorrere in giu per selezionare Video
Capture Pin....

3. Scegliere I'elenco Dimensioni output e selezionare una
risoluzione inferiore per ridurre le dimensioni del file
catturato.
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Modulo 3.5G

Se nell'opzione di acquisto ¢ stato incluso un modulo 3.5G
opzionale, seguire le istruzioni sotto per installare la carta
USIM (presumibilmente fornita dal proprio operatore),
quindi installare I'applicazione.

\ A/
RS
Avviso Sicurezza Alimentazione

Prima di effettuare qualsiasi procedura di aggiornamento, Figura 12 - Rimozione del coperchio della carta SIM
accertarsi di aver spento il computer e di aver scollegato tutti i
cavi e le periferiche (incluse le linee telefoniche). E inoltre
consigliabile rimuovere la batteria al fine di evitare l'accensione
accidentale del computer.

Inserire la carta USIM come illustrato nella (Figura 13) e

chiudere il FERMO DELLA SIM.

7. Chiudere il FERMO DELLA SIM premendolo nella direzione
della freccia in Figura 13 fino a farlo scattare in posizione di
blocco.

8. Sostituire il coperchio, la vite e la batteria.

1. Spegnere il computer, girarlo e rimuovere la batteria.

2. Individuare il coperchio della carta SIM e svitare la vite 0 in
Figura 12.

3. Rimuovere il coperchio della carta SIM 9 in Figura 12.

4. Inserire la carta USIM nel cellulare, come si farebbe per il
proprio cellulare.

5. Far scorrere il BLOCCO DELLA SIM verso il perno (in
direzione opposta alla freccia raffigurata in Figura 13) per
rilasciare il blocco e sollevare.
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Figura 13 - Inserimento della carta USIM & blocco del
FERMO DELLA SIM
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Applicazione 3G Watcher Configurazione di un profilo carrier

Una volta installati il modulo 3.5G e la carta USIM (forniti ~ Sebbene le informazioni di connessione siano memorizzate
dal proprio operatore) & possibile installare I'applicazione ~ sulla carta USIM fornita dal proprio service provider, sara
3G Watcher. L'applicazione 3G Watcher consente di necessario configurare il profilo carrier appropriato per il
accedere direttamente al servizio Internet 3.5G dal software 3G Watcher.

computer. 1. Utilizzare la combinazione di tasti Fn + per accendere il

Installazione dell'applicazione 3G Watcher modulo 3.5G.

. . . E possibile accedere all'applicazione 3G Watcher dal menu
1. Accertarsi che il modulo sia acceso premendo la P op

binazi di . C (Tindi - & Start (Start > Programmi/ Tutti i programmi > Sierra
combinazione di tasti Fn + - (I'indicatore visivo . | Wireless > 3G Watcher), oppure facendo clic sull'icona

indica lo stato di alimentazione del modulo). nella barra delle applicazioni.
2. Se compare I’installazione guidata “Trovato nuovo 3. Fare clic su Strume... e selezionare Opzioni.
hardware?’, fare clic su Annulla. 4. Fare clic su Profili e quindi su Aggiungi nuovo profilo l._j’

3. Fare clic su Option Drivers (pulsante). (pulsante), e selezionare Profilo WWAN.
4. Fare clic su 2.Install 3G Driver > Si.
5
6

3]

Cpmninerne

. Fare clic su Avanti.
. Fare clic sul pulsante “Accetto i termini del contratto di
licenza”, quindi fare clic su Installa.
7. Allavisualizzazione della schermata successiva attente
circa 2 minuti prima di scegliere Fine (al fine di

Y T

consentire all'hardware di rilevare la presenza del modulo
O 3 5G) .......
c o ~ -
@© 8. L'icona 3G Watcher ﬂ comparira sul desktop. e
o 9. E possibile accedere all'applicazione 3G Watcher dal O
= menu Start (Start > Programmi/ Tutti i programmi > / =

Sierra Wireless > 3G Watcher), oppure facendo clic

. AU Figura 14 - Aggiungi profilo WWAN
sull'icona i nella barra delle applicazioni. g gginare
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5. E quindi possibile inserire un nuovo nome di profilo oppure
scegliere un profilo dall'elenco a discesa visualizzato dal
software.

6. Sceglier Applica > OK per salvare le informazioni.
7. E possibile scegliere il profilo dal menu a discesa.

36 Watoher BEx

Visusli. Strume.

Far EasTone

hung
/4N -Far Eas Tone

WAWAN -Far Eas Tore
e —— WAAN AT & T
W Sun Cellr

Opzioni utente e selezione del profilo

Se si e selezionato il profilo dall'elenco a discesa, la maggior
parte delle informazioni nelle schede Generale e Avanzate
sono state inserite automaticamente (€ comunque opportuno
controllare con il service provider quali sono le informazioni
piu recenti poiché potrebbe essere necessario immettere
Nome utente e Password).

Figura 15 - Opzioni utente e selezione del profilo

Guida Rapida per I'Utente

Connessione al service provider

1.

Utilizzare la combinazione di tasti Fn +
modulo 3.5G.

E possibile accedere all'applicazione 3G Watcher dal menu
Start (Start > Programmi/ Tutti i programmi > Sierra
Wireless > 3G Watcher), oppure facendo clic sull'icona
nella barra delle applicazioni.

Il software si avvia e visualizza il nome del service provider (le
informazioni di connessione vengono lette dalla carta USIM).

- per accendere il

3G Watcher

Visusli.. Stume..

Figura 16

v ore ]
m 3G Watcher

— g

SIERRA WiHELESS

Scegliere Connetti per iniziare il processo di connessione.

L'applicazione 3G Watcher visualizza quindi nella finestra le
informazioni di connessione.

Una volta stabilita la connessione, viene visualizzata una
notifica nella barra delle applicazioni (vedere la figura sotto).

F 99 3¢ watcher
- |
~, ConnessoaFar Eas

Figura 17
Notifica di connes-
sione nell'area di
notifica

= W= 17,54
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10.
11.

12.

13.

14.

A questo punto € possibile accedere a internet, scaricare e-

mail e cosi via, come per qualsiasi altra connessione a

Internet.

Una volta connessi, 'icona nell'area di notifica diventa verde
(e rossa qguando il programma € in esecuzione ma

non c'e connessione).

Per disconnettere, scegliere l'icona Disconnetti.

Il programma disconnette dal service provider.

I modulo resta acceso e occorre premere la combinazione di

tasti Fn +

Facendo clic sullicona di chiusura 3G Watcher [, viene

visualizzato un messaggio che chiede di scegliere OK per

confermare l'uscita dal programma.

ey ==l
Figura 18
Avviso chiusura

s
i
£
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La chiusura del programma NON spegne il modulo 3.5G,
quindi occorre premere la combinazione di tasti Fn + - per
spegnere il modulo (fare particolare attenzione a questo
aspetto quando si € in aereo) - vedere “Funzionamento
delle periferiche Wireless in aereo” a pagina 178).

Se il modulo & acceso e il computer entra in uno stato di
risparmio energetico, lo stato di alimentazione del modulo alla

ripresa dallo stato di risparmio energetico € indicato nella
pagina successiva:

« Se il modulo 3.5G ¢ acceso e il computer &€ Spento/ e si
riavvia il computer, il modulo viene spento all'accensione
del computer.

¢ Se il modulo 3.5G é acceso e il computer entra in modalita
Sospensione/e il computer entra in Ibernazione, il modulo
viene spento quando il computer esce dalla sospensione.

Messaggistica SMS
Oltre ai servizi Internet standard € anche possibile inviare e
ricevere messaggi SMS tramite il programma 3G Watcher.

1.

L'indicatore dei messaggi SMS [ nella finestra
principale avvisa della ricezione di nuovi messaggi.

Fare doppio clic sull'icona [ o selezionare Strume... >
SMS Express....

Selezionare la cartella della posta in arrivo e scegliere un
messaggio da leggere, oppure selezionare File > Nuovo
messaggio di posta oppure scegliere Nuovo per creare un
messaggio nuovo.

Per ulteriori dettagli sugli SMS, vedere 3GWatcher Online
Help (guida in linea) dal menu ? (Guida) > Argomenti
della guida.

. |
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Modulo LAN Wireless

4

Accensione/spegnimento del modulo LAN Wireless

Attivare l'alimentazione al modulo LAN Wireless utilizzando la
combinazione di tasti (Fn + F11). Quando il modulo LAN Wire-
less & acceso, il LED (i) & di colore verde e l'indicatore visivo
.. viene visualizzato per breve tempo.

Installazione del driver del modulo LAN
Wireless

aprwpn PR

Accertarsi che il modulo sia acceso.

Fare clic su Option Drivers (pulsante).

Fare clic su 3.Install Wireless Lan Driver > Si.

Fare clic su Avanti > Avanti.

Fare clic sul pulsante “Accetto i termini del contratto di
licenza™, quindi fare clic su Avanti.

Fare clic su Avanti > Avanti > Fine.

Nota: Il sistema operativo & I'impostazione predefinita per
il controllo LAN wireless in Window Vista.

Modulo LAN Wireless - 209
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Connessione a una rete wireless
Accertarsi che il modulo LAN Wireless sia acceso.

1.

a s v

Fare clic sull'icona della WLAN nella barra delle
applicazioni, e quindi fare clic su Connessione aunarete (0
fare clic con il pulsante destro del mouse sull'icona =, e
quindi fare clic su Connessione a una rete).

Nell'elenco Mostra, scegliere Wireless dal menu a tendina.
Verra visualizzato un elenco delle reti disponibili al momento.
Fare clic su una rete e quindi su Connetti.

In caso non venisse visualizzata una rete alla quale si
desidera connettersi, fare clic su Configura una
connessione o una rete (verra visualizzato un elenco di
opzioni che consente la ricerca manuale e la creazione di una
nuova rete).

Spostare il cursore sull'icona E della barra delle applicazioni
per visualizzare lo stato della connessione.

Per disconnettersi dalla rete wireless & possibile fare clic
sullicona 4, della barra delle applicazioni e selezionare
Connetti o disconnetti... per accedere al menu della rete,
quindi fare clic su Disconnetti (o fare clic con il pulsante
destro del mouse sull'icona |4, e quindi fare clic su
Disconnetti da).
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Modulo Intel Turbo Memory
e

Supporto porta eSATA

Si noti che il driver Intel Matrix Storage € necessario per at-
tivare la porta eSATA anche se nella configurazione acquista-
ta non é stato incluso un modulo Intel Turbo Memory.

Attenersi alla procedura riportata per installare il driver.

Se nell'opzione di acquisto ¢ stato incluso il modulo Intel
Turbo Memory (Robson) sara necessario installare il driver
secondo le istruzioni descritte di seguito (non installare
questo driver in Windows XP).

Intel Turbo Memory Technology (definita anche memoria
flash Robson) & una tecnologia di Intel che riduce il tempo
impiegato da un computer per avviarsi, per caricare le
applicazioni e per scrivere i dati sul disco rigido. Intel
Turbo Memory Technology ¢ supportata solo da Windows
Vista (sono supportate anche funzioni di Windows Vista
quali ReadyBoost, ReadyDrive e Superfetch).

Configurazione e installazione del
driver Intel Turbo Memory e Matrix

Storage

1. Accendere il computer e premere F2 per entrare nel BIOS.

2. Aprire il menu Advanced, selezionare "Installed O/S" e
assicurarsi che l'opzione selezionata sia "Vista".

3. Passare alla voce "SATA Mode Selection” e assicurarsi
che sia selezionato "AHCI".

4. Selezionare "Exit Saving Changes" dal menu EXxit (o
premere F10 e selezionare "Yes", quindi premere Invio) e
premere Invio per uscire dal BIOS e riavviare il computer.

5. Inserire il DVD-ROM Device Drivers & Utilities + User’s

Manual nell’unita CD/DVD.

Fare clic su Option Drivers (pulsante).

Fare clic su 4.Install TM&iIMSM Driver > Si.

Fare clic su Next > Yes > Next > Next.

Fare clic su Finsh per riavviare il computer.

© N

e — === « Windows ReadyBoost - utilizza
@ T la memoria flash come solu-
= zione di cache a disco rigido.
» Windows ReadyDrive - utilizza
le unita ibride come soluzione
di cache a disco rigido.

Abb. 19 - Intel Turbo Memory Console
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Lettore d’impronte digitali

Se nell'opzione di acquisto € stato incluso il lettore di a
impronte digitali sara necessario installare il driver secondo Guida & Manuale

le istruzioni riportate sotto.
P Clic destro sull'icona & della barra delle applicazioni per atti-

Assicurarsi di avere i diritti amministratore sul proprio vl [l el el elleaibue e Stk
computer, _e avere attivato una password di Windows per Inserire il CD-ROM Device Drivers & Utilities + User's Manual
una protezione totale. e fare clic su Option Drivers (pulsante). Fare clic su Unlock

. . . . . . . . (pulsante) et quindi fare clic su 5.Install FingerPrint Driver >
Prima di avviare il processo di registrazione si raccomanda Si
di seguire I'esercitazione per il lettore d’impronte digitali.
Per avviare I'esercitazione fare clic su Start > Programmi/ Cliccare Documentazione per aprire la cartella dove si trova
Tutti i programmi > Protector Suite QL > Esercitazione [GIETVENS () D (EaiE
Flngerprlnt. Per installare Adobe Acrobat Reader per leggere il file, inserire

il CD-ROM Device Drivers & Utilities + User’'s Manual e fare

|nStaI IaZione del d river per |'| m pronta clic su User’s Manual (pulsante), e fare clic su Install Acro-

L. bat Reader (pulsante).
digitale
1. Inserire il CD-ROM Device Drivers & Utilities + User’s

Manual nell’unita CD/DVD. Registrazione utente

2. Fare clic su Option Drivers (pulsante). 1. Fare clic su Start > Programmi/ Tutti i programmi > =
3. Fare clic su 5.Install FingerPrint Driver > Si. Protector Suite QL > Registrazione utente, o fare doppio Q
4. Fare clic su Installazione software. clic sullicona E‘ nella barra delle applicazioni. 5
5. Fare clic su Avanti > Avanti > Avanti. 2. Al primo avvio del programma viene richiesto di fare clic sul >
6. Fare clic su Fine > Si per riavviare il computer pulsante di accettazione della licenza, quindi su OK. o

3. Fare clic su Avanti (viene selezionato automaticamente
"Registrazione nel disco rigido") e fare clic su Fine.

Lettore d’'impronte digitali - 211
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10.

11.
12.

13.
14.
15.

Nel caso non si sia impostata la password Windows apparira
l'invito per farlo (nota: Nel caso non sia stata impostata la
password Protector Suite QL non potra garantire la
sicurezza all'accesso al proprio computer).

Fare clic su Avanti e quindi si viene invitato a inserire la
propria password Windows.

Fare clic su Avanti > Avanti (attivare la cassella "Lancia I’
esercitazione interattiva" per lanciare l'esercitazione
Fingerprint).

Fare clic su Avanti ad ogni finestra dell'esercitazione (si puo
premere il pulsante "Salta esercitazione" in qualsiasi
momento).

Premere il pulsante per ogni impronta per avviare il processo
di registrazione di quell'importa.

Passare l'impronta tre volte per registrare la stessa.

Ripetere I'operazione per tutte le impronte che si desiderano
registrare, quindi fare clic su Avanti.

Fare clic su Fine.

Fare clic su una delle intestazioni sotto "Informazioni su:" per
visualizzare ulteriori informazioni relative a un argomento.
Fare clic su Chiudi.

Riavviare il computer.

Clic destroy sull'icona E| della barra di applicazioni per
attivare il menu che permette la Modifica impronte, lanciare
Control Center, accedere al menu Guida ecc. Si puo inoltre
eseguire il Control Center ecc. dalla voce Protector Suite QL
del menu Start > Programmi/Tutti i programmi.

212 - Lettore d’'impronte digitali

16.

17.

18.

Consultare “Guida & Manuale” a pagina 211 per altri
dettagli.

Se si fa passare il ditto sul lettore ogni volt ache si puo
accedere al Biomenu per bloccare il computer, registrare
siti web, aprire il Control Center e accedere il menu Guida.
Control Center consente di cambiare le Impostazioni, le
Impronte digitali e di visualizzare la Guida.

Control Center delle impronte digitali
1§ smtormaziont v
# Impronte digitall o g
Fligistri o modificn gh sk model dobs egeoniy dgaal
dofurie
= Impostazioni
Configurn 4 softwar por e smproio digtsh
® Guida
Indormazsom dels Gusda
* introdanions
» Esercaanons

& Guda
) Aumenia peivegs emmininarativ pes Futente x - :
L

Souaraan  necaadan g

\ A/

t/ \

Registrazione Impronta

Si osservi che viene raccomandato di registrare piu di una
impronta in caso di ferita ecc.

Figura 20 - Control Center & Biomenu
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Configurazione Bluetooth ro—
Impostareil proprio dispositivo Bluetooth 4
in modo che il computer possa trovarlo Trasferimento dati via
1. Accendere il proprio dispositivo Bluetooth (PDA, cellulare BEC Y
ecc.). Si noti che il trasferimen-
2. Rendere da trovare il dispositivo (per questo si veda la - to di dati tra il computer
documentazione che accompagna il proprio dispositivo). e e un dispositivo Blueto-

oth & supportato solo in
unadirezione (il trasfe-

Per accendere il modulo Bluetooth ‘ i M rimento dati simulta-
1. Utilizzare la combinazione di tasti Fn + F12 per accendere il neo non é supportato).
modulo Bluetooth.

2. Un'icona Bluetooth 3 apparira nella barra di applicazioni (puo
essere necessario attivare I'opzione dal pannello di controllo

Inwia un file

Ricevi un file

Aggiungi a Personal Area Network

Dispositivi Bluetooth). Apri impostazieni Blueteoth
3. Quindi & possibile effettuare una qualsiasi delle azioni 1 Rimuovi icona Bluetooth

seguenti per accedere al pannello di controllo Dispositivi M

Bluetooth. Figura 21 - Dispositivi Bluetooth e cliccare I'icona Menu

« Fare doppio clic sull'icona g per accedere al pannello di . . L.
controllo Dispositivi Bluetooth. Per aggiungere un dispositivo Bluetooth

 Fare clic su Start e fare clic su Pannello di controllo 1. Accedere al pannello di controllo Dispositivi Bluetooth. =
(oppure scegliere Impostazioni e fare clic su Pannello di 2. Fare clic Opzioni (scheda), e accertarsi che la casella di 9__-’
controllo), e quindi fare clic su Dispositivi Bluetooth controllo Consenti ai dispositivi Bluetooth di connettersi Q
(Hardware e suoni). al computer abbia Connessioni sia selezionata. >

« Fare clic/Fare clic con il pulsante destro del mouse 3. Fare clic Dispositivi (scheda), quindi su Aggiungi. ©
sull'icona 3 e selezionare un’opzione dal menu. 4. L'Aggiunta guidata dispositivo Bluetooth comparira.

.|
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5. Fare clic per selezionare “ll dispositivo € configurato ed & Per cambiare le impostazioni per il
pronto per il rilevamento”, e quindi fare clic su Avanti. . .
dispositivo Bluetooth

[ ——— BN | 10 s qudes dapatier Suomtvoen =)
3] Agshinta uicata Gapossivs 1. Accedere al pannello di controllo Dispositivi Bluetooth.
T e * rapz e 2. Cliccare sul dispositivo che si vuole modificare e Cliccare
o i i Proprieta a:
i " - - - “ge .
- > * Modificare il nome del dispositivo (Cliccare Generale,

digitare un nuovo nome e cliccare OK).
« Attivare/Disattivare un servizio (cliccare Servizi, seleziona/eli-
mina la casella di controllo accanto al servizio e cliccare OK).

Figura 22 - Aggiunta guidata dispositivo Bluetooth . .
Per rendere da trovare il proprio

6. L'assistente procedera alla ricerca per qualsiasi dispositivo

Bluetooth nel range. computer ai dispositivo Bluetooth
7. Selezionare il dispositivo con il quale si vuole comunicare e 1. Accedere al pannello di controllo Dispositivi Bluetooth.
Cliccare Avanti. 2. Fare clic Opzioni (scheda), e accertarsi che la casella di
8. Selezionare 'opzione passkey appropriata e cliccare Avanti > controllo Consenti ai dispositivi Bluetooth di individuare il
Fine. computer abbia Individuazione sia selezionata.
O oot soil St otk = 3. Assicurarsi che la casella di controllo Avvisa quando un
St o by e e d el 9 nuovo dispositivo Bluetooth tenta di connettersi abbia

Connessioni selezionata, se si desidera essere notificati
quando un dispositivo Bluetooth vuole connettersi.

o D s B =
G —— Figura 24
.T_G Dispositivi
= o | Bluetooth -
Opzioni
Figura 23 - Opzione passkey

.|
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Risoluzione dei problemi

Problema

Possibile causa - Soluzione

Non & possibile rilevare i
moduli LAN Wireless e
Bluetooth.

11/l modulo/i &/sono disattivato/i. Controllare il LED indicatore (ig) per verificare se il/i modulo/i &/sono
attivato/i o disattivato/i. Se il LED indicatore & spento, quindi premere la combinazione di tasti Fn + F11
(WLAN) oppure Fn + F12 (Bluetooth) al fine di attivare i moduli (vedere la Tabella 4 a pagina 189).

Il modulo Bluetooth viene
spento dopo aver ripreso
dalla modalita
Sospensione.

Il modulo Bluetooth e spento dopo aver ripreso dalla Sospensione. Lo stato predefinito del modulo
Bluetooth sara spento dopo aver ripreso dallo stato di risparmio energetico Sospensione. Utilizzare la
combinazione di tasti (Fn + F12) per accendere il modulo Bluetooth dopo che il computer ha ripreso da
Sospensione.

Non é possibile copiare un
file da/verso un dispositivo
Bluetooth connesso.

Il trasferimento di dati tra il computer e un dispositivo Bluetooth € supportato solo in una direzione (il
trasferimento dati simultaneo non e supportato). Se si sta copiando un file dal computer a un
dispositivo Bluetooth, non sara possibile copiare un file dal dispositivo Bluetooth al computer finché il
processo di trasferimento che parte dal computer non € terminato.

| file video catturati dalla
Camera PC prendono
troppo spazio sul disco.

Nota catturare file di video ad altra risoluzione molto spazio disco disponibile per ogni file. Vedere
“Riduzione delle dimensioni dei file video” a pagina 204.

Non si sente alcun suono
da un dispositivo di
visualizzazione collegato
via HDMI.

L'uscita audio HDMI non é stata configurata. Vedere “Configurazione audio HDMI” a pagina 196.
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Specifiche tecniche
4

Ultimi aggiornamenti delle specifiche tecniche

Le specifiche tecniche elencate in questa appendice sono corrette al momento di andare in stampa. Alcuni elementi (in particolare
tipi di processore e velocita) possono essere modificati o aggiornati causa la programmazione del produttore. Per dettagli rivol-
gersi al proprio centro di assistenza.

Funzionalita Specifiche tecniche
Tipi di Processore Intel Core 2 Duo (45nm) tecnologia di processo a 45 nm
processore 478 pin Micro-FCPGA package, 35W Cache L2 da 6MB & FSB a 1066MHz
T9400/ T9600 -2,53/2,8 GHz
Processore Intel Core 2 Duo (45nm) tecnologia di processo a 45 nm
478 pin Micro-FCPGA package, 25W Cache L2 da 6MB & FSB a 1066MHz
P9500 - 2,53 GHz
Processore Intel Core 2 Duo (45nm) tecnologia di processo a 45 nm
478 pin Micro-FCPGA package, 25W Cache L2 da 3MB & FSB a 1066MHz
8 P8400/ P8600 -2,26/ 2,4 GHz
2 Logica del Modelli A & B Modelli C & D
E core Chipset Intel GM45 + ICH9M Chipset Intel PM45 + ICH9M
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Funzionalita

Specifiche tecniche

Opzioni di ModelliA & C Modelli B & D
LCD Schermo piatto TFT tipo Glare, 14,1" - WXGA / WXGA+ | Schermo piatto TFT tipo Glare, 15,4" - WXGA /
WXGA+ | WSXGA+
Visualizza- Modelli A & B Modelli C & D
zione Intel GM45 video integrato (interno sul chip) NVIDIA GeForce 9300M GS video discreto (esterno
Acceleratore grafico 2D / 3D ad alte prestazioni su scheda)
Architettura di memoria condivisa (fino a 256MB di 256MB GDDR?2 Video RAM On Board
memoria video condivisa, assegnata TurboCache™ con supporto per memoria grafica
dinamicamente dalla memoria del sistema quando totale fino a 512MB (a seconda della memoria di
necessario) sistema)
Supporto per DirectX 10.0 Supporto per DirectX 10.0
Memoria Due prese SODIMM 200 pin, dotata di supporto per la memoria DDRII (DDR2) 667/800
Memoria espandibile fino a 4GB
Sicurezza Slot blocco di sicurezza (tipo Kensington®) Password del BIOS
Modulo lettore d'impronte digitali (opzione di fabbrica)
BIOS Phoenix BIOS (SPI Flash ROM da 32Mb)
Periferiche di Una unita di tipo ottico SATA (CD/DVD) da 12,7 mm (altezza) - vedere “Opzioni” a pagina 220 per le opzioni
memorizza- dell'unita
zione Un disco rigido SATA facilmente sostituibile da 2,5" di 9,5 mm (altezza)
Audio Interfaccia conforme Intel High Definition Audio Emissione digitale S/PDIF

Sistema sonoro stereo 3D
Compatibile con Sound-Blaster PRO™

2 altoparlanti incorporati
Microfono incorporato
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Funzionalita Specifiche tecniche

Tastiera Tastiera "Win Key"

Periferica di . S . . .
TouchPad incorporato (funzionalita tasto di scorrimento integrata)

puntamento

Interfaccia Tre porte USB 2.0 Una porta eSATA
Una porta uscita HDMI (High-Definition Multimedia eSATA supportata solo in Windows Vista:
Interface) (supporta 5.1 canali) con uscita audio La modalita AHCI supporta la tecnologia Hot-
Un jack uscita delle cuffie Swap (sostituzione a caldo)
Un jack ingresso del microfono IDE non supporta la tecnologia Hot-Swap

Un jack uscita S/PDIF
Un jack RJ-11 per modem

Un jack RJ-45 per LAN
Un jack di ingresso CC
Una porta per monitor esterno

Lettore di Modulo lettore di schede 7-in-1 (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)
schede Nota: Schede MS Duo/ Mini SD/ RS MMC richiedono PC adattatore
Slot

Slot E Card/54(34
ExpressCard ot ExpressCard/54(34)

Slot Mini-Card | Uno slot Mini-Card per il modulo WLAN
Uno slot Mini-Card per il modulo Intel Turbo Memory O modulo 3.5G

o
c
&
'
=
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Funzionalita Specifiche tecniche
Comunica- Fax/Modem Plug & Play da 56K conforme V.90 & V.92
zione Ethernet LAN da 1 GB PCle ﬁ
7 \}
Opzioni del modulo LAN Wireless: Modalita UMTS

Modulo Intel® WiFi Link 5300 (802.11 a/g/n) Wireless LAN Mini-Card S— .
Modulo Intel® WiFi Link 5100 (802.11 a/g/n) Wireless LAN Mini-Card S'_ T“’“ che NON E. }?OSSIB"‘_E
utilizzare le modalita UMTS in

Modulo di camera PC USB da 1,3M o 2,0 M pixel (opzione di fabbrica) Nord America.
Modulo Bluetooth 2.0 + EDR USB (opzione di fabbrica)

Modulo 3.5G basato su UMTS/HSPDA con interfaccia Mini Card
(opzione di fabbrica)

Quad-band GSM/GPRS (850 MHz, 900 MHz, 1800 MHz, 1900 MHz)
UMTS WCDMA FDD (2100 MHz)

RISpaTmIO Supporta ACPI v3.0
energia
Alimentazione | ModelliA & B Modelli C & D
Adattatore CA/CC a pieno campo Adattatore CA/CC a pieno campo
Ingresso CA: 100-240V, 50-60Hz Ingresso CA: 100-240V, 50-60Hz
Uscita CC: 19V, 3,42A o 18,5V, 3,5A (65W) Uscita CC: 19V, 4,74A (90W)
Pacco batteria Smart agli ioni di Litio a 6 celle, 4000mAH o 4400mAH —
Pacco batteria Smart agli ioni di Litio a 9 celle, 7200mAH (opzione) Q__’
Requisiti Temperatura Umidita relativa %
ambientali In esercizio: 5°C - 35°C In esercizio: 20% - 80% (@]

Non in esercizio: -20°C - 60°C Non in esercizio: 10% - 90%
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Funzionalita

Specifiche tecniche

Dimensioni
fisiche & Peso

ModelliA & C

336 (larghezza) x 250 (profondita) x 24,8 - 35,7
(altezza) mm (min)

2,3 kg con batteria da 6 celle

Modelli B & D

359 (larghezza) x 268 (profondita) x 24,8 - 37
(altezza) mm (min)

2,6 kg con batteria da 6 celle

Opzioni

Opzioni modulo unita ottica:
Modulo Unita SATA Combo
Modulo Unita SATA DVD-Dual (Super Multi)

Opzioni del modulo LAN Wireless:

Modulo Intel® WiFi Link 5300 (802.11 a/g/n) Wireless
LAN Mini-Card

Modulo Intel® WiFi Link 5100 (802.11 a/g/n) Wireless
LAN Mini-Card

Pacco batteria Smart agli ioni di Litio a 9 celle,
7200mAH

Modulo di camera PC USB da 1,3M o0 2,0 M pixel
(opzione di fabbrica)

Modulo lettore d'impronte digitali (opzione di fabbrica)

Modulo Bluetooth 2.0 + EDR USB (opzione di
fabbrica)

Modulo Intel Turbo Memory (Robson) - 2GB

(0]

Modulo 3.5G basato su UMTS/HSPDA con interfaccia
Mini Card (opzione di fabbrica)

Quad-band GSM/GPRS (850 MHz, 900 MHz, 1800
MHz, 1900 MHz)

UMTS WCDMA FDD (2100 MHz)

2N
/Q\

Modalita UMTS

Si noti che NON E POSSIBILE utilizzare le
modalita UMTS in Nord America.
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